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ANIMATION 
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VIDEO WORKS 

Each Animated Sprite 
Consumes Memory 
Each animated sprite takes up me mo1y 
space and slows down the program. When 
choosing how many objects you'll ani­
mate during each sequence, keep it simple 
for the best results. 

Creating Self-Running 
Animations 
Take a self-running animation from your 
VideoWorks files. Put your animation 
fil es on a disk with the VideoWorks 
player and set the Player to run as soon as 
the disk is inserted. Copy the System 
folder and the Vic.leoWorks player from 
the MacroMind Utilities Disk to your blank 
disk, the n copy the Demo List document 
from VideoWo rks, and finally, transfer 
your animation files over. Select the Vid­
eoWorks Player icon on the new disk and 
choose Set Startup from the Special menu. 

ow, when the disk is inserted , it imme­
diate ly launches into your animation. 

DATABASES 

FILE 

.. . ... 

.... 

Generating Line Fields 
At Insertion Points 
To Create Lists 
Type Option-Return in a field to gene rate 
a line feed at the insertion po int, which 
allows you to create lists. This embedded 
character acts like a normal carriage re­
turn when copied and pasted into a word 
processing or spreadsheet application. 

Quickly Select 
The Entire Field 
Shift-Click to select the entire field so that 
you don't have to scroll to highlight it. 

Generating Exportable 
Tab Characters 
Hitting the Tab key usually moves the 
curso r to the next field . However, you can 
generate Tab characters by holding clown 
Option while pressing Tab. If data with 
embeclclecl tabs is exported to a word 
processor, for example , the tabs will 
respo nd to the settings in the word proc­
essor, making it easy to format tables. 
Take care when using the same data in 
another database program, though, since 
the receiving database may confuse the 
Tab characte rs with field delineators, 
ruining the transfe r's format. 
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DATABASES 
The Display Box Is 
Bigger Than It Looks 
If the display box you've chosen for a 
field in your form design isn't large enough 
for the data you've entered, don't wony 
-while the box only displays the first 
part of the data, File saves the rest. You 
can see what's in the rest of the field by 
clicking a few characters before the end 
of the box and dragging off its end. This 
scrolls the text through the box for view­
ing. This only works horizontally in single 
line fields, and won't work vertically with 
multiple line fields. 

Changing Field Formats 
Whlle Preserving Your Data 
There's a way to preserve data and still 
change the format of a field. First, open 
your form design and move the hide line 
so that all your fields are showing. 
Remember to show even hidden fields, 
since if you don't you'll lose their data. 

Now, return to the data entry window and 
Shift-Click to select all the record'i in your 
database and copy them to the Clipboard. 
Then, use clear from the Edit tnenu to 
empty all your records and quit. When the 
dialog appears asking how to save the 
Clipboard, choose "Unfonnatted." 

Then, restart File by double-clicking on 
your data file's icon and choose Show 
Form from the Form n1enu. Now refor­
mat the fields, clicking OK whenever File 
warns you that you'll lose data. After 
changing the field forn1ats, save the 
changes and return to the data entry 
window. Select a New record and Paste in 
your data from the Clipboard. Then, 
choose "By Natne" when the dialog box 
comes up. 

This only works if the database contains 
no pictures. Graphics are lost during this 
reformatting. 

Enter Data Fastest In The 
Smallest Database Window 
To enter data quickly, don't leave the 
database window open to the default 
screen size setting. Close it as far as it will 
allow, to display only two lines. Since File 
redraws the screen after cotnpleting an 
entry, keeping the window stnall requires 
the progran1 to draw less. Hit the Enter 
key to go to the first field of the next entry. 

If Your Select Bar 
Pushes Your Form Aside 
The width of the select bar on the far left 
side of the screen in the data file display 
varies to accomtnodate the nun1her of 
digits in the record numbers. If the bar 
gets so wide that it pushes your form 
partly off the page, fix it by opening the 
Form window, picking up the line, and 
then moving it back to the left. This n1ay 
obscure some of your record numbers, 
and you'll have to reset it every time you 
start a new work session. 

Keyboard Cursor Movement 
File has provisions for using the arrow 
keys on the keyboard: 

The right arrow moves the cursor to 
the next field, replacing Tab or 
Return; 

The left atTO\V n1oves the cursor to 
the previous field, replacing Shift-Tab 
or Shift-Return; 

The down arrow n1oves the cursor to 
the san1e field in the next record, re­
placing Cotntnand-Enter; 
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The up arrow n1oves the cursor to the 
same field in the previous record, replac­
ing Comn1and-Shift-Enter. 

Printing Solid Rules 
On The LaserWriter 
When you print reports on the Laser­
Writer, rules will print as dotted lines. To 
print them solid, select Font Substitution 
fron1 the Page Setup dialog. Font Substi­
tution also makes sure that any of your 
total and subtotal fields, and your headers 
and footers, are printed in Helvetica in­
stead of in Geneva. 

Don't Use Embedded 
Tabs Within Fields 
When Exporting 
To Other Databases 
If you work on a file you want to transfer 
to another database tnanager, don't use 
embedded (Option-) Tabs and carriage 
returns within fields. When you try to 
transfer the file later, the other database 
manager could interpret the embedded 
tabs and returns as regular ones. In most 
cases, this will render the transfer useless, 
since the importing database manager 
will interpret the tabs as field delineators, 
and the returns as record delineators. 
This messes up the order of your fields 
and records, generating so n1uch extra 
work that you might as well create a new 
database fron1 scratch. 

Creating Flle Records 
With A Word Processor 
You can create records in a word proces­
sor that will later be transferred into File. 
Don't type in the names of fields, since 
these will get Pasted in along with the 
data. just type in the contents of the fields 

in the san1e order as the fields on your File 
fonn. Follow each field with a Tab char­
acter, and n1ark the final field in each 
record with a carriage return. 

If you have blank fields in your records, 
enter an extra Tab character for each 
blank. If a blank field is at the end of your 
record, you don't have to enter Tabs, 
since the carriage return will make the 
database tnanager ignore any remaining 
fields in the current record, instead start­
ing with the first field of the next record. 

Transfer the data into File by selecting all 
of the data. Put the cursor in front of the 
first character of the first record and press 
Shift-Click while placing the cursor imme­
diately after the last carriage return. 

Copy the records to the Clipboard, quit 
the word processor, and enter File by 
double-clicking on the file's icon. Go to 
the end of the database and select the 
new record by clicking on the selection 
bar to the left of the data window. Then, 
Paste your records into position, choos­
ing the "by name" option. If anything 
doesn't look right, Undo the Paste and go 
back to the word processor file to fix the 
problem. 

Saving Changes To Page 
Setup Par~eters 
If you change the page setup parameters 
of a report that's already been saved, use 
Save As ... instead of Save after you make 
the changes. Using the standard Save will 
save only the changes you've made in the 
report design, without saving changes to 
page setup. When the Save As ... dialog 
asks you if you want to replace the 
existing report of that natne, click Yes and 
the page setup is pern1anently saved. 

3 
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DATABASES 
Saving Files In 
A Sorted Order 
To save files in a sorted o rder, use Save 
Records As ... before closing the fil e, after 
data has been sorted. This saves your 
infotmation as a new, sorted data file. If 
you want to keep the unsorted file as a 
backup, close and save it in the usual 
way. If you don't need the old file, delete 
it, since it won't reflect changes made to 
the sorted file while it was open, and this 
keeps you from getting confused about 
which is which. 

.. . ... 

ftLEMAKER PLUS 

Solution For Label Peels On 
The ImageWriter ll 
When printing on the Image Writer II, you 
might find it peels labe ls off pages and 
backs up. j ust prior to printing your label 
layouts, choose Set Paper Size from the 
File menu and set the paper length extra 
long. Then, in Page Setup, turn " o Gaps 
Between Pages" on and specify Hand 
Feed printing. If you use, say, l-inch, one 
across labels and set the pape r length to 
36, the printer makes 36 labels, skips the 
next two labels, and then prints the next 
batch of 36. 

Hidden Credits 
A humorous credit screen is embedded in 
FileMaker Plus. To see it, hold down 

Option-Shift while choosing About File­
Maker Plus from the Apple menu. 

Entering Multi-Word Phrases 
As Search Identifiers 
Use Option-Space instead of the space 
bar when you're entering multiple-word 
phrases to be used as search identifie rs. 
That indexes both words as one, allowing 
searches by combinations or portions of 
all the words. 

Entering Copies Of A Record 
To enter a lot of copies of a record using 
the Command-M key combination, it helps 
to execute a find on the first record 
ente red. Thereafte r, the number under 
Found will increase by 1 each time you 
press Command-M. This allows you to 
keep track of how many records have 
been entered. 

.. . 

... 

ftLEVISION 

Establish Help Files 
For Other Users 
Of Your Database 
If other people will be using your Filevision 
database, establishing Help files in addi­
tion to your drawings will make things 
more convenient for them. In the Types 
menu, add a type called He lp. Create one 
field in your data form and name it 
Instructions. Then, in the Name field , type 
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in a message such as, "For Help screens, 
double-click the mouse." Take a rounded 
rectangle tool and placed a small shape in 
an unobtrusive but accessible place on 
the screen. Then, click on the rectangle 
and , with the Shift key depressed, select 
the text tool and type Help into the 
rectangle. Finally, go back to the dataform 
and type in your Help text in the Instruc­
tions field. 

Controlling Object Sequence 
You can control the sequence of objects 
when using the Next or Previous buttons 
by numbering your objects in the Name 
field. Numbers always take precedence 
over letters, which are alphabetized. So to 
move items to the top of the list, give them 
numbers as names. 

Another way to control ordering is to use 
the same name, but put a number in front 
of it. This also shows you at a glance 
which data is linked. It works well if you 
need to show a series of steps in your 
drawing. 

f. 
.. . ... 
.... 

HELIX 

Advance Planning Helps 
To use one of Helix's abacus icons to 
perform complicated calculations, it's best 
to plan your function before building it in 
on the Mac. If possible, break the calcu­
lation into modules, then combine them 

in the fina l calculation. This also means 
you can use the modules in other calcu­
lations without having to start over from 
scratch. 

If you can't break a complex calculation 
into modules, plan it on paper first, then 
construct it on the Mac. A quick flowchart 
now can save hours of confusion later. 

Viewing Entire 
Complex Calculations 
Seeing the entirety of complex calcula­
tions can be difficult, since you have to 
view portions of it by scrolling the win­
dow. View the whole calculation by print­
ing it out on the Image Writer by selecting 
PrinL Scaled Image from the File menu. 
This doesn't work on the LaserWriter. 

Avoiding Icon Confusion 
Complicated relations clutter your work 
with a lot of icons. To keep from getting 
confused, name your most important and 
frequently-used icons in all uppercase 
letters to make them stand out. Then, 
move lesser-used icons off to the side of 
the window and arrange your icons in 
logical groups for easier tracking . 

Save Time: 
Copy Old Calculations, 
Then Modify Them 
To create a calculation with an abacus 
icon that differs slightly from another one 
that's already created, duplicate the origi­
nal calculation's icon and then modify the 
copy to create the new calculation. 

5 
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DATABASES 
Save Time While 
Setting Up A New Relation 
When setting up a Relation for the first 
time, several fie lds will probably have for­
mats different from the default settings . 
Save time by creating one field with each 
of the formats you plan to use, then 
replicate them as often as you'll need 
(one for each format) and name them ap­
propriately. 

Moving A Single Tile 
To move only one tile, click and drag 
anywhere on the tile except in an arrow 
or a blank space. 

Moving Groups Of 
Segments Or Tiles 
To move a group of arrow segments and/ 
or tiles, use Shift-Click to select the indi­
vidual e lements to be moved, or surround 
the group with the selection rectangle. 

JAZZ 

.. . ... 

Power Off Prior To 
And After Work Sessions 
When you use Jazz, turn off the power 
switch on the Mac for a few seconds 
before and after you use the program. 
This is because the program adds its own 
embellishments to memory that can't be 
erased by the reset switch. Turning the 

power off eliminates any leftover bits of 
program from the memory. 

Link A Copied Graph 
To A New Worksheet 
People who do a lot of graphics work can 
use ResEdit or another resource editor to 
link copies of worksheets and graphs to 
new worksheets. Edit #LFRF# and change 
the old file name to the new file name to 
quickly link the old ro the new. Only do 
this with copies of your Jazz documents 
- never the originals. 

SYLK File Conversion 
If you're convening a SYLK file from an­
other spreadsheet into Jazz, make sure 
that none of the cells in the file are 
formatted. Converting an unformatted file 
only takes a few minutes, and it saves a lot 
of trouble. 

How Much Memory 
Jazz Allocates 
To Each Application 
Jazz allocates specific memoty sizes to 
each of its applications. If you close an 
application you aren't using, Jazz allows 
another application to use the extra 
memory to create larger documents. Jazz 
allocates: 

237K 
70K 

97K 

45K 
70K 
26K 

to the o perating program 
to the spreadsheet 
(it requires only 3K if the 
database is already open) 
to the database (it requires 
only 30K if the spreadsheet 
is already open) 
to graphics 
to word processing 
to communications 
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Printing Empty Cells 
When you create a database repo1t, empty 
cells will print as zeroes. Get around this 
by entering Option-Space in any cell that 
you want blank for the printout. 

Cutting And Pasting In 
Communications Mode 
When using Jazz's communications op­
tion, cutting and pasting messages makes 
things work a little smoother. First, store 
all the messages you have to transmit into 
a word processing file on one side of the 
screen. Then cut them, one at a time, and 
paste them into the communications win­
dow. 

Loading Jazz Spreadsheet 
Data Into Excel 
Jazz can imp01t data a number of ways, 
but it can't export in anything mher than 
text format. It's possible, though, to load 
Jazz spreadsheet data into Excel. First, 
save each column of data as a text file, 
then load each into Excel, pasting it into 
its own column, Formula information 
isn't transfe rred, so you'll have to re-enter 
it in Excel. 

If You Have 
Trouble Printing 
Sometimes the program will te ll you "This 
file can't be printed," and there seems to 
be no reason why. This happens because 
sometimes Jazz scrambles its own port 
configuration memo1y. The easiest solu­
tion is to make sure jazz is to ld which 
printer it should use, and how that printer 
is connected, by selecting Chooser. 

.. .. ... 

... 
OvER VUE 

Previewing Reports 
Preview a report by saving it to disk, then 
opening it with a text processing desk 
accessory like MockWrite or MiniWriter. 
You'll be able to see and print the report, 
and can even make changes without re­
opening databases. 

Embedded Tabs 
When Exporting Data 
OverVUE doesn't use Tab characters to 
separate fields, which can cause prob­
lems when you uy to Paste information 
into a database manager or spreadsheet 
that uses Tabs as separators. 

To remedy the problems on files you 'll be 
exporting, place a tilde character (-) be­
tween fields in the Report Generator. 

Don't Use "Global Replace" 
If You Can Help It 
In applying the Global Replace function, 
if the< or <= values are applied, you run 
the risk of trashing some data, especially 
if you're working in a numeric column. 
To side-step this problem, use the< or <= 
value with Select instead of Global Re­
place. After the selection is made, use Fill 
to replace the old data with the new, then 
Select All to get all records back on­
screen. 

7 
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DATABASES 

REFLEX PLUS 

Sorting Concatenated Fields 
One of the more annoying things about 
using Reflex Plus is having to take several 
extra steps when sorting on a field that 
hasn't been expressly included in a re­
port. For instance, to make a neater label, 
you might concatenate a last-name and a 
first-name field: 

[First_Name&'"' &Last_Name] . 

As long as you're in the repo11, however, 
you won't be able to son by the last name. 

The simplest solution is to create a last­
name field and hide it. You make room 
for it by making it a tiny size (such as 6-
point Helvetica) , shortening it as much as 
possible, and tucking it in some unclut­
tered corner of the report window (keep­
ing it in its proper repeating collection if 
necessaty). Make the last name fi e ld invis­
ible by adding a ca rriage return with the 
CHAR function to irs fo rmula 

[CHAR( 1 3)&Last_Name] 

so the fie ld will show a blank spot and yet 
still sort correctly. 

This method also works well if you want 
to search by zip code when you've lost it 
in a field fo rmula such as: 

[City&"" &State&"" &""Zip]. 

DESKTOP PUBLISHING 

ADOBE 
TYPE MANAGER 

Undocumented 
Type Manager Tip 
Here's a tip about Adobe Type Manager 
(ATM) that's not mentioned in the prod­
uct manual: 

ATM gives non-PostScript printers such as 
the Image Writer and LaserWriter IISC the 
ability to print Adobe's PostScript fonts. 
The package includes the PostScript out­
line fonts for the four "basic" fonts as well 
as the corresponding bit-mapped fonts: 
Helvetica, Times, Courier, and Symbol. 

If you have little need for math and Greek 
characters, you might be tempted to save 
disk space by not insta lling the Symbol 
font. But when you ny to print one of the 
18 characters that are also included in the 
other three fonts, you'll find that they 
print with a bad case of the jaggies. 
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It turns out these characters are repre­
sented in the Helvetica, Times, and Cou­
rier PostScript files only by references to 
their locations in the Symbol font. With­
out Symbol available, your Macintosh has 
no choice but to print the bitmaps instead. 
If you want decent output for any of these 
characters, you must install the Symbol 
font - both the outline fonts and the 
bitmapped font. 

GENERAL 

Generating 
Special Characters 
Use the Option key to generate special 
characters such as the tilde (-, Option- I) , 
registered trademark (®, Option-R), and 
delta (() , Option-D). Use Key Caps under 
the Apple menu to view other special 
characters. 

Getting The 
Command-Key Symbol 
Many users are surprised that the Com­
mand-key symbol ( 3€ ) isn't included in 
the Dingbats font - especially since Apple 
thoughtfully provides its logo ( 4i ) in the 
other LaserWriter fonts. In fact , the Com­
mand-key symbol is hiding in the Chicago 
font in another nearly untypeable loca­
tion: ASCII 17. Only owners of keyboards 
with Control keys - which excludes you 
if you own a Mac Plus - can type this 

symbol easily; they can access by press­
ing Control-Q. Chicago isn't a PostScript 
font, so if you need high-quality output, 
try ChicagoSymbols, a shareware Post­
Script font. (Send $10 to Bradley Poulson, 
Northwind Enterprises, 4003 Martin Lane, 
Two Rivers, WI 54241.) If you own Altsys's 
Fontographer, you can use the accompa­
nying DemoFont, which also contains the 
Command-key symbol. 

LASER WRITER 

Printing With Ligatures 
If you're using a LaserWriter to print, don't 
forget the two "ligatures" that all the Las­
erWriter fonts provide: "fi " and "fl ". These 
will make your text "extra tight" for best 
appearance. The "fi" is Option-Shift-S and 
"fl" is Option-Shift-6. Don't forget the 
printer's quotes either: " Option-[, "Op­
tion-Shift-[, ' Option-], ' Option-Shift-]. 

There are several desk accessories and 
INITs available through on-line services 
and user groups that make using printer's 
quotes easier. The ligatures are probably 
easiest if you type in "fi " and "f'' normally 
and use a search-and-replace in your 
word processor before printing. 

9 
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OMNIPAGE 

Edit With AppleScan To 
Help OmniPage Differentiate 
Pictures And Words 
OmniPage has some trouble recognizing 
text and pasting text blocks. The less 
"traditional" the page layout, the mo re 
difficult it is for OmniPage to differentiate 
pictures and words. 

AppleScan's editing tools offer a good 
remedy: 

First, use AppleScan to get a pictu re of the 
page. The scanner settings should be 300 
dpi, Line Art. After scanning, move to the 
document window and use the eraser, 
lasso, and selection-rectangle tools to 
eliminate graphics that crowd into text, 
and to move text into groupings that are 
more easily handled by OmniPage. Then, 
Save the document as a TIFF file. 

row, open OmniPage. choose Open from 
the File menu, and open the document 
you just saved. Choose Recognize from 
the Text menu. OmniPage runs through 
your newly-designed page flawlessly ­
and in record time! 
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Correcting 
Underscoring Problems 
When making a ·'fill-in" sheet, the under­
score characters you type at the end of 
each line will occasionally line up with 
the end of other lines. To correct this, after 
you've completed a page, draw a box 
over the edges of the ends of the lines 
which encompasses all of the associated 
lines. Give this box a white shade and 
"None'' lines, so it can't be viewed. The 
objects behind it will be invisibly covered. 

Getting PageMaker 
To Remember 
Page Setup Alterations 
PageMaker will permanently remember 
page setup alterations if you choose Page 
Setup from the File menu with no docu­
ment open and o nly the gray desktop 
showing. Every new publication you create 
will default to the altered settings. 

Getting The Most 
Accurate Size Display 
Although the 200% size has the most 
fractional markings on the rulers, it is not 
the most accurate size display. Since the 
printed version exactly matches the Ac­
tual Size display, always check it before 
doing your final printing. 
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Toggling To A 
MacPaint-Style Hand Tool 
Hold down Option while clicking on your 
document in any other place but in a 
column guide. Use the hand to drag an 
in1age around the window and reposition 
your page. 

Disabling "Snap To Guides" 
You have the option of turning off Snap 
To Guides in the Options menu if you 
don't use then1 often. When n1aking a 
move that isn't affected by these guides, 
be careful where you place the pointer. 
Position the pointer away from the guides 
when you start the n1ove so that the iten1 
you're n1oving won't be affected by the 
guides. 

You have the option of turning off Snap 
To Guides in the Options n1enu if you 
don't use them often. When n1aking a 
move that isn't affected by these guides, 
be careful where you place the pointer. 
Position the pointer away fron1 the guides 
when you start the rnove so that the iten1 
you are n1oving won't be affected by the 
guides. 

Keeping The LaserWriter 
Up To Speed 
If you've been using your LaserWriter to 
print clocun1ents from other applications, 
turn it off and then back on again before 
printing PageMaker clocurnents. This is 
because PageMaker initializes the Laser­
Writer with Aldus Prep, but it doesn't 
replace the old Laser Prep file. Since both 
Prep progran1s are tnen1ory hogs, when 
the LaserWriter stores both files it slows 
down in printing speed. For the same 
reason, reinitialize the printer after finish­
ing your PageMaker printing. 

You n1ight try reinitializing the printer 
whenever your network -connected printer 
seems to be printing too slowly. 

Save Time When 
Switching Printer Drivers 
Switching frotn the Aldus printer driver to 
the Apple driver for background printing 
under MultiFinder is a hassle if you rely on 
the usual, slow tnethod of invoking the 
Aldus Print dialog box and selecting 
Change. You can tnake the change n1uch 
more quickly by holding clown the Op­
tion key while selecting Print frorn the File 
n1enu; then click on OK in the two 
resulting dialog boxes. You '11 find your­
self at the familiar LaserWriter dialog box, 
where you can specify the number of 
copies and pages to print. You've auto­
matically switched printer drivers! 

Printing a Publication From 
Page One, With A Title Page 
You may want your publication to have a 
title page and then start the cloctunent 
with Page 1, but PageMaker doesn't let 
you treat the title page differently frotn 
your docwnent (it also won't autonlati­
cally ntnnber the pages starting with the 
second docun1ent as Page 1). 

If you put the title page at the end of the 
clocwnent and turn off the Display Master 
option on the Page Menu for that page, 
you can use auton1atic page numbering 
for the docun1ent and still have a title 
page vvithout a folio. 

11 
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Creating Evenly-Spaced 
Lines In Difficult Places 
There will be times when you want evenly­
spaced lines in a place not easily divided 
by the ruler. You can create these lines 
easily: 

First, draw and save your own simple 
ruler (with some division lines) in a PICT 
file (you can make these with MacPaint or 
MacDraw, for example). 

Enter PageMake r and use the Place 
command to put your ruler on the page. 
Select the rule r and resize it to fit the space 
you need to divide. You can now draw 
lines using the ruler as a guide. When 
you're finished, remove the ruler. 

Solution For Imported 
Graphics "Clipping" 
When you open PICT files within Page­
Maker, you'll occasionally find a bug that 
clips off the top patt of a graphic, espe­
cially if it consists of text placed above 
graphics. By placing a shape above the 
text and giving it no fill or pattern you can 
fool the program into including the fu ll 
impotted Pier file. 

Toggling Between 
"Full Page" And 
"Fit To Window" Views 
You can toggle betvveen the Full Page and 
Fit To Window views by holding down 
the Command key while clicking in the 
page window. 
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Selecting 
Closely-Packed Objects 
Selecting closely-packed objects confined 
to a small space is easiest if you Com­
mand-click near the object you wish to 
choose. 

"Guide Lock" Aids 
In Object Selection 
It can be difficult to select items located 
on or underneath a guide w ithout grab­
bing the guide by mistake. To lock the 
guides temporarily, use Guide Lock from 
the Options menu.This makes it impos­
sible to select and move them acciden­
tally. When you're done moving the ob­
jects, toggle the Guide Lock off by choos­
ing it a second time. 
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PAGEMAKER 3.0 

Keyboard Command 
Shortcuts For 
Extended Keyboard Users 
If you have Apple's Extended Keyboard, 
you can choose tools from the PageMaker 
Toolbox window by using the following 
undocumented key combinations: 

Control-Shift-Fl selects the Pointer. 

Controi-Shift-F2 selects the Line tool. 

Control-Shift-F3 selects the Horizon­
tal/Vertica l tool. 

Control-Shift-F4 selects the Text tool. 

Controi-Shift-FS selects the square 
rectangle tool. 

Control-Shift-F6 se lects the rounded 
rectangle tool. 

Control-Shift-F7 selects the Ellipse 
tool. 

Control-Shift-F8 selects the Cropping 
tool. 

Printing Through 
The Manual-Feed Tray 
Of The Varityper-600 
PageMake r has difficulty printing through 
the manual-feed tray of the Varityper VT-
600. The problem isn't with the VT-600 
but with the VT-600.apd (Aldus Printer 
Description) file that PageMaker uses to 
prinr. 

You can alter the APD with Word or 
another word processor so that the file 
w ill work with the manual-feed function. 
Open the VT-600.apd in Word, find this 
line: 

@Manualfeed : "none" 

and rep lace it with these lines: 

@Manualfeed true: "statusdict 
begin 
/manualfeed true defend" 

@Manualfeed false: "statusdict 
begin 
/ manualfeed false defend" 

Flowing Text Around 
Irregularly Shaped Objects 
PageMake r 3.0 lets you flow text around 
irregular graphics using an invisible out 
li ne that text won't cross. This feature also 
lets text flow into an irregular shape. 

Sta rt by drawing or placing a graphic in a 
shape that you wish to replace with your 
texr. 

Using the rectangle tool, create two side­
by-side rectangles to cover the graphic, 
with the two rectangles touching in the 
centerofthegraphic and extending across 

13 
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the width of the column and above and 
below the graphic. 

Select the center text-wrap feature, (found 
in Text Wrap under the Options menu) 
for each of these rectangles. The invisible 
wrap control lines will appear, overlap­
ping in the center. 

Working first with the left rectangle, click 
along the right control line enough times 
to create the number of points necessary 
to outline the left side of your graphic. 
Use these points to stretch the control 
lines around the left side of your graphic. 

Repeat the process for the right rectangle, 
using the left side of the rectangle. Make 
sure the top and bottom control lines still 
overlap at the center. 

When you have the graphic outlined 
completely, delete it. 

Now, choose the two rectangles and 
specify None under the Lines menu. 

Flow your text into the column, and it will 
fill the area you created. Set the text to be 
justified to flow it properly across the 
area. This tip works best when you're 
working with small font sizes, tight lead­
ing, no paragraph breaks, no tabs, and a 
column width no larger than the size of 
your graphic. 

Wrapping Text Around 
A Graphic, Then 
Captioning The Graphic 
If you want to wrap text automatically 
around a graphic and then put a caption 
below or next to the graphic, you tnust 
increase the stand-off value of the text 
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wrap around the graphic on the side 
where you want the caption. If you're not 
careful, the text wrap area of the graphic 
will push the caption away, leaving it 
stranded right in the middle of the wrapped 
text again. Be sure that all the handles of 
the text block defining the caption are 
inside the text wrap area. 

Place the text or begin the text block by 
dragging the text cursor, rather than just 
clicking it. Clicking forms a text block the 
width of the colun1n or page, which 
usually makes it larger than the text wrap 
area. The result is that PageMaker will 
push the caption away. When you drag 
instead, you can n1ake sure that the text 
block of the caption begins and ends 
inside the wrap area, so it will stay where 
you want it. 

Changing the 
Default Settings 
When Laser Printing 
The Default settings of the Aldus Printer 
Description (APD) files control the laser­
printer screen quality, producing output 
at 60 lines per inch and placing half-tone 
screens at a 45-degree angle. You can 
change these default settings using a text 
editor. 

\Vith a text editor, open the APD file 
corresponding to the printer that you are 
going to use, and find the two lines: 

@ScreenFreq:" and @ScreenAngle:" 

Enter your desired screen frequency and 
the desired screen angle between the 
respective quotes. 

Save as a text-only file. The laser printer 



DESKTOP PUBLISHING · 
will now produce the newly-defined 
screen definition when you print. For best 
results, don't use a screen frequency 
higher than 135 lines per inch, and set 
your half-tone screen angle to a multiple 
of 45 degrees. 

Use The Wide Tabloid Page 
Setup To Print Two Pages 
On One Large Sheet 
Most service bureaus charge less for print­
ing one 11 x 17-inch sheet of paper or film 
than they do for printing two 8.5 x 11-inch 
printouts. You can take advantage of the 
price break by using PageMaker's wide 
tabloid page setup to lay out two pages on 
a single page. This also lets you produce 
bleeds (graphics that extend across two 
pages). 

Here's an example of how to set up two 
three-column pages on one tabloid-sized 
page: 

Set the left and right margins to be the 
outside margin measurements (since 
neither one is an inside, or bound margin, 
they should be equal). Next, choose the 
distance between columns and the nun1-
ber of columns, but choose seven col­
umns instead of the tnore common six. 
The columns will be evenly spread across 
the two-page spread. To rearrange them, 
you need to know the width of the 
column you want. For a three-column 
page, the formula is (8.5 (2 x the distance 
between columns) - (outside margin + 
inside margin)) divided by 3. 

Starting from the left margin, measure the 
width of your column and then drag the 
left side of the first column guide to that 

point. Zero the ruler to the right edge of 
the column guide, and repeat the proce­
dure for the second and third columns. 
Then move to the right margin and repeat 
the measurements for colun1ns six, five 
and four. The remaining "seventh" col­
umn (the one left in the middle) and 
adjacent column divisions will be equal to 
the two inner margins. 

When printing proofs on a LaserWriter, 
make sure that you change the options at 
the bottom of the print dialog box so that 
the paper is set at Tall. At this setting, with 
the tile feature set at automatic and the 
overlap set at 0, the LaserWriter will print 
your proofs as neatly as if your layout 
were in an 8.5 x 11 format. 

Laying Out 2 Pages On An 
8.5xll-Inch Sheet Of Paper 
To print two pages on a single 8.5 x 11-
inch sheet, just create two columns on a 
letter-sized page turned on its side by 
entering 11 x 8.5 in the Page Setup dialog 
box. Remember, you can't use 
PageMaker's automatic page-nun1bering 
feature, since auto-numbering considers 
this setup to be one page. 

Stopping PageMaker 
From Reformatting 
Text Imported From Word 
When you first place a Word document 
into PageMaker 3.0 or 3.01, you place 
Word's style sheet into the PageMaker 
document's style sheet, even if you previ­
ously hadn't been using a style. In other 
words, the style is not actually created by 
PageMaker; rather, it's borrowed from 
Word. 

15 
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Once you've placed Word text into the 
program (and so, placed it in its style 
sheet), PageMaker will read whatever 
Normal text you place from Word, whether 
it's been formatted differently or not, as 
the same Normal style. 

If you have several stories with different 
formats to place in your document, make 
sure to delete the Normal entry from the 
PageMaker style sheet before adding 
additional text. You can either add the 
styles you want in Define Styles under the 
Format menu while still in Word, or else 
save your formatting until you've im­
ported all your text into PageMaker. 

How To Save Revised 
Print Parameters 
PageMaker saves updates to your print 
parameters (like Paper Source, Driver, 
Scaling, etc.) only if it perceives that you 
have changed the file. Even though you 
may only be opening the file to print it, 
your changed parameters will be lost 
when you close the file. 

One solution is to do something and then 
promptly Undo it. For example draw a 
box and then delete it. Now PageMaker 
will perceive a saveable change, and your 
new print parameters will be saved within 
your file. 

Using Pyro! To Force 
PageMaker To Update 
The Screen Automatically 
One annoying flaw in PageMaker 3.0 is its 
occasional failure to update the screen (as 
when the print dialog box disappears, 
leaving a gaping "hole" in the screen 
text). Most users just scroll off the page 
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and then back again to recover the por­
tion that was blanked out. 

If you have Pyro! or another screen saver, 
there's a much faster way to force Page­
Maker to redraw the entire screen. Move 
the cursor to the sleep corner. When 
Pyro!'s start up screen shows, move the 
cursor back to the document. The fully 
updated page appears. It's a lot easier that 
dealing with the scroll bar. 

Use Easy Access 
To Nudge Graphics 
Or Text A Short Distance 
If you need to nudge an object just a tiny 
distance, you probably know that using 
the mouse to drag it is extremely inexact. 
Easy Access~ an INIT that comes with the 
new System, can help. 

Just press Command-Shift-Clear to tum 
on the Mouse Keys. Press the 0 key to lock 
the mouse button down, then use the 
numeric keypad to move the pointer 
(press 8 to move up, 6 to move right, etc.). 
To move the pointer one pixel on the 
screen, tap the key once. For a longer 
movement, hold down the key a little 
longer. Press the decimal point to unlock 
the mouse button, and press the Clear key 
to turn off Mouse Keys. 

Hide The Guides And Rulers 
To Gain Some Screen Space 
On'Plus And SE Screens 
You can gain some space on the small 
Mac Plus and SE screens by hiding the 
guides and rulers. To navigate through 
your documents, use: 

Command-Tab to move forward. 
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Command-Shift-Tab to move backward. 
Command-G to go to a specific page. 

Select the hand tool and Option-Click 
with it to move around the page. 

Keeping Colors In Order 
For Strippers And Pressmen 
When printing a document with spot 
colors, PageMaker doesn't print color 
names on each separate plate if the image 
area occupies the entire printed page. 
This can prove especially confusing if 
you're printing multiple pages at a time. 
To keep your colors in order, insert a 
small text block in the top left corner of 
the document's master pages. Type in the 
name of a spot color you 're using, and 
then make the text that color with the 
color palette. Repeat this for every color 
you use in the document. 

You can stack all the text blocks on top of 
each other, so when you print out, the 
names will only print out in the pages that 
have those colors on them. 

\XIhen you use this method, don't forget to 
tell d1e pressmen to cover the color des­
ignators when the page is exposed for 
printing. 

An Easy Way To Track 
Hours Spent Working 
If you need to track how many hours you 
spend on a particular PageMaker job, you 
can create a small chart on the Paste­
board, just off to the side of a page. Create 
columns for Date, Time Started, Time 
Ended, and Hours Worked in the chart, 
using tabs. Each time you open the docu­
ment, add a new row for the day and enter 

me pertinent information. \XIhen you close 
me document, fill in the Time Ended 
column. Now you'll always have accurate 
data handy for invoicing that project, and 
it's a lot cheaper than buying a time­
tracking program. 

Opening More 
Than One Publication 
Ever wish you could open more man one 
publication in PageMaker? If you have at 
least 3 megabytes of memory, a hard disk, 
and MultiFinder, you can. 

Use the Finder to make duplicate copies 
of PageMaker and rename each copy (ie: 
PMK.l , PMK.2, etc.). For safety's sake, 
place each copy in its own folder wim 
accompanying files. Then launch each 
copy under MultiFinder. You can now 
copy and paste whole pages between 
publications easily. 

PAGEMAKER 3.02 

Getting The Right Space 
Allocations When Dividing 
Space That's Not A 
Round Whole Number 
One of d1e most-used functions of Page­
Maker is to divide an amount of space 
(vertical or horizontal) evenly among a 
number of increments. However, when 
this amount of space isn't a round , whole 
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numbe r, dividing and spacing can turn 
into a headache. To get the proper space 
a llocations no matter what sized spaces 
you're using: 

Draw a rectangle that is, for example, five 
inches in length, then divide it into five 
increments. Copy this segme nted rec­
tangle to the Scrapbook and use the Place 
command on the File me nu to place the 
most recent Scrapbook file as a grouped 
PICT file . 

You can resize this rectangle to fit into a 
longe r area by grabbing one of the handles 
and stretching it. Now, you'll have five 
equally divided spaces, without going 
through the trial and error of measuring 
each area out. 

Getting The Proper 
Spacing When Dividing 
Horizontal Or Vertical Space 
A common operation in PageMaker is 
dividing an amount of space (horizontal 
or vertical) evenly amo ng a number of 
increments. But when this amount of 
space is not a round whole number, the 
division and spacing can be problematic. 
Here's an easy way to get the proper 
space allocations: 

1. Draw a rectangle that is. for ex­
ample, fi ve inches in length, and 
divide it into five increments .The 
rectangle should be divided into 
five l -inch segments. 

2. Copy this segmented rectangle to 
the Scrapbook and use the Place 
command on the File menu to 
place the most recenr Scrapbook 
file as a grouped PICT graphic. 

3. To resize this rectangle to fit into a 
longer area, grab o ne of the 
handles of the rectangle and 
stretch it. 

Now you'll have fi ve equally divided 
spaces without the tedium of trial-and­
e rror measureme nt. 

0UARKXPRESS 2.0 

Improving The Printed Look 
Of AppleScanned Art 
Th e re 's a proble m w ith the way 
QuarkXPress handles line art saved as 
PICT files in AppleScan. An AppleScan 
PICT file placed into QuarkXPress looks 
fine on-screen, but prints out terribly w ith 
the LaserWritcr. If you import the same 
file in the TlFF format, Quark).rpress auto­
matically assigns a halftone screen value 
to the line art, which ruins its clarity. 

A solution not docun1e nted in the manual 
is to save the line art in the TIFF format in 
AppleScan, then to ho ld down the Com­
mand key when selecting the file in 
Qua rkXPress. us ing the Get Picture 
command. Doing this impons the file as 
non-halftoned line art. Now you can take 
adva ntage of nea rly a ll the options on the 
Style menu, such as legative, Contrast, 
and others which arc not available for any 
graphics imported as PICT files. 
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Wrapping Text Around 
AppleScanned Images 
When irregularly shaped pictures are 
scanned with AppleScan and then im­
poited into Quark.XPress, it is usually 
impossible to use the automatic text-wrap 
features. When text is wrapped around 
the imported graphic, it wraps only around 
the shape of the graphic box. 
He re 's a solution that allows you to wrap 
text around an irregularly shaped image 
imported from AppleScan: 

While in AppleScan, select the irregularly 
shaped object using the Lasso tool. After 
the object is selected. AppleScan gives 
you the option to Save Selection as in the 
File menu. Save your image as a TIFF file 
so that it can be imported into Quark­
XPress. 

After you've imported the TIFF file , you 
can go through the normal steps to create 
a wraparound . The text will wrap per­
fectly around the shape of your object, 
and if you put the object into a rectangle 
picture box you can set the Text Outset to 

anything you want. 

READY, SET, Go! 2.1 

Importing Formatted 
Or Tabbed Data 
If you're imponing heavily formatted and/ 
or tabbed data into Ready,Set,Go! 2.1 , use 

a screen-to-Clipboard desk access01y. Im­
poit your information in as a graphic or a 
series of graphics (take a bitmapped screen 
clump of word processor screens) . Match­
ing the MacWrite ruler with Reacly,Set,Go's 
block layout makes this easy. 

Only impo rt finished documents, though, 
if you have to make corrections, you'll 
have to reimport the data again. This tip 
should work whe n you're us ing any 
program that accepts Clipboard graphics. 

READY, SET, Go! 3.0 

Wrapping Text Around Text 
It's possible to wrap text around other 
text. Just choose Specifications from the 
Special menu and pick '·run around." The 
resulting text can wrap around the text 
block just rhe way it works for a picture. 

Viewing A Page At The Text 
Block Insertion Point 
Using Command-1 to Command-S to view 
a page can be annoying, since you always 
see the upper left corner of a page. To 
work around this, while the text tool is 
activated, click and hold the mouse but­
ton with the cursor in the te:A'1 block you 
want to zoom to. Still ho lding down the 
button, hit the Command key to zoom to 
any factor. When you release the mouse 
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button, the view will shift to show the 
insertion point in your text block. 

You Can Only Import 
32K Documents Or Smaller 
If you're importing a complex PostScript 
document, check the size of the file first. 
It has to be 32K or less to import properly, 
since Ready, Set, Go! 3.0 is limited to 32K 
text blocks. Importing longer documents 
may be courting trouble, so break large 
files down into smaller ones before enter­
ing Ready,Set,Go!. 

Use The Program's Drawing 
Tools To Save Printing Time 
Although Ready, Set, Go! is usually excel­
lent at importing 300 DPI graphics, try to 
make do with the drawing tools included 
in the program if your needs aren't too 
complex. It saves considerable time when 
you print out the page. You '11 find you 
can create some pretty elaborate logos 
with imaginative use of the fill patterns 
and shapes, and your page will print 
almost as fast as a text -only document. 

Bypassing The Get Picture 
Routine With The Clipboard 
Although tnost people copy graphics from 
files using the Get Picture routine, you 
can skip a step by passing the in1age 
through the Clipboard instead. If you 
work with a drawing or painting program 
and Ready, Set, Go! under Switcher, cut 
the image to the Clipboard, switch to RSG, 
use the cropping tool to prepare the target 
graphics block, and then Paste. You'll still 
have the same control over the image as 
if you had itnported it in through Get 
Picture. 
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Link Text Blocks In 
Exact Order, Page By Page 
When linking text blocks together, n1ake 
sure to link them in the exact order, page 
to page. The program won't assume that 
you want the blocks linked in numerical 
page order, but instead will take your 
comtnands literally. If you try to link up 
the blocks from front to back, the results 
will be a real tness. 

Using ResEdit To Recover 
A Lost Application Icon 
Sometimes Ready, Set, Go! 3.0 loses it'i 
application icon, which can result in a 
"Couldn't find the application" error when 
you try to open a Ready, Set, Go! docu­
ment. If you have a copy of ResEdit, 
here's a fix to try: 

On a backup of Ready, Set, Go! 3.0, 
launch ResEdit and select the Ready, Set, 
Go! 3.0 application. Choose Get Info from 
the File menu and click on the bundle box 
to turn it on. Then close the window and 
save the changes. 

(Setting the bundle bit in an application 
specifies that the application "owns" 
documents and that it has its own indivi­
dual icon.) 

Now, double-click on the Ready,Set,Go! 
3.0 application to open it and show its 
resources. Select NEW from the File menu 
and enter a new resource type of MRSN 
(all caps). A blank MRSN window opens 
immediately. Choose NEW again from the 
file n1enu and enter the following at the 
insertion point: 

OB 56 65 72 73 69 6F 6E 20 33 
2E 30 
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Now close the w indow, and you'll notice 
how the only listing in the MRSN window 
is highlighted. Choose Get Info from the 
File menu and change the ID name to 
zero. Finally, quit ResEdit and save the 
changes made to the Ready, Set, Go! 
backup. Now, just reboot the backup, and 
you're ready to work again. 

READY, Sn, Go! 4.0 

Stretching Text Easily 
There's a quick and easy way to stretch 
text as tall or as wide as you want. Start 
with a text block and type in the desired 
text. Then draw out a picture block to the 
size of the end product. If, for example, 
you want the text to come out half as wide 
and four times the height, create the 
picture block in that size. 

Select the text block to be stretched by 
clicking on it, then Cut or Copy it. Now, 
ready the picture block as if it were to 
receive clip art, and then paste the text 
into the block. Select the Picture block, 
choose Specifications (Command-M), and 
use the Scale Across and Scale Down 
functions to stretch the text accordingly. 
The stretched text will now appear as you 
want it. 

Wrapping Text 
Within Two Graphics 
It's possible to wrap text within two 

graphics to create interesting paragraph 
shapes like ci rcles, triangles, or just about 
any shape you can imagine. Here's how: 
Draw the shape that you want d1e text to 
conform to wim a graphics program like 
MacDraw. The trick is to draw it in two 
halves (such as two half-moons that to­
gether would form a circle). Copy and 
Paste each half of the drawing separately 
into the Scrapbook. 

Now, boot RSG! 4.0 and create two graphic 
blocks large enough to accommodate 
your drawings. Make sure they butt up 
against each other. Then, paste your two 
graphics into these graphic frames - the 
left half into the left block, and the right 
half into the right one. The two halves 
should now resemble the graphic shape 
you want. Invoke the Specifications box 
(Command-M) for each graphic block 
and click Don·t Print and Runaround 
Graphic (instead of Runaround Frame). 

Then, create one text block as large as the 
two graphic blocks. Make sure the text 
block lies directly on top and covers these 
blocks. Put your insertion point in the text 
block and start typing o r import a text file . 
The resulting text will take on the shape 
you created with the two graphics. 

Use justified text if you want the text to 
conform exactly to the shape you've creat­
ed . And set text repel d istance to zero. 

If you have problems getting the text to 
flow correctly into the shape, try drawing 
nonprinting lines above and below your 
graphic. 
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READY, Sn, Go! 4.5 

Using Ready, Set, Go! 
To Produce 
Gray-Scale Characters 
An undocumented feature of this pro­
gram is its ability to produce gray-scale 
characters. just make text different colors 
and print without the Color Separation 
option checked to get gray-scale charac­
ters when you print on a PostScript-com­
patible printer. 

Getting Rid Of 
Unwanted Characters 
In Imported Text Files 
You may need to import a text file into 
RSG 4.5 that displays unwanted or un­
known characters on-screen. Files trans­
ferred from other computers or clown­
loaded from bulletin boards often contain 
such characters, as do files from non­
Macintosh operating systems. These un­
wanted characters often appear as little 
boxes. 

You can get rid of these characters by 
using the Replace command. Select the 
offending box or symbol by highlighting 
it. When you select Replace, the character 
is automatically pasted into the Find box 
in the dialog box. Move the cursor to the 
Change To box and press Option-D and 
then R (this specifies that you want the 
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replacement character to be a carriage 
return; or you can replace the non printing 
characters with a space or with nothing at 
all). When you click OK, all your un­
wanted characters will be deleted. 

Increasing And Decreasing 
Text Point Size 
From The Keyboard 
You can increase and decrease the point 
size of your text right from the keyboard. 
Select the text whose point size you want 
to alter. Press Conunand-> (greater than) 
to increase the text size one point at a 
time; press Command-< to decrease the 
size by one point. 
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AIRBORNE! 

Christmas Cactus 
A specia l "Christmas gift" was written into 
Airborne! 's program. Once a year, on 
December 25, the cactus turns into a 
Christmas tree. You can see it any day of 
the year by setting the calendar on your 
Mac to December 25. 

THE ANCIENT ART OF WAR 

Keeping the Enemy 
From Multiplying 
In this game, only 20 squads can be on the 
war map at any one time. You can keep 
your opponent from training more men 
by detaching squads (preferably in your 
fort) until the 20-squad limit is reached. 
Whenever one of your squads is wiped 
out, detach another one to retain the 20-
squad limit. With small squads in your 
fort, you continue to gain men and your 
opponent continues to lose them. 

Send Two Squads 
Against Forts 
Using archers alone to overrun a fort can 
inflict a lot of casualties on your army. 
Instead, send two or more groups with a 
few men each just to occupy the e ne my 
archers o n the wall. Then, send in your 
regular units. They'll be able to sneak 
over the wall while the enemy is already 
engaged, and then the battle w ill take 
place in the courtyard- where you have 
better-odds of winning. 

The Coward's Way 
To Inflict Casualties 
If your archer is outnumbered while fight­
ing another squad , fire a barrage of ar­
rows and the n retreat. The arrows still 
move even after your men are safely off­
screen, so you can whittle down e nemy 
forces without taking any casualties of 
your own. 

Don't Zoom In When 
Non-Archer Squads 
Attack Forts 
Armies can't retreat unless you press the 
Zoom button during tl1e battle. So, if an 
enemy squad is dumb enough to attack 
your fort without any archers, don't zoom 
in to see the battle. The attackers won't be 
able ro retreat, so they' ll eventually all be 
killed. 

You Don't Need A Whole 
Squad To Capture A Flag 
You can capture a flag without tying up 
an entire squad. j ust detach one man into 
a new squad , then send him to the flag. As 
long as there is no enemy lurking nearby, 
a single soldier works as well as a full 
squad. 
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Exporting Graphics 
If you try to create a screen dump using 
the standard Command-Shift-3 combina­
tion, it won't work . Command-Enter takes 
a PICT file screen snapshot, which you 
can then edit into any graphics file. 

ARKANOID 

Get The Power 
Capsule You Want 
If you don ·t like relying on chance for the 
right power capsule to drop down, there's 
a way to make yourself a w inner. First, 
boot the program and begin to play as 
you normally would . Then, type: 

dsimagic. 

Then, resume your play . You' ll see a 
capsule called DS drifting down the screen. 
Catch it and press A to regain sound, then 
press the following keys to obtain the 
type of power c~ps11le you want: 

B= break to next round: 
C=catch; 
L=laser; 
P=player (extra life); 
S=slow. 

On some earlier versions, when you press 
B, you see a screen called Boss Coming 
instead of the next level. 
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Creating The Perfect Party 
To complete the game, you'll need a Bard 
and three spellcasters, each of at least 
12th level. Fighters are necessary at first to 
protect the rest of the party. When you 
first create your characters, make some 
extra fighters and leave them at the Inn to 
get later (when your first round of fighters 
is killed). 

Survival In A Hard World 
Working your characters up in level can 
be extremely frustrating, since it seems as 
if almost everything can kill them. A good 
way to build up some experience is to 
simply walk back and forth between the 
Inn and Ga1th's store during daylight 
hours. When you're really feeling brave, 
trek down south to the Temple (you can 
heal up there) and back again. Don't go 
out at night until you have at least 1 or 2 
third-level characters, since d1e bigger 
monsters come out when the sun goes 
down. 

When You Need 
More Money 
You can double, trip le , or even quadruple 
your money if you're willing to cheat a 
little. Pool the pa rty's gold to a single 
character, then copy that character to 
another d isk. Now. restart, using the back­
up disk to create a new character. Pool 
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the gold to the new character and transfer 
him or her back to your game disk, where 
he hands off the gold to your party. The 
more often you do this, the more money 
you'll end up with. 

Recharging Magical Items 
When magical items are running low on 
charges, sell them to Gaith and then buy 
the m back. They'll be fully recharged 
again when you buy them. 

Getting Quick Experience 
One way to build up your characters 
quickly is to slay the Samurai on Rakhir 
Street. Heal seriously wounded charac­
ters, then go back and kill him again. 

Getting Massive Experience 
Once your characters are around levellO, 
advance them fast by defeating the ber­
serkers at 5N, 12E, 2U in the Castle, which 
nets more than 50,000 experience points 
per character. You can do this without 
taking much damage by summoning a 
Reel Dragon with at least 100 hit points, 
putting two fighters w ith an armor class of 
LO behind him, and having your Spell cas­
ters toss mind-blast spells. The Barel should 
sing song number 3 or 5. Repeat this as 
often as you like, leaving the Castle to 
heal up between battles. 

Develop 
Spellcasters Carefully 
You need an Archmage as soon as pos­
sible. Stait with a Magician and have him 
or her learn three spe ll classes, tl1en 
switch to Sorcere r class and learn three 
more . Finally, switch to Wizard and learn 
tl1ree more, then make the final jump to 
Archmage. Develop one or two other 

magic-users all the way through to the top 
levels before you switch them. Eventually 
they'll become far more powerful than the 
Archmage, but in the meanwhile you'll be 
able to use the widest variety of spells. 

To Complete The Quest ... 
To find and defeat Mangar, you 'll need 
the name of the Mad God; his eye; the 
Silver Square, Triangle and Circle; and the 
Onyx Key. The Master Key isn't vital, but 
having it will save you a lot of time in 
Mangar's Tower. 

CYBORG 

Updating Old Copies 
To Work With HFS 
Cyborg wasn't designed to run on HFS 
Macs (which have been standard since 
the first Mac Plus was introduced). If you 
have an old copy of the game, first make 
a copy of the master, then use any file 
utility program like Fedit or HFS Locator 
Plus to re name the Finder on the Cyborg 
disk. (Call it anything except "Finder.") 
Then , reboot your Mac with a current 
System and Finder, and inse11 Cyborg into 
the external drive. Double-click on the 
icon, and you're ready to adventure. 

25 



GAMES 

DARK CASTLE 

Tracking How Many Times 
You've Won In A Session 
lf you're expert enough , you can track 
how many times you've toppled the 
throne. While typing your name into the 
Hall of Fame, type O ption with any o ther 
key. This creates a Dark Castle symbol. 
Use the number of castle symbols to 
represent how many times you've fin­
ished the mission. 

Keeping Your 
Shield Activated 
The shie ld usually lasts only about 3 
seconds. You can keep wearing it indefi­
nite ly, though. When you activate your 
shield , hold clown the key fo r about 2.5 
seconds. The n, at the last moment, re­
lease the key and press it again quickly. 
Experiment with this to pick up the rhytlun. 

How To Walk On Air 
It's possible to make your on-screen hero 
li te rally walk on air. Press the cluck key 
w ith either the up or clown key as you go 
up or clown a staircase or ladder. When 
you reach the top or bo ttom, your charac­
te r will seem to be walking on air. Once 
there , expe riment with different com­
mands to get some ente rtaining results. 
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Ex press Route 
To The Trouble Room 
The easiest way to get to the Trouble 
Room is to push Door # 3. You' ll go to the 
Black Knight's first chamber. If you wait, 
the platform will slip out from underneath 
you, dropping your characte r clown to 
Trouble #3, saving you the trip through 
the first two rooms, and possibly saving a 
few game lives as well. 

DEJA VU: 
A NIGHTMARE COMES TRUE 

Use The Note Pad 
To Keep Track Of Addresses 
Use the Note Pad DA to jot clown ad­
dresses, names, e tc. That way, whe n you 
get into a taxi, you' ll a lways have the 
exact information you need, when you 
need it. 

Talking To The Woman 
In The Car Trunk 
She's a little out of it. but she might 
respond to certain d rugs. 

Don't Leave Horne 
Without It 
Keep your gun loaded and handy. You'll 
need it if you run into an alligato r. Or 
worse. 
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Never Let The Coppers 
Take You Alive 
Don't enter the police station unless you're 
certain you've collected enough physical 
evidence to exonerate yourself from the 
murder. 

fLIGHT SIMULATOR 

Creating Poster-Sized 
Screen Dumps 
You can create a huge, almost poster­
sized screen dump of a Flight Simulator 
screen by pressing Command-Shift-S. The 
program then prompts you to insert a for­
matted disk w ith at least 200K free. After 
inserting the disk, click on the close box, 
and12 large PICT files will be saved. The 
series can be printed and taped togethe r 
to form a poste r of your favorite exploits. 

Access Five 
Hidden Situations 
To activate five prerecorded situations 
that don't normally appear among your 
choices, start by choosing Load RAM 
From Disk from the Situation menu. The 
Flight Simulator disk ejects, and you'll be 
prompted to insert a disk containing a 
Situation file. Don't. Instead, reinsert the 
program disk. This confuses the program, 
which ejects the disk again, prompting 

you to reinsert it. Do it again and you 
should be able to find those hidden 
situations. 

INFOCOM 
TEXT ADVENTURES (ALL) 

Mapping Is Essential 
As simple as Infocom adventures appea r 
on the surface, you can't get anywhere in 
the game without making a map. To do 
this, draw a circle at the first location and 
name it, with arrows to indicate which di­
rections the exits are in. Then, when you 
go to a new area, connect the correspond­
ing arrow with a new circle and repeat the 
process. This can help you avoid e nding 
up as grue-meat. 

Change Fonts For 
A Change Of Pace 
You can add a bit of extra spice to your 
games by changing the display font to 
something prettier. Spellbreaker looks 
great in London; a nice simple Times font 
adds a down-to-business look to murder 
mysteries like Witness. 
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KLONDIKE 

Speed Counts As 
Much As Accuracy 
Klondike scores you on how many ca rds 
you can move off the playing board, but 
that's only half the story. You lose points 
for taking too much time, and also for 
repeating the deck more than three times. 
For maximum high scoring, go as fast as 
you can. 

Put Cards On The 
Board Before Moving 
Them Onto Aces 
You score 5 points for eve1y card you put 
on the board, and also score 5 points for 
eve1y card you move onto the aces. 
The refore , putting a card on the board 
and THE moving it to the "off'' piles 
scores you 10 points per card instead of 
only 5. 

Don't Play Your Last Card 
Until You Have To 
When the last card available has been 
played- even if that means turning over 
the one remaining card in the deck- the 
score freezes and you don't gain any 
more points for moving the cards off the 
playing board. So, when you're on the 
verge of winning, be sure to move off as 
many cards as you can from the playing 
board before you play the last care!. 

28 

Attaining A "Perfect" Score 
Even the fastest (and luckiest) player has 
trouble scoring higher than 4000 points, 
and 5000 or more practically qualifies as 
a world record . Still, you can amaze your 
friends by being the only kid on the block 
with a score in the high 9000's- if you're 
willing to cheat. 

Simply boor up the game and leave it on 
long enough for the time penalties to roll 
the score over from negative numbers 
back to positive ones. (You can speed 
things up a little by continuing to turn 
over the deck afte r you've lost a game.) 
The next time the high scores appear, 
your name will be enshrined in the I\ umber 
One position - with an "unbelievable" 
score. 

MAcGoLF 

Putt Like A Pro 
When you're on the putting green, make 
sure the wind is at zero. Then face away 
from the hold, and place the swing indi­
cator at zero. Click once on the Up arrow 
and putt, recording how far the putt goes. 
Now, do the same thing again, except this 
time, click twice in the swing indicator's 
Up arrow. Keep doing this, adding one 
click each time, until you reach a full ­
strength pu tt. This helps you figure out 
how many clicks you need to do to get the 
ba ll to move different distances. 
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MOEBIUS 

Saving Your Most 
Experienced Fighters' Lives 
Creating characters in Moebius is ex­
tremely time-consuming, since every new 
fighter has to be tra ined in three types of 
combat. When characters are killed later 
in the game (and their extra lives are used 
up) , they're gone for good. Or are they? 
You can preserve your important char­
acters by saving and quitting the game. 
Then, open up the folder with the game, 
select by Date under the View Menu, and 
then copy all the files with the curre nt 
elates on them to a separate disk. Then, if 
a character dies, copy the backups into 
the game folder. Whenever your charac­
ter advances in levels, wealth , and/or 
food, back him or her up again. 

Be Nice To The Locals 
How you deal with the citizens of Khan­
tun directly affects the amount of clues 
and other help they give you. Don't pick 
fights whe re you don't ha ve to. 

Contents of Chests 
And Vials Is Random 
You can maximize the type of treasure 
you get by saving the game before search­
ing chests and vials. Then, if you don't 
like what you get, you can restart the 
game and search them again. 

Close Doors Behind You 
Guards ofte n steal treasure from you. 
When you close doors after ente ring or 
leaving a room, you cut off their escape 
route, making it easie r to reclaim your 
tl1ings without a long chase. 

Tips For Fighting Guards 
When a guard approaches, wait until he 
is just in front of you, the n use low swings 
to hit his legs. After you strike him, imme­
diately use an '0 ' or an 'I' to deliver a hit 
to his head. Finally, use a 'K' or an 'L' for 
a mid-level swing to his anns. 

Tips For Fighting Assassins 
Punch Assassins in the face when they're 
almost on top of you. If you miss, hit the 
'A' key to back out of range. Keep one 
finger on that key, and another on the 'X' 
to move forward. If you're about to lose 
a fight, Quit and restart from your last 
save. 

Tips For Fighting 
Evil Monks 
Stun evil monks with fireballs, then use 
long strides to overlap them and plant 
middle and high kicks to their faces. You 
can also pa ralyze a Monk before the battle 
stans, then kill him with a single hammer 
blow. This is handy whe n you're attacked 
by a group . 

Practice Bare-Handed 
Combat Early In The Game 
No matter what foe you're up against, 
bare-handed combat is a very reliable 
way to fight. Practice it a lot in the ea rly 
stages of the game to ga in expertise 
against relatively small enemies. The low 
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kick is an excellent choice against a ll ad­
versa ries except Monks. 

How To Kick 'Em 
Where It Hurts 
An e ffective fighting method is to move 
into the center of the combat area and 
wait for your foe to advance, then kick 
him as he moves in. 

In The Earth Realm ... 
A good strategy is to head for the Cistern, 
refill your waterskin, and clear a path clue 
east to the Palace steps. Enter and con­
front the Overlord by moving north into 
the Palace Court. Make sure to get a ham­
mer by defeating a guard. Don't go through 
the Astral Gate until you're a Level l O with 
a full supply of food and water, and are in 
good health. 

In The Water Realm ... 
From the weste rn land, swim north to the 
Palace island. Follow rhe path northeast 
to the Tower, then rake the path west and 
southwest to the Palace steps. 

In The Air Realm ... 
The Demon and the Condor can't be 
defeated, so just avoid the m. 

In The Fire Realm ... 
The Floating Skull can only be defeated 
with fire balls. The flames are a waste of 
time; avoid them. 
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ROGUE 

Saving Characters 
From Automatic Deletion 
Rogue de letes a character from the disk 
each time the character file is opened at 
the start of a saved game. making it 
difficu lt to re-save him- and impossible 
if he meets an untimely encl. To avoid 
losing a really great character, save him 
and the n eject the disk and lock it. Then, 
reinsert the disk and play the game. Since 
the disk is locked, the game can't erase 
your cha racter. When you're ready to 
save his newest experience back to disk, 
eject and unlock the disk, then reinsert it 
to save it again . 

SARGON Ill 

Setting Handicaps 
The game's no rmal settings are roo hard 
for less experienced chess players. You 
can handicap Sargon for beginners by 
ra king pieces away from Sargon's setup 
before starting the game. Handicap by 
pu lling down the Options menu and 
selecting Change Board. Then, drag the 
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pieces you want off the playing field and 
click OK to start the game. 

SHADOWGATE 

Use The Note Pad 
To Keep Track Of Clues 
The Note Pad DA is useful for keeping 
notes handy. Just jot them on the Note 
Pad and you can refer to them whenever 
you need to. 

Don't Ignite Torches 
Without Examining Them 
There's a special torch you need to get 
through a ce1tain section of the game. 
Examine all torches you fi nd before light­
ing them, and save the one that looks 
diffe rent for a special situatio n. 

Surviving The Dragon Room 
You need several items located in the 
dragon's lair. To retrieve them with your 
hide intact, grab the shield first. You the n 
have three more times to take more things 
(like wea pons) before the shield melts 
under the dragon fire. 

Let Randomization 
Work In Your Favor 
The Sphinx asks you for a certain item, 
couched in the form of a riddle, when you 
enter the room it inhabits . However, the 

exact item it asks for is randomly-gener­
ated. To increase your chances of having 
the ite m the Sphinx wants in your posses­
sion (or at least, know where to find it), 
save the game just before entering the 
room. If the Sphinx asks for an item you 
haven't located, just Quit and start again 
for a chance at bette r luck. 

SHANGHAI 

Remove Tiles When You Can 
See All Four Of Them 
While you can't really cheat at Shanghai, 
you can vastly improve your chances for 
winning by tiy ing not to remove any sets 
of tiles unless all four matches are show­
ing. This gua rantees that you aren't inad­
vertently trapping a tile under its only 
match. 

SIM(ITY 1.0 

Collecting All The 
Taxes You're Owed 
SimCity has an annoying habit of resetting 
the tax rate to zero w hen you load a saved 
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city. If you save and quit from the loaded 
city mid-year, you' ll find that when .Janu­
<liY rolls around, several months have 
gone by with no taxes be ing collected. 
This can devastate a city already on the 
brink of financial disaster! 

To avoid any loss of funds when you 
restart a game, immediate ly call up the 
Budget window and enter the tax rate. 

Printing Cities 
With The LaserWriter 
The game manual and Print dialog box 
warn that LaserWrite r printing isn't sup­
ported, but that's not entirely true. The 
LaserWriter can indeed produce (l imited) 
printouts from the game. 

When you choose Print City from the File 
menu, you're offered two choices: print 
all on o ne page (this produces a reduced 
city map without fine detail) or print a 
tiled map (2-by-3 pages in size which 
displays buildings, roads and other fine 
derails). 

If you print to a LaserWriter, the 1-page 
map prints out just fine. Choosing the 
tiled map p roduces the first section or 
page of the map, but the remaining 5 
pages must be p rin ted with a n 
Image Writer. 

SMASH HIT 
RAQUETBALL 

Fast Shutdown 
Make a fast shutdown from the game by 
pressing Command-Q to return to the 
Finder. 

S~ELLBREAKER 

If At First 
You Don't Succeed ... 
It's a good idea to learn all spe lls more 
than once, since they don't always work. 
This isn't a problem with the "blorple" 
spell, or when you have the magic cube. 

Which Cube Is Which? 
It's crucial to keep track of where each 
cube takes you, which you do by wri ting 
on them with the burin. 

Don't Leave 
Home Without It 
The zipper is extremely handy. It's used 
for storage. If you're told you 're ca rrying 



GAMES 

too much to pick up something new, just 
stuff a few things into the zipper. 

STRATEGIC CONQUEST 
PLUS 

Attack On Each Move 
Don't limit fighters to two attacks per 
round. Use the Move Late r command after 
each attack to attack on each move. This 
works for all water pieces as well. 

Regaining Full 
Naval Strength 
Carriers and battleships can safely regain 
their fu ll strength if you put them into po11 
for repairs and then use Move Later until 
d1ey're fixed. 

Keeping Fighters 
Out Of Combat 
You can protect fighters from attack by 
leaving the m in an empty enemy city. 

When To Build Bombers 
Start building bombers on day 30 to get a 
blast radius of 1. For a blast radius of 2, 
stan on clay 65. 

Stealth Bombers 
On The Cheap 
You can hide bombers by placing them 
on the same square as any other piece. 

THROUGH THE 
LooKING GLAss 

Secrets Of The Cheshire Cat 
Through The Looking Glass has a number 
of undocumented oddities. For example , 
clicking on the Cheshire Car's left eye and 
watch the opposing pieces change at 
random. Click the eat's mouth and the 
playfield turns upside-down. Click the 
eat's nose to reverse all of your mouse 
movements o n the screen. And click on 
the eat's right eye, and the black hole on 
the playing board multiplies until the 
entire board is eaten away. 

UNINVITED 

Keep Magic Words 
Handy On The Note Pad 
The ore Pad DA is the pe rfect place to 
store magic words so they're always handy 
when you need to use them. 

Making Friends 
With The Gremlin 
The little animated gremlin who runs 
across the screen has an important item to 
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give you. You can offer it a bribe by leav­
ing the item in the room, then waiting 
there for the gremlin to appear. When 
you've offered the right gift, you'll earn a 
reward. 

In The Greenhouse ... 
Water the plants. You never know what 
you might grow ... or how it might come in 
handy later in the game. 

In The Dungeon ... 
You don 't have to read all the epitaphs 
you find on headstones. However, if you 
put flowers on a certain grave, you might 
find some appreciation from an "anony­
mous" benefactor. 

A Circle Of Death? 
The three caged animals will kill you -
unless you cage the right one quickly. 
When you do, the o ther two animals 
distract each other. 

Dealing With The 
Floating Monster 
The weird, floating monster in the dun­
geon won't le t you pass unless you give 
it something ro distract it. Hint: it moves. 

There IS A Way In! 
The locked door in the study remains 
locked, but there is a way in . Don't waste 
your rime uying to find it, though, since 
the way in is extremely roundabout, and 
you WILL find it soone r or later. 

There IS A Way Out! 
When the bathroom srans filling with 
water, wait until the water enables you to 
reach the light fixtu re and break the 
fixture to avoid drowning. 

UNIVERSE II 

Finding Your Way Around 
Get a good astronavigaror and asomni­
gate him as soon as possible. If his grade 
is lower than 14, hire another one and put 
him in school until he's a grade 18 or 19. 

Don't Forget The Engineer 
The engineer is you r most important crew 
member. Get one who is at least a grade 
10, and put him in school to advance to 
grade 18 or 19, then find another one 
who's grade 10 to use until the o ther one 
graduates. 

Fuelish Is Foolish 
Get a new convener and hyperdrive as 
soon as possible. The better ones are 
more fue l-effi cient, so you can build up 
more money soone r. 

Weapons Can Wait 
Don't buy weapons for the first year, since 
you aren 't strong enough to do much with 
them, anyway. 

The Place To Get Ships 
The best place to buy a ship is at Arbest, 
and it's also the best place to outfit it with 
the highest technology. Take at least 
300,000 credits for your shopping spree. 
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Avoid Jumping From 
System To System 
The most profitable trading routes are 
those that don't require system jumps, 
since they use the least amount of fuel. 
Pyxis is the most lucrative system overall. 

Piracy Doesn't Pay 
As Well As Trading 
Don't even attempt ro pirate until you've 
learned the ropes as a trader. You have to 
know which items to sell where, and 
which items are wonhless, or you 'll starve 
to death. Mining is much more lucrative, 
anyway. 

WIZARDRY 

Avoiding Mistakes 
Getting Written To Disk 
You just can't get a break in Wizardry. 
Unlike many other role-playing games, it 
writes evety stupid mistake you make to 
the disk. There is a way to avoid this, 
though: w hen you're about to enter a 
situation that experience has told you is 
dangerous, just pop the disk (Command­
Shift-} or Command-Shift-2) and then 
enter the area. When the battle is finished , 
the program will ask you to reinsert the 
disk. If you didn't take any major losses, 
go right ahead. If you lost a major charac­
ter, turn off the computer and reboot 
instead. 

Dishonesty Pays Well 
If you're willing to cheat for some extra 
gold, use the Swag bag to duplicate 
potions and other expensive treasures. 
When your roster has an item in the bag, 
you can switch rosters and the item will 
still be there . Just back up your roster, 
Give the ite m to the bag, and then Restore 
the roster. Keep the duplicated item, o r 
sell it - or use this trick to equip every 
member of your party with a Wand of 
Conflagration. 

Exit - Stage Right 
You can quickly exit the maze on Level 
10. just walk into the little alcove right 
next to the entry point on that level. 

Werdna Isn't 
(Always) So Tough 
The final battle against Werd na and his 
buddies is harder at some times than it is 
at others, since the game randomly gen­
e rates the number of monsters in his 
chambers. Pop the disk and lock it (see 
above) and then reinsert it. IfWerd na has 
only two allies at his side, it's the right 
time to fight him. 
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ADOBE ILLUSTRATOR 

Undoing A Move Even After 
Disabling "Undo Move" 
There's a helpful way to Undo an acci­
dental move, even if you've already clicked 
the mouse button and so lost the oppor­
tunity to Undo Move from the Edit me nu. 
First, make sure that the same anchor 
points are still selected - if they're not, 
select the object. 

Now, hold down the Optio n key as you 
click the Pointer tool. The Move dialog 
box will appear, showing a positive value 
beside "Move distance." This value rep­
resents the distance in points of the LAST 
MOVE YOU MADE. All you have to do is 
make that value negative by insetting a 
minus sign in front of the positive num­
ber, and then click OK. Your ancho r 
points will slink right back to where they 
were before you made the "wrong" move. 

Moving Or Copying Objects 
In The Preview Mode 
Although the Adobe Tllustrator manual 
stares that the currem art file can·t be 
edited in the Preview mode, there are 
some ways around that. You can move 
and copy objects in the Preview mode by 
using the Move dialog box. 

Select the object you want to move or 
copy, and enter the Preview mode. While 
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there, hold down Option while clicking 
the Pointe r tool in the toolbox to call up 
the Move dialog box. Now, just enter the 
distance and/ or angle data you want and 
click OK (or Copy). The object will move 
or duplicate immediately and you'll be 
able to see exactly how this adjustment 
will affect your printed copy. You 'll find 
this very useful in making changes to 
aspects of the illustration that you can 
only see during Preview. 

Layering Graphics Higher -
But Not At The Top 
You p robably already know how to take 
an object low in the painting order and 
bring it to the front of everything else. 
However, there will probably be ti mes 
whe n you wish you could bring the 
graphic forward, but not all the way to the 
top, as if removing a playing card from a 
deck and inserting it several cards away 
from the top. If you cut the object and 
paste it in front, then you'll have to select 
all the other objects that are supposed to 
be in front of it, and then move them in 
front to achieve the proper layering. 
Sounds complicated, and it is. However, 
there is a simpler way: 

Select the object that you wa nt to bring 
forward, together with the fotward object 
you want to move the first object directly 
behind. Group them while they're both 
selected by pressing Command-G. That's 
it! You clon·t have to cut and paste, and 
even if you Ungroup them, the layering 
change is presetved. The front-most ob­
jects can be left alone, with no editing at 
all. 
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Working Around Text 
Elements 
Illustrator 88 has problems creating text 
elements such as tabs or leaders . You can 
type in a row of periods, but trying to 
create leaders for a simple list of products 
and prices, for instance, is time-consum­
ing. Stretching or shrinking the row to fit 
a specific width distorts it. One solution is 
to create a clashed line: 

1. Draw a line with the pen tool. 

2. Press Command-! to bring up the 
Paint dialog box. 

3. Choose None for the FiU, and Black 
100 percent for the Stroke. Enter a line 
weight (the default is 1 point), select 
the second choice for Caps, click on 
the Dashed button, and enter 0 in the 
first Dash Pattern box (constraining 
your dashes to be perfect circles or 
dots) and a number to specify the 
space (in points) between your dots. 

4. To see your changes on screen, go 
to the Preview Illustration view. (Click­
ing on OK takes you back to the 
Artwork Only view, but you won't see 
the dashed line you just created.) 

5. To modify the line, go back to the 
Artwork Only view. You can resize 
this line with the Scale tool so that it 
fi ts in any width without distortion. 

Quickly Cancelling Preview 
illustration Saves Time 
You can cancel Preview Illustration by 
typing Command-period. This is useful if 
you're using patterns or color and the part 
you wanted to check has already been 
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previewed, since it can take several 
tninutes for the entire illustration to pre­
view fully. 

Inserting An Object 
(Almost) In The Front 
It's easy enough to take an object low in 
the painting order and bring it in front of 
everything else. However, you might want 
to bring it forward only so far- not all the 
way to the front. Here's a sitnple way to 
do it: 

Select the object you want to bring for­
ward together with the forward object 
you want to move the first object right 
behind. Group then1 while they~re both 
selected with Con1mand-G. 

That's it. Even if you Ungroup the objects, 
the layering change is permanent, and the 
f01ward objects don't have to be shuffled 
around. 

Extracting 
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lliustrator 88 Graphics 
From PageMaker Flles 
Extracting Illustrator 88 graphics fron1 
PageMaker files can be done as follows: 

1. Open the PageMaker document, 
choose Print from the File menu, 
hold down the Option key, and click 
on the OK button in the Print dialog 
box to bring up the PostScript Op­
tions dialog box. 

2. Turn off the Download bitmap fonts, 
Download PostScript fonts, and In­
clude Aldus Prep options. Nan1e the 
file to make finding the PostScript 

file easier; otherwise it will be called 
PostScriptO (1,2,3, and so on). Save 
the file either as EPSF or as Normal. 
Click on the Print button, and close 
PageMaker. 

3. Open the resulting PostScript file 
with Illustrator 88. Illustrator recog­
nizes only the PostScript code that 
corresponds to its file, and when the 
PostScript file is explicitly saved from 
within Illustrator, only that code is 
saved. 

Create Distortion-Free 
Leaders With A Dashed Une 
Using rows of periods to create leaders 
doesn't work well in Illustrator 88 be­
cause stretching or shrinking rows dis­
torts the spacing between periods too 
much. You can work around this by cre­
ating a leader with a dashed line: 

First, draw a line with the pen tool. Then, 
press Command-1 to invoke the Paint 
dialog box. Choose None as a fill, and 
Black 100 percent for the Stroke. Enter' a 
line weight (the default is 1 point), select 
the second choice for Caps, click on the 
Dashed button, and enter 0 in the first 
Dash Pattern box and a number to specify 
the space (in points) between the dots. 
You can see your changes on-screen by 
going to the Preview Illustration view. If 
you want to modify the line, go back to 
the Attwork Only view. You can resize 
the line with the Scale tool so it fits in any 
width without distortion. 
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Importing mustrator 88 
Files Into Quark XPress 
Quark XPress lets you place and print 
patterned artwork created in Illustrator 88 
if you save the Illustrator document as an 
EPSF file. You'll face a bottleneck in Illus­
trator, though: saving a single art file in 
EPSF can take several n1inutes. If you do 
a lot of saving and revising, you'll waste 
valuable work time. 

Part of the delay in saving sten1s fron1 
Illustrator's tendency to create and show 
a Mac Preview image in its Print dialog 
box. You can stop this by unchecking the 
Preview and Print Patterns options in 
Illustrator's Preferences menu. 

Now, when you save in EPSF there will be 
no lengthy wait. The itnage will print out 
correctly through Quark XPress, but it 
won't appear on-screen. 

Making All Your Lines 
Thicker Or Thinner 
You don't have to spend hours changing 
stroke attributes to, say, tnake all the lines 
in your document half as thick. There's an 
easy way to do it: 

Select the necessary paths and activate 
the scale tool. Click on one of the selected 
anchor points while holding down the 
Option key to open the Scale dialog box. 
To thin all selected paths uniformly, scale 
the object larger in the Scale dialog with 
Preserve Line Weights selected, and then 
iinmediately scale the selection back to its 
original size with Scale Line Weights 
selected. (Make sure to Option-dick on 
the san1e anchor point when reducing the 
object back down, so the object keeps its 

original position on the page.) 

The percentage you enter to scale the 
object back to its correct size must be 
fractionally inverse to the percentage to 
which you enlarged it (ie, a 200-percent 
enlargement is remedied by a 50-percent 
scaling factor; 500 is remedied by a 20-
percent factor, etc.). 

To n1ake selected paths unifom1ly thicker, 
follow the satne procedure, except choose 
Scale Line Weights while scaling up, and 
Preserve Line Weights while scaling down. 

39 



GRAPHICS 

CANVAS 

Creating An Accurate 
Display Of Proportional 
Rectangle Resizing 
To accurately see the proportional re­
sizing of rectangular objects, draw a di­
agonal line from one corner of the object 
to the o ther, and extend it, keeping it 
lined up against the two handles. 

:--Jow, grab a corner handle at the e nd of 
the diagonal line and resize the object 
while keeping the handle on that line. 
Finally, de lete the line. As long as the 
handle is on the diagonal li ne, the object 
is in proportion. 

CANVAS 2.0 

Accessing An 
Undocumented 
Search-And-Replace Feature 
Yo u can perform an easy search-and­
replace: Hold down Option w hile choos­
ing Select All from the Edit menu. Then, 
make a selection from the Pen Patte rn, Fill 
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Pattern, Foreground Color, Background 
Colo r, Pen Shape, Line, o r Transfe r Modes 
pop-up menu. Canvas will select all the 
objects with that attribute. You can now 
choose any attribute (such as fill patterns) 
that you want, to globally replace the 
selected attribute. 

Displaying Small-Scale 
Fractions On-Screen 
Whe n using Canvas 2.0 fo r architectural 
or engineering drawings, choosing Show 
Dime nsions in Fractions under Pre fe r­
ences will not give you fractions fo r small 
scales such as 1" = 1' or 1/ 2" = 1". You can't 
get fractions in your dime nsions by typing 
in 1"=1' in the Rule r Manager. 

If you want to d isplay fractions on-screen 
for such scales, the right-hand side of the 
scale in the Ruler .VIanager box must 
always remain at 1". Then divide the left­
hand side of the scale fo r whatever frac­
tion of the inch you want. For example , 
if you need 1"=1' , use 1/ 12"=1" , which 
you enter as .0833=1". Fractions now 
appear in your auto-dimension lines. 

Getting Rid Of The Frame 
Around Each BitMap 
Although Canvas' multiple layers and 
overlay modes let you superimpose bit­
mapped objects over other graphics, the 
rectangular frame around each bitmap 
whites out everything below it, ruining 
the effect. If you tty to make the bit­
mapped object transparent by using the 
Not Or option in the Ink Manager, the 
background shows through the white 
borde r - but it also shows through any 
white inside your object! He re 's a worka­
rouncl fo r the problem: 
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First, duplicate the bitmapped object, and 
use the paint bucket to fill in the frame 
area of the duplicate with black. Make 
sure the outline of the picture is a continu­
ous line so the paint won't overflow the 
image itself. If the background is solid 
black with no patterns, skip the next three 
steps. 

Second, use the Ink Manager controls 
near the bottom of the tool palette to 
change the object with the filled frame 
from Copy to the Not BIC overlay mode. 
The object will be invisible unless it is in 
from of another graphic, so don't lose 
track of its position. 

Now, select the original bitmap with the 
unfilled frame and change its overlay 
mode to Or with the Ink Manager. 

Then select Bring to Front from the Object 
menu to bring the object to the front of the 
display. 

Finally, select both objects , place them 
exactly together with the Align command 
from the Object menu , and group them 
before clicking the mouse anywhere else. 
When laid over anothe r object, the frame 
is transparent, but now nothing shows 
through the interior of the picture. Note 
that PostScript doesn't work with many 
QuickDraw overlay modes, so test print­
outs are mandat01y when using Post­
Script-compatible printers. 

More Realistic Tracing 
You can make your traces more realistic 
and closer to the original image by select­
ing the bitmapped object and choosing 
the Object conunand from the Object 
menu. Change the resolution in the dialog 

box from 72 to 300 dpi. Click OK and 
close the box. Now auto-trace the object. 
This increased resolution creates more 
handles as well as drastically improving 
your traced image's appeara nce. 

Switching Windows Without 
Using The Windows Menu 
rf you're working with Canvas on a large­
screen mo nitor and have several win­
dows open, using the Wi ndows menu to 
switch between all your windows is a 
bother. An alternative is to Option-dick 
anywhere in the title bar of a w indow 
(except the zoom or close boxes) to get a 
list of all open windows. 

CRICKET DRAW 

Creating A Partly-Dotted, 
Partly-Solid Element 
If you want to draw an oval or circle that's 
partly solid and partly dotted lines, you 
can do a quick cheat to get it done. First, 
draw a number of evenly-spaced lines 
over the po rtion you want ro make dotted 
(Cricket Draw·s Grate tool is excellent at 
this) and then just make those lines white. 

Use ALIGN OBJECTS To 
Control Object Placement 
Permanently 
Cricket Draw comains a little-known trick 
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that allows users to gain total control of 
object placement by using the Align 
Objects command. The ordering of ob­
jects drawn doesn't depend on their crea­
tion order or positioning, but rather in 
their layering. That means, selecting an 
object and choosing Bring To Front from 
the Arrange menu will later make that 
object the point of reference for fu ture 
Align commands. 

For example, when you have an object 
you'd like to align with other objects, 
select the item and choose Bring To Front 
from the Arrange menu. Then, Shift-Click 
on the othe r objects you want aligned 
(press Shift w hile clicking o n each one), 
and choose Align Objects from the M­
range menu. Regardless of the alignment 
clone, the object on the top layer w ill 
remain in its original position. 

Printing Is Faster When 
You Ungroup Objects 
When printing documents that contain a 
large number of grouped objects, you' ll 
save printing time on LaserWriters by 
ungrouping your objects just before you 
print your document. 

CRICKET DRAW 1.1 

A Bug 
This version has a bug that wasn't present 
in Cricket Draw 1.0. If you construct a 
two-sided open polygon and then add an 
arrowhead to the end , the arrowhead will 
appear correctly on-screen, but will print 
out at the intersection between the two 
lines instead. 

The workaround is this: add an extra 
clickpoint to the polygon. For some 
reason, this results in a printout with the 
arrowhead positioned at the end of the 
polygon, where it should be. This w ill 
work every time. 

FREEHAND 

Placing Text Around 
The Outside Of A Circle 
Although FreeHand has a feature to allow 
users to create text on a curved path , 
you'll probably fi nd it a real challenge to 
accurately place text around the outside 
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of a circle. The text normally starts to 
wrap clockwise around the outside of the 
circle beginning at the 9 o'clock position. 
To center a word or phrase around the 
top of the circle, first draw your circle. 
Then select the Text tool and click your 
insertion point above the circle. In the 
Text dialog box that appears, choose the 
typeface, font and style you want and 
type in the text. OK your selections. Now, 
select the text block and the circle and 
press Command-] to join your text to the 
circle. 

When you've done this, you'll notice that 
your text has moved to the center of the 
curved path at the 3 o'clock position. 
Move it to 12 o'clock by using the Rotate 
tool to rotate the joined circle and text 90 
degrees counterclockwise by dragging 
the bottom-right size box to the position 
of the top right-size box. 

Wrapping Text Inside A 
Circle 
Getting text to wrap counterclockwise 
along the inside of a circle is accom­
plished with a method very similar to the 
one described a hove. Center the text 
within a circle at the 6 o'clock position by 
following the instructions above, with a 
minor change: 

Press Command-] to JOin the text and 
circle, then use the Mirror Reflection tool 
to flip the circle vertically. Now the text 
will be wrapped along the inside of the 
circle at the botton1. 

Wrapping Text Above And 
Below A Circle 
You can combine both of the effects 
described above, select both effects and 
choose Align Elements from the Elements 
menu. Then, hit the Center radio button 
for both Vertical and Horizontal align­
ment. The result is a circle with text 
around both top and bottOin. 

Opening Adobe illustrator 
88 Files With Freehand 
While FreeHand can easily open Adobe 
Illustrator 1.1 files for editing, it usually 
can't open Adobe Illustrator 88 files. 
Here's how to bring your Adobe Illustra­
tor 88 files into FreeHand: 

Open the Illustrator 88 file with Illustrator 
88, and Save As an Illustrator 1.1-compat­
ible file to convert custom colors to pro­
cess colors, and also to defeat masking 
and retnove all patterns and placed or im­
ported in1ages. Don't worry, all your ob­
jects will be retained. Next, open the file 
using Illustrator 1.1 and then save it. Now 
you'll be able to open it with Freehand. If 
you don't have Illustrator 1.1, you'll have 
to open the file using a text editor capable 
of saving text-only files. 

Change the second line fron1: 

to: 

%%Creator: Adobe Illustrator 88 
(TM) 1.6 

% %Creator:Adobe Illustrator 88 
(TM) 1.1 

It's in1portant to ren1en1ber that you'll 
have to delete the space before "Adobe". 
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Now, save as TEXT 01\LY, and open the 
file with a resource editor and change the 
Creator from ARTZ to ARTY. The result­
ing file can now be opened and edited 
with Freehand. 

Simulating Filled, 
Outlined Text 
Although FreeHand doesn't allow out­
lined text to be filled in with shading, 
there is a way to simulate that effect: 

Create the shading color you want to use. 
Select the text tool and create a text block 
specifying outlined format. 

Once you've clicked OK, go to the Edit 
menu and choose the Clone command. 
This will create a duplicate of the first text 
block right on top of the first one. 

Double-click to edit the cloned block. 
Make sure the text is selected in the 
resulting dialog box. 

Now, change the text effect box to read 
"solid" and [change to color box to be the 
color] you created to fill. 

Then, click OK and immediately send that 
text block to the back. This trick works 
because outlined text in FreeHand is 
transparent, and lets the shaded text block 
show through. 

Adding Variety To 
Unes With Zapf Dingbats 
Unless you can progran1 in PostScript, 
you'll probably find the fill and line op­
tions dull after awhile. You can expand 
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your options by combining two Free­
Hand techniques with some ready-made 
PostScript images- Zapf Dingbats. 

To convert any drawn line to a line made 
up of dingbats, use the "text on a path" 
feature. First, draw the line. Then choose 
the Text tool and create a single line of 
text in a small point font (6 point works 
very well) that's longer than your drawn 
line. Select both your text block and the 
line you wish to convert, and use the join 
Elements con1n1and from the Element 
menu. That's all there is to it. 

Using Zapf Dingbats 
As A Fill Pattern 
You can also use dingbats as an unusual 
fill pattern in your objects by using the 
"clipping path" feature. First, create the 
area you want to fill. Then select the Text 
tool and create a block of text large 
enough to cover your fill area. Now, 
select the text block and use the Cut 
command to send it to the Clipboard. Fi­
nally, select the area to be "filled" and 
choose Paste Inside fron1 the Edit menu. 
The same techniques work with other 
fonts, but if they aren't PostScript fonts 
you'll find then1 printed out as bitmapped 
characters. 
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Quickly Deselect 
All Items In An illustration 
You can deselect a ll the items in an 
illustration by pressing the Tab key. This 
is particularly useful w hen you're in a 
close-up view and want to deselect an 
object without selecting a larger one 
behind it. 

Drag A Small Object Without 
Grabbing Its Resize Handle 
If you can't drag a small object without 
grabbing o ne of its resize handles, try 
drawing a large object next to it, selecting 
both, and then putting the pointer on the 
big object to move them as a unit. Whe n 
the small object is in the correct spot, 
deselect borh objects and delete the larger 
one. 

Express Route 
To The Edit Dialog 
You can get to the Edit dialog fast to alter 
a line, fill o r color style. Just press Option 
and select the style from its menu. 

Archiving Lines, 
Fills, and Color Styles 
To save a reusable library of lines, fills, 
and/or color styles for use in other Free­
Hand illustrations, define the styles in a 
blank illustration file . You can also select 
a target printer and print settings , and add 
objects (like logos) that you want in every 
new document. The n choose Save As, 
name the file, click on the Template 
option, and save. 

The next time you need these styles, use 
the template to create your illustration . 
You can even make these styles your 
FreeHand default setting by deleting the 
Aldus FreeHand Defaults file that came 
with the program and assigning that name 
to your template file. 

Getting More Control 
Over FreeHand Tracing 
Double-click on the trace tool to display 
the Curve and Corner dialog box, which 
lets you get mo re control over the number 
and kind of points FreeHand applies 
while it traces. 

Getting The Most 
Out Of Tracing 
Gray-Scale TIFF Images 
Whe n tracing a gray-scale TIFF image, 
you'll get the best resul ts if you make it 
into a black-and-white image first. Select 
the image, choose Element Info, and click 
o n the Black and White option. Adjust the 
contrast and lightness to obtain the high­
est contrast, and then trace the image. 
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Opening MacPaint Files 
Without Loading FreeHand 
You can open any graphics file MacPaint 
can open just by double-clicking on it, the 
same way you would if you were using 
MacPaint. 

Using a resource editor like ResEdit or 
FEdit, you can alter your FreeHand pro­
gram so that it opens files like MacPaint. 
Within the resource editor, select the 
paint program you'd like to use (in this 
case, FreeHand). Check the field Creator 
and change what it says to MPNT. Then 
quit the resource editor and return to the 
Finder. You'll notice that your FreeHand 
icon now looks like the MacPaint icon. If 
the real MacPaint is on your disk, get rid 
of it, or this tip won't work. 

As with any resource editing work, n1ake 
changes only on a backup of FreeHand. 

Faster Screen Redraws 
For faster screen redraws, work in Key line 
mode rather than Preview mode. In the 
Docun1ent Setup dialog box, select Faster 
for display quality. In complex illustra­
tions, use Layer Control to view only the 
layers you need to see while you work. 
Move TIFF images, transformed text, and 
eletnents with complex fills to layers that 
are kept invisible until you need to see 
them. 

1 
If you have a color or gray-scale monitor, 

i use the optimum settings (2 grays or 256 
colors); also use 2 grays (black and white) 
when you're working on black and white 
illustrations. 

finish updating, press Con1n1and-period 
to stop the redraw. 

Faster Printing 
Of PostScript Fills 
When printing PostScript fills to a Laser­
Writer, make the color parameter gray 
(either 0 or 1) instead of color to speed up 
printing. 

Faster Printing Of TIFF Files 
.Make TIFF files print faster by using black 
and white images whenever possible. If 
you've applied color to a TIFF itnage, the 
color processing slows down printing tre­
n1endously. 

Having Trouble Printing 
Custom PostScript Line And 
Fill Effects? 
You can avoid problems when printing 
custom PostScript Line and Fill effects by 
making sure your UserPrep file is in the 
correct folder and is properly named. If 
UserPrep isn't in the FreeHand folder or 
the System Folder, you'll get an "unde­
fined" PostScript error. 

Compatibility Problems 
With Older Systems And 
LaserWriter Drivers 
If your printer won't print a FreeHand file 
unless there is text on the page, it's be­
cause you have old or incompatible Sys­
ten1 and LaserWriter-driver files. When 
you update your System file, make sure to 
update your printer files as well. 

The optirnmn versions for FreeHand are 
System 6.02 and LaserWriter driver 5.2, 
although you can use Systetn 4.3 and 

If you don't want to wait for the screen to LaserWriter 5.1 as well. Earlier systetn 
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and printer files than these can cause 
trouble when you print. 

If You Print A Lot Of 
Fonts With FreeHand 
Using more than two or three download­
able fonts usually overtaxes a printer's 
men1ory and generates a PostScript error. 
Avoid this by going into the Page Setup 
dialog box, clicking the Options button, 
and checking the box marked Unlimited 
Downloadable Fonts in a Document. 
If you routinely print a lot of different 
fonts, set the above option as your de­
fault. 

Make Sure All 
The Pieces Of Your Flle 
Fit On A Printed Area 
When you print a file, FreeHand adds up 
the size of the illustration, any bleed that 
was added, and the space required for 
any print options you selected (such as 
crop tnarks and separation natnes). If all 
these pieces won't fit on the specified 
paper size -for example, adding crop 
marks to a letter-sized page and then 
printing to letter-sized paper with a Laser­
Writer- you'll receive an error tnessage. 
When printing to a LaserWriter, turn off 
the options that print information beyond 
your illustration area, or select the Fit on 
Paper option in the Ptint dialog box. 

If you use a Linotronic in1agesetter, change 
the paper size to LetterExtr, which accom­
modates the crop marks. 

Creating An 
Outlined Pattern Effect 
When using one of the PostScript lines 

from FreeHand's UserPrep file, you can 
create an outline of the PostScript line 
instead of a solid line: 

First, choose PostScript fron1 the Line 
n1enu, and type DOT (or any other file 
nan1e) in the dialog box. Then tab to the 
PostScript entry box and enter "[DOT] 10 
10 1 0 newrope" in the box. (The word 
in braces should be the name of the 
predefined pattern you want to use from 
UserPrep.) The four numbers refer to 
width (in points); height; the spacing 
between dots; and the color (O=black, 
1=white). The last term, "newrope," is a 
routine frotn UserPrep. 
Now, choose Lines from the Line menu 
and select the line name, DOT, you just 
created. Then click on the Copy button. 
The PostScript dialog box will appear 
with the attributes of the first line. Change 
the nan1e to son1ething like DOT2 and 
change the numbers in the PostScript 
entry box to "[DOT] 9 9 2 1 newrope". 
Then, draw a line with the line tool. 
Choose DOT frotn the Line menu and 
Clone (Command-=) the line. 

Fina11y, return to the Line menu without 
n1oving the lines and select DOT2. When 
printed, the cloned line will print as white 
over the black dotted line underneath 

' giving the effect of an outlined pattern. 

Centering Text Along 
The Outside Of A Circle 
You can center text along the outside top 
and botton1 of a circle by first making the 
two text blocks and setting the text to be 
center-aligned. 

Draw a circle and ungroup it. With the 
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knife tool, split the circle at the side points 
and delete the bottom half. Clone the top 
half and use the reflecting tool to tnake 
the clone the new bottotn half of the 
circle. Then join each text block with its 
respective half of the circle. 

To make the text run along the outside of 
the arcs, use the Element Info dialog box 
to align the text to the path, with the 
baseline (top half) and the ascent (bottom 
half) options. 

Creating A 
Three-Dimensional Box 
To create a 3-D box, first skew a rectangle 
upward to create one side. Then, clone 
it and use the reflecting tool to click on a 
vertical edge and move the clone to the 
opposite side of the original. Now, clone 
the second side of the box and ungroup 
the clone. Shift-select the lower left and 
lower right points of the cloned element. 
Release the Shift key, then click on one of 
these points and drag to create the top of 
the box. Finally, give each side an appro­
priately shaded fill or color. 

Fixing Improperly 
Printed Strokes 
When you specify a point size for the 
stroke of text in the Fill & Stroke dialog 
box, the stroke will be too large to print 
properly if the text isn't joined to a path. 
For painless printing, place a period be­
fore the point setting in the dialog box. 
For exan1ple, a stroke set at .20 points 
prints out as 20 points high. 
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Getting The Smoothest 
Graduated And Radial Fills 
You get the smoothest graduated and 
radial fills by making sure that the print 
quality is set to Better. Lower screen 
rulings generally create smoother fills 
because they produce more shades of 
gray. However, screen rulings are closely 
related to printer resolution: a high-reso­
lution image-setter gives you smoother 
grays, and sharper itnages, at higher screen 
rulings. (For a table of recommended 
screen rulings based on printer resolu­
tion, see pages 9-12 of the manual.) 

For best results, print to the highest­
resolution printer available. Also, stnaller 
filled areas stand a better chance of being 
sn1ooth than do larger filled areas. 

When You See 
"PostScript Error: 
Undet1ned, Offending 
Command" 
The above error n1essage means your file 
has too many grouped subgroups. Un­
group some of them to solve the problem. 
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FULLPAINT 

Creating Dashed Boxes 
Or Lines 
You can easily create dashed boxes and 
dashed horizontal or vertical lines: 

Create a checkerboard pattern of two 
diagonally opposed, 4 x 4 solid boxes. 

Select this pattern , then hold clown 
Option while drawing a square , or 
Shift-Option while drawing a line. 

Expanding Graphics 
To Fit An Entire Page 
To get a drawn graph ic to expand propor­
tionally to fit an entire page: 

Select the graphic with the Lasso tool 
and Copy it. 

Then close your document and open a 
new one. 

In the new docume nt, triple-click the 
selection marquee and select Paste 
from the Edit menu. 

The pasted graphic w ill expand to fit the 
entire page. The expanded graphic might 
require a little cleaning up before you 
print it out. 

Creating A Custom Brush 
From An On-Screen Pattern 
When you use the custom brush feature 
in FullPaint, click the pointer on any part 
of the Mac screen, and whatever is under 
the pointer will be turned into a brush and 
p laced on the brush palette. 

MACDRAFT 

Producing Laser-Printable 
Diagonal Dotted Lines 
To produce high-quality diagonal dotted 
lines, start by editing a pattern so that 
most of the pattern is black, with a one­
or two-pL"{el column or row being white. 
Tow confirm that you're drawing with a 

non-dotted line, and choose that special 
pattern you've drawn as the ink for the 
line by holding down Option while se­
lecting the pattern. 

Try drawing a few diagona l or dotted 
li nes. Later, you can choose the special 
pattern for better control. 

The Same Name 
Can Spell Trouble 
Take care when naming your fil es. If you 
save with the same name as a MacPaint 
document in the same folder, the new 
MacDraft document will not be accessible 
from the application. The o nly way to 
o pen it will be to use a file editing tool like 
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MacTools or FEdit. Open the fil e and 
change the creator to MDFT and type to 
D RWG. This will allow MacDraft to access 
the file again. 

MACDRAW 

Create Original 
Patterns Easily 
Want inte resting, original patte rns in 
MacPaint? Use MacDraft to create them. 
First, create a patterned object in MacPaint, 
then copy an area of the patte rn and paste 
it into MacDraft. With the object selected , 
experiment with choosing diffe rent pat­
terns from the Fill menu. The MacDraft 
pattern will overlap the MacPaint pattern, 
w ith almost limitless new patterns result­
ing. 

Creating An Accurate 
Display Of Proportional 
Rectangle Resizing 
To accurately see the proportional re­
sizing of rectangular objects, draw a di­
agonal line from one corner of the object 
to the othe r, and e>..'tend it, keeping it 
lined up against the two handles. 

ow, grab a corne r handle at the end of 
the diagonal line and resize the object 
while keeping the handle on that line . 
Finally, delete the line. As long as the 
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handle is on the diagonal line, the object 
is in pro portion. 

Creating Proportionally­
Spaced Text lines 
You can make lines of text with propor­
tional spacing by creating each individual 
text object and then lining all objects up 
venically. Now, select all the objects with 
the selection marquee and group them. 
By stretching the grouped text with the 
corner and uppe r/ lower resizing handles, 
the vertical spacing between the lines 
changes propottionally. 

Using Smoothing To 
Create Complex Arcs 
MacDraw's arc tool is quite limited in the 
complexity and variety of arcs it can 
generate . But you can create complex 
arcs by using MacDraw·s smoothing func­
tions. Use the polygon tool to draw a two­
vector shape, then select Smooth from the 
Edit menu. After experimenting with this 
technique for awhile, you'll be able to 
create some highly complex arcs. 

Quickly Selecting 
The Last Tool You Used 
To automatically select the last tool you 
used, hold down Command while press­
ing the mouse button. 

Centering Items Perfectly 
In The Middle Of A Page 
There's an easy way to center an ite m 
exactly in the middle of your page. Once 
the page has been created, type in the text 
you want to center, approximately whe re 
you want it placed. Then choose Reduce 
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To Fit to create a rectangle wide enough 
to cover the entire width of the page. 
Choose None from the Fill menu, so you 
can see the objects behind the rectangle. 
Then, select the rectangle and Shift-Click 
the text item you want to center. Now, 
choose Align Objects fron1 the Arrange 
menu and click on L-R Center, then click 
OK. Your text is now centered on the 
midpoint of the box. 

Use this technique to center object.;; hori­
zontally by clicking Top-Bottotn instead 
of L-R. 

Grabbing Tiny 
Resizing Handles 
If you're working with very small objects, 
it can be hard to grab their resizing 
handles, and you might end up n1oving 
the object when you didn't mean to. 

To avoid this, create a second, larger 
object, and then Shift-Click on both, group 
them and use the resizing handles on the 
larger element to shrink or stretch them 
both. When you've finished resizing, 
ungroup the two objects and delete the 
larger elen1ent. 

Proportional 
Enlarging And Reducing 
To reduce or enlarge an object propor­
tionally, draw a one-inch by one-inch 
square (with Sho-w Size active). Shift­
Select this square with the object to be 
reduced or enlarged. Place the arrow cur­
sor on the corner of the square and drag 
it to the size desired, pressing Shift while 
you do so to guarantee proportional en­
largen1ent or reduction. 

Maintaining Fill Patterns 
When Exporting 
To Bitmap Programs 
When you're transferring an object graphic 
to a bitmapped prograrn such as MacPaint 
or FullPaint, you can maintain the original 
fill patterns ratio. Select the area that the 
object graphic will be pasted into by using 
the selection marquee, and then paste the 
graphic into the docutnent. It will scale it­
self to the size specified by the marquee 
without distorting. If you resize the graphic 
after it's been deselected, though, you'll 
get a distorted stretch. 

Selecting Multiple 
Objects At Once 
Hold down Shift while selecting more 
than one object to have all chosen objects 
selected at once. 

Duplicating Objects Easily 
You can duplicate any single object or 
group of objects by selecting them and 
then choosing Duplicate from the Edit 
menu. If you move the first copy dupli­
cated, and then duplicate that copy, your 
new duplicate will be placed in the same 
position the first copy originally occu­
pied, in relation to the original. 

To make a row of objects, put the first 
copy right next to the original image, then 
duplicate copies until the row is com­
pleted. 

Toggling To The Grid Option 
When the Grid option is turned off, you 
can temporarily use it by holding down 
Shift while you n1ove an object. Press 
Shift after you've pressed the mouse button 
to pick up the object you want to move. 
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Redrawing The Most 
Recently-Created Object 
If you want to redraw the same type of 
object that you most recently created, you 
don't have to reselect the action from the 
icon panel. just hold down the Command 
key and click at the place you want the 
new object to be drawn. The previous 
action is automatically selected with the 
Command key, so your image appears 
instantly. 

Automatically 
Selecting Objects 
All the objects drawn while the Command 
key is pressed are automatically selected 
when you release the Command key and 
the tnouse button. 

Creating New Font Sizes 
You can create a different sized font by 
typing your text into MacDraw and then 
copying it into Microsoft Word, where it 
can be stretched or shrunk to any size you 
want. The new font will print out per­
fectly well on laser printers. 

Selecting All Text 
Within A Block 
You can select all the text within a block 
by triple-clicking on the text tool in the 
text block. 

Always Use The 
Same System To 
Create, Display, and Print 
A MacDraw docun1ent created with one 
System and called up with another might 
not show up at all, or n1ight show up 
distorted. For example, if you create a 
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MacDraw figure using a 14 point font and 
then open the docun1ent using a System 
that doesn't contain that font in 14 point 
size, the character spacing will be com­
puted incorrectly. The obvious solution is 
to make sure that any MacDraw System 
you use contains the same point sizes and 
fonts installed on any System you'll use to 
open or print the document. 

Avoiding Text Default 
To The Geneva Font 
If you want to use a specific text in 
MacDraw, change the font before you 
select the writing tool. If you don't change 
it, the font will automatically default to 
Geneva, and you'll have to choose a new 
font every time you switch into text tnode. 

Computerizing 
Your Autograph 
You can keep your own signature on file 
in MacDraw, ready to affix to any docu­
tnent. First, write your name as large as 
you can, using the free-hand tool. Read 
that as Large. Use the Smooth, Unsmooth, 
and Reshape comn1ands until you're sat­
isfied with the results, and then Group all 
the letters and grab the lower right handle 
to reduce the signature to the desired size. 
Finally, paste it in the Scrapbook. You 
n1ight never need a pen again! 

Previewing 
Horizontal Layouts 
Preview how your horizontal layouts will 
look when printed by selecting Wide 
from the Page Setup option in the Print 
menu. This will show you the horizontal 
orientation of your page. 
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If You Can't Complete The 
Print Command ... 
Sometimes when you print a multi-page 
document, you might get a message that 
says the print command cannot be com­
pleted. The easiest way to work around 
this is to print only a few pages at a time . 

Laser Printing Small, 
White Type 
If you have trouble printing small white 
type with your laser printer, uy typing the 
text in Outline style, then fill in the back­
ground and then stretch the object to 
double its size, both vertica lly and hori­
zontally. Now, specify 50% reduction in 
the Page Setup dialog box. Your white 
type will probably print out much better. 

Enlarging Or Reducing 
Can Clip Text 
When you laser print a document con­
taining text, you might experience clipped 
text printouts if you use more than a 150% 
enlargement or more than a 75% reduc­
tio n. 

See The Graphics, 
Not The Rectangle 
To see a graphic image instead of a 
rectangle while moving images around 
your page, press Option. 

An Easy Way To Create 
Perfect Hollow Lines 

with the third line thickness on the menu. 
When you're finished, Group all lines, 
duplicate the group, and set the line 
thickness of the duplicate lines to the 
second line thickness on the menu. Then, 
under the Pen menu , set the pattern of the 
duplicate lines to w hite. Now, select both 
groups and align both centers. The white 
group will "carve" out the centers of the 
thicker lines. 

MACDRAW II 

Creating A Pixel Ruler 
One of the oversights in Claris' MacDraw 
II is the lack of a standard rule r for 
measuring in pixels. You can create your 
own just by setting the scale ratio to 1:72 
inches, setting Divisions/ inch to 1, and 
unchecking the Show Unit Name check 
box. 

Trimming File Space 
The gro uping informat io n stored in 
MacDraw II files for complex grouped 
graphics can cause the files to increase in 
size - sometimes dramatically. If you 
need to trim some fat off a file, ungroup 
the grouped objects and then save the 
file . If you need to produce hollow lines, use 

the following procedure to raise the quality 
of your work: This works for all the major object-ori­

ented graphics programs. including Cricket 
First, draw your graphic, making all lines Draw, Illustrator 88, and FreeHand. 
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MACP.AINT 

Leave Enough 
Disk Room To Work 
MacPaint requires a lo t of free space- at 
least lOOK or so - on the disk in order to 
work properly. If you're not using a hard 
disk, and are creating several docume nts, 
save them to a different disk for the rime 
being. You can copy them back to your 
MacPa int disk for editing later, if you 
want. 

Customizing Your Eraser 
The standard eraser in MacPaint is a 16 x 
16 pixel square. You can make it as thick, 
thin, or round as you like by selecting the 
Paintbrush tool and choosing white as 
your brush color. 

Avoiding Pattern Distortion 
In Multiple Copies 
Sometimes when you make multiple 
copies of your document, the patterns 
stan to look clisronecl. This can be reme­
died by choosing the Grid option before 
making copies, since it creates an auto­
matic grid that's 8 pixels apart, •·gluing" 
your pattern down before it's copied. 
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Hints For Saving Disk Space 
Another way to free up space is to remove 
the Image Writer driver from your MacPaint 
system file. MacPaint doesn't use the 
driver to print documents. 

You can also save several small MacPaint 
illustrations in a single file, instead of in 
individual files. MacPaint files take a min­
imum of 2K on-disk, per file. 

Getting Where You 
Want In FatBits, Fast 
You can take the express route into Fat­
Bits, and work on the exact area you wa nt 
to, by selecting the marquee tool and 
using it to frame the pan of your picture 
you want to work on in-depth. Then, just 
double-click on the Pencil tool, and you'll 
immediately go to a close-up of the area 
highlighted by the marquee. 

Another way to access FatBits quickly is 
to choose the Pencil tool, hold clown the 
Command key, and then point to the spot 
you want to work o n and click the mouse 
button. Just click once; double-clicking 
will bring you right back into the "regular" 
bits mode. When you release the Com­
mand key, the Pencil tool will behave 
normally. 

Moving The Page While 
In FatBits 
When the Pencil tool is selected in FatBits, 
you can change the Pencil into a Hand 
tool by pressing the Shift button. This 
a llows you to move the page without 
going back to the regular mode. When 
Shift is released, the Hand changes back 
into a Pencil. 
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TheEasyWay 
To Make Straight Lines 
To tnake sure that the straight lines you 
draw are completely straight, with no 
jagged lines, hold down the Shift key 
while positioning and using the straight 
line tool. This constrains the line's move­
ment to vertical/horizontal only. 

Restraining Works 
Throughout The Program 
The same restraint can be applied to the 
paint brush, pencil, spray can, or eraser 
tool. Just hold down Shift while using the 
tool. 

You can even restrain the active window 
or the graphics elements in the Show 
Page mode by holding down Shift while 
repositioning your page. You'll be able to 
drag up, down, or to a 45-degree angle 

Multiple Copies Of An Image 
Make multiple copies of a graphic by 
highlighting the itnage with the Lasso or 
Marquee tool and pressing Command­
Option as you click and drag the picture 
around the page. 

Creating Multiple Copies 
In A Straight Line 
Multiple copies of an image can be cre­
ated and placed in a straight line by 
pressing Shift-Comn1and-Option while 
dragging the itnage being copied. 

Controlling Spacing 
With Multiple Copies 
You can control the spacing between 
n1ultiple copies by choosing a line width 

that corresponds to the amount of space 
you want between each copy. Choose a 
narrow line width for closely-spaced 
copies, and a wider one for more distance 
between each illustration. 

Stretching Images 
To select an image, use the marquee tool 
to select the entire picture, then press 
Cotnmand while dragging the edges of 
the highlighted in1age. Drag from the 
edges, and one dimension of the image 
will be stretched. Drag from the corners 
and both horizontal and vertical dimen­
sions of the image will be altered. 

Keeping Patterns 
Intact While Stretching 
You can keep patterns from distorting 
during stretching by holding the Shift key 
down while dragging the edges. 

Stretching And Shrinking 
Rectangles Proportionately 
When working with a rectangular graphic, 
you can control proportional stretching 
or shrinking by pressing Shift -Command 
while stretching fron1 the edges. If you 
drag frotn the comer while holding down 
these keys, the proportions of the picture 
will remain intact. Drag from the sides, 
and the horizontal resizing is limited in 
proportion to the vertical position of the 
cursor. 

Keeping Rectangle Patterns 
Intact When Resizing 
Keep the pattern of your rectangle intact 
by holding down Shift while stretching. 
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Changing Fonts 
Without Creating 
A New Entry Point 
Changing fonts mid-text can be a prob­
lem, especially if you don't want to create 
a new text entry insertion point. But it can 
be done without changing the font al­
ready entered by pressing Enter and 
choosing the new font or style. Once this 
has been done, though, you can't back­
space past the point where the Enter key 
was pressed. 

Changing The Font Size 
Of Entered Text 
You can change the font size of text that's 
already been entered by pressing Com­
mand and both arrow keys(< and>). 

Changing The Font 
Of Entered Text 
Change the font of text already typed in 
by pressing Command-Shift and the ar­
row keys. 
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Command-period changes the text to 
the next larger size. 

Command-comma brings the text to 
the next smaller font size. 

Command-Shift-period changes the en­
tire entered text block to the next font 
shown on the font menu. 

Command-Shift -comma changes en­
tered text to the previous font shown 
on the Font menu. 

Creating Ultrabold Letters 
You can create extra-bold letters by enter­
ing your text in Bold and Outline from the 
Style menu. Then, use FatBits, or the paint 
bucket's Fill option, to fill in space inside 
each of the letters. The Fill selection gives 
letters a shaded look. 

Creating Special Effects 
With Fonts 
You can create interesting special effects 
with any font and MacPaint. Just type 
your letters on the screen the way you 
want them to appear. Then select all the 
text with the Marquee tool. Now, either 
trace the edges with a shadow (Com­
mand-Shift-E) or trace the edges normally 
CCon1mand-E). Then, do a Comtnand­
Shift-E. Do it several times to create pro­
gressively wilder effects. You can fool 
around with other options, like inverting 
the itnage, to get the best results. 

Grid Option Assists 
Text Entry 
Use the Grid option while working on 
documents requiring a lot of text entry, 
since it makes it easier to align new text 
inserts. 

The Fast Way To Edit Brush 
Shapes 
Take the express route to the Bn1sh 
Shapes window by double-clicking on 
the Paint Bn1sh tool. 

Edit Brush Shapes With A 
Font Or Resource Editor 
Bn1sh shapes can be edited with a font 
editor. Use one that has the ability to 
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access fonts stored as resources with 
applications. The font stored in MacPaint 
is "12." It contains characters with ASCII 
values 120-151 that make up MacPaint's 
brush shapes. Just use the font editor's 
edit mode to alter these characters to the 
new brush shapes and save the changes 
you've made. 

Erasing Large Portions Of 
The Screen 
To erase large parts of your graphic 
quickly, select one of the shape boxes 
(choose the colored one, not the transpar­
ent version). Then pick white as your fill 
color and select the dotted-line (invisible) 
outline. Finally, draw the shape directly 
over the part of the screen you want to 
erase. You'll still probably have to clean 
up the edges with the eraser. 

Another way to eliminate large illustra­
tions is to choose Show Page from the 
Goodies menu. Move the page until your 
graphic has disappeared from the screen, 
then hit OK. When you reposition the 
page again, the section you moved off the 
screen will be gone for good. 

The Lasso is useful for eliminating oddly­
shaped illustrations. Outline the shape, 
then press backspace to erase it. 

For large, uniformly-shaped areas, use 
the Marquee to highlight, then use back­
space to erase. 

Shadowing Images 
Shadows can be added to MacPaint im­
ages. Just select the drawing with the 
Marquee. Now, hold down Shift and se-

lect Trace Edges from the Edit menu. 

Lasso Tool Doesn't Have To 
Close Its Loop 
The Lasso tool doesn't require you to 
completely encircle the object you're 
lassoing. When you release the button, 
the Lasso automatically completes the 
loop in a straight line back to the point 
where it started. 

Merging Patterns In Shapes 
It's possible to place one patterned shape 
over another without obscuring the origi­
nal shape. Press Comn1and while select­
ing the paint brush, spray can, paint 
bucket or shape drawing tools. When 
you select this mode, both shapes' pat­
terns will merge at the points where they 
overlap each other. 

Adding New Patterns To 
Your Palette 
If you create or find a pattern that you'd 
like to add to the patterns palette, choose 
a pattern you think you can live without. 
Then choose Edit Pattern from the Good­
ies menu and click the n1ouse on the part 
of the screen that you want to copy the 
pattern from. The new pattern replaces 
the old one. 

Using The Flip Horizontal 
Option To Create Gantt 
Charts 
You can produce large drawings or Gantt 
charts easily by printing out large draw­
ings in 8.5 x 11-inch sections on a Laser­
Writer, using the Flip Horizontal option to 
create a mirror image. Then, trim the 
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pages and assemble with transparent tap 
on the back of the drawing. The resulting 
300-dpi flipped-image montage can he 
used as a master in a blueprint machine. 

MACPAINT 2.0 

Using ResEdit 
To Change Default To 
Pixel Measurement 
You can change MacPaint's default meas­
urement from inches to pLxels, which is 
particularly useful to programmers and to 
desktop publishers. Make a copy of 
MacPaint, and use ResEclit for a little 
surgery on the copy. 

First, use ResEdit to open your copy of 
MacPaint. Open the PREF resource. Open 
PREF 10=128. On the line: 

00000008 0008 017B 0009 
OODl 

... change 

"017B" to 007B". 

In this position, 00 is for pixels, 01 is for 
inches, and 02 is for centimeters. 

When you've made the change, Quit 
ResEdit and type Y to save the changes. 
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MAC 3D 

Rotate Selection To Verify It 
Sometimes it's difficult to select pa1t of a 
complex model and know exactly which 
pan has been selected. To verify, choose 
Rotate, and the currently-selected object 
will appear in the Show Selection win­
dow. Once you've confirmed exactly 
what you selected, click Cancel and you 'll 
be back where you staned - but with a 
better idea of what you're working with. 

MAC 3D 2.0 

Creating Endmarks 
On Arcs And Curves 
Create endmarks on arcs and cutves by 
attaching a small line to the end, then 
placing the endmark on that line. 

Importing QuickDraw 
Graphics 
Although the program has a Save As PICT 
function , a graphic saved as such comes 
through as a bitmapped image when 
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opened in graphics or desktop publishing 
programs. To get a QuickDraw object 
from the program, copy the graphic ro the 
Clipboard before copying it into the graph­
ics program. 

Adding Tiny Details 
Add small deta ils to a drawing easily by 
increasing the scale of the document. 
This enlarges the objects and makes it 
easy to draw in small details. 

Dimensioning Edges On 
Rotated Objects 
Dimension an edge on a rotated object by 
ungluing it down ro irs edges, duplicating 
the edge to be dimensioned , and then 
moving the duplicate away from the object 
and selecting Din1ension. 

Quickly Redrawing All 
Objects In A Window 
Click in the empty area on the tool palette, 
right underneath the tool icons, to redraw 
all of the objects in the window. 

Splitting Vertexes 
You can split a vertex into two vertices to 
get a new edge. Just enter the Bevel win­
dow, select the vertex, and bevel by 1%. 

PIXEL PAINT 

"Animating" Drawings With 
Color Cycles 
Here's a way to make Pixe!Paint cycle 
through colors on the color palette to 
"animate" drawings. It's a great way to 
bring a picture of a wate rfall to life, or to 
make a daytime sky seem to pulse w ith 
clouds. 

First, select the colors you want to cycle 
between by clicking the mouse o n the 
color box and then dragging the cursor to 
the color you want. Then choose the 
second color. 

After selecting colo rs, pick the selection 
tool, turn Caps Lock on, press the Shift 
key, and click the mouse button. To stop 
the cycling, click aga in. 

This is quire spectacular if you copy a 
color Mandelbrot picture to the Clip­
board, go into Pixe!Paint, and paste in the 
picture while in the Special Effects mode. 
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MICROSOFT CHART 

Exporting Charts 
To MacPaint 
When copying charts to MacPaint, choose 
the option to copy "As it Appears on the 
Screen." Otherwise, the chart won't fit 
into your drawing w indow after it's been 
pasted in. 

Cells Import As 
Individual Elements 
When a graph crea ted in Microsoft Chart 
is cut and pasted into MacDraw, each 
piece of the chart becomes an individual 
element. You can add a lot of spice by 
dressing up the chart lines to reflect what 
the chart says. For example, a dollar­
figure chart could show stacks of dollar 
bills instead of dull bar lines. 

Wrapping Text Pasted 
From The Clipboard 
You can paste text from the Clipboard 
and have it wrap within an area. First, 
create the rectangle that you want to w rap 
the text within , and type any character 
(the space bar will do). Any text you now 
paste in will wrap ro the size specified by 
the rectangle. 
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Centering Primitives 
Center any of the primitive objects (circle, 
rectangle , etc.) on a page by drawing the 
object, Cutting or Copying it, and then 
clicking the pointer whe re the object's 
cente r of gravity should be. 

Widen The Window 
When You Start Working 
Always widen the window, chart area, 
and plot area to their maximum settings 
before you start working. To access the 
underlying series of windows, use Com­
mand-L (list). 

Extra-Long Text In 
Headers And Footers 
It's possible to create text in a header or 
footer en tty box that's longer than the box 
itse lf. To edit the longer text, get at it by 
placing the cursor in the visible text near 
the right end of the entty box and then 
dragging off the end to scro ll the text left 
and display the extra text. 

Embedding Formatting 
Commands In Headers 
And Footers 
You can embed formatting commands 
and other instructions in the text of a 
header or foote r. These commands can 
be inserted in the Page Setup dialog box 
by typing the ampersand (&) and a lette r 
simultaneously: 

&L: Align the characters that fo llow at 
the left margin· 
&R: Align the characters that fo llow at 
the right margin; 
&P: Print the page number; 



GRAPHICS 

&D: Print the curre nt clare; 
&T: Print the curre nt time; 
&&: Print a single ampersand. 

Use White On Labels 
That Overlap Tabs 
Whe n using labels that overlap other 
parts of a chart. select a white background 
to avoid having pixels from the over­
lapped lines show through. 

Add Legends 
Before Formatting 
If you'll need a legend on your Chart 
document, add it before you start format­
ting. since Chart rearranges everything to 
make room for the legend. This rearrang­
ing can make a mess of the formatting 
you've created. 

IfYou Link 
Chart Files To Multiplan 
When linking Chart files to Multiplan, 
choose the type of data first, o r e lse each 
series will be out of ste p and categories 
and values w ill be transposed. Also. 
changing the typeface of a linked series 
can sometimes unlink the two programs 
without wa rning! 

Margin Settings Determine 
Printed Size Of Charts 
Chart uses the margin settings established 
in the Page Setup dialog box to dete rmine 
the printed s ize of a chart. If you wa nt to 

change the size of your prinrout, just 
change the margin seuings. 

Let Chart Do Your 
Math For You 
When you·re creating a pie chart, let Chart 
work out the math for you. just e nter in 
the actual figures and le t it calculate 
percentages. Otherwise, you won't be 
able to use percentage labels on your 
sectors. and you 'll fi nd that o ther statisti­
cal functions \Viii he disabled, as we ll. 

Modify Chart Files 
To Create Sequences 
Of Pie Charts 
You can modify Chart files with a graph­
ics program to create a sequence of pie 
charts on a page. Usc the Plor Area grab 
handles from Chart to resize each chart 
before positioning and deselecting the m. 

Intersecting Gray Areas 
May Print Fuzzy 
Intersections of gray areas that are eas ily 
distinguishable on your screen might print 
a little blurred , especiall y on the Image­
Writer. Use cla rk o utlines to emphasi ze 
each figure , o r e lse alternate light and 
clark colo rs for best results. 

Templates Save Time 
Whenever you create a new kind of g raph 
or chart. keep a copy in a libraty folder, 
s ince modifying an existing chart is a lot 
easie r and faster than creating a new one 
from scratch. In creating a te mplate. aYoid 
using non-automatic text areas, since these 
will remain even after you've entered 
new data . When you use the template, 
always remember to Save As ... and then 
name it, to keep your o rig inal template 
clean. 
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Save As You Go 
To Prevent Confusion 
When possible, save a numbe r of Chart 
versions a long the way, since the formar­
tino commands can be complex. This 
helps you save rime in the event of mis­
takes, since you can simply backtrack to 
an earlier ve rsion. 

Tips For More 
Effective Charting 
Dark patterns are much easier to under­
stand, so as a general rule, use the darker 
patte rns to display the most impon ant 
figures . 

Horizontal column charts are best suited 
to comparisons of series with few num­
bers and wider. less ordered variatio ns. 

Line charts are best used fo r displaying 
trends in time, w here the re lationship 
between two date figures is more impor­
tant than the re lationship between the 
target and actual figures. 

Pie charts can only be used when your 
data adds up to 100%. Plus, each secto r 
must exclude all members of the others. 
In designing charts, as in any o ther graphic, 
remember that when in doubt, simpler is 
be tte r. A chart clutte red with too many 
labels and patterns is too distracting to be 
effective . 

SMART ART 1.01 

Using Smart Art 
To Preview EPSF Files 
It can be a real pain to browse EPSF files. 
You can use Smart Art to browse because 
of the program's ability to preview un­
opened docume nts. 

Just open the fo lder of EPSF files from 
Smarr Art's Ope n dialog box and select 
the file you want to view. The preview 
window lets you zip through numerous 
files that are still displayed in a reduced, 
bur recognizable . size. 

Re membe r, though, you 're only preview­
ing files. Don't tty to o pen these files in 
Smart Art. 

Smart Art Can View Old 
LaserFX Files Through A 
Desktop Publishing Program 
Smart Art can create screen images for the 
EPSF fil es produced by some of the ea rlie r 
text special-effects programs such as 
LaserFX. These first-generation programs 
have some wonde rful effects, but when 
you place them in ro a page-layout desk­
top publishing program, a ll you see on­
screen is a g ray box. Sman An can fix that, 
provided that the creato r program can 
save files in EPSF and that you're working 
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with a 300-dpi PostScript printer. 

First, save the effect as an EPSF document 
and open the docume nt with Smart Art. 
The n, click on Smart Art's Re image but­
ton. After a few moments, Smart Art 
creates a screen image of the text special 
effect. 

Save the file from within Smart An . When 
you place the new fil e in a DTP program, 
you'll see what the graphic will look like 
when it prints out. 

SUPER PAINT 

Making Shadowed Text 
You can create interesting shadowed ef­
fects on your text by selecting the font and 
style while in the draw mode, and then 
typing your text. (Hint: bold text looks 
best with this effect.) Switch to the Paint 
layer and choose a brush pattern , such as 
a simple dithered gray. Then, choose Text 
Patte rn from the Style menu , and on 
another part of the page, type the text 
exactly the same as the text in the Draw 
layer. Now, switch back to the Draw layer 
and move the original text to create a 
shadowed effect. When you get the effect 

you like, copy the shadowed text on to 
the Draw layer. 

Enlarging Any Selection 
You ca n e nla rge any se lectio n in 
SuperPaint to page size, or to any size you 
want. First, use the l asso or Marquee tool 
to select the picture you want enlarged . 
Then. use Command-C to copy d1e gmphic 
and press Command-A to select d1e screen. 
Next, press Command-V to paste and , 
after a few seconds, the selection will fill 
the entire screen. 

If you want a smaller enlargement, in­
stead of pressing Command-A to select 
the entire screen, use the Marquee to 
select the size, then press Commancl-Y to 
copy the graphic. 

You'll find this helpful when you enlarge 
graphics, since you can choose the size 
right away, instead of having to enlarge it 
step by step. 

Moving Tiny Items Easily 
If you seem to be go ing blind ttying to 
move tiny objects around. ny drawing a 
line near the object to be moved, then 
grouping the two objects together and 
using the line as a "handle" to move the 
tiny item to its new destination. 

This also he lps keep the Pointer tool from 
blocking your view. This also works in 
other graphics programs that allow object 
grouping. 
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Using The Lasso While The 
Marquee Is Selected 
While in the Pain£ layer, you can have the 
Marquee tool selected and still be able to 
use the Lasso tool. just hold clown the 
Option key to turn the cursor into a lasso, 
making it easy to select odd-shaped 
bitmaps on the screen. 

"Nudging" Selected 
Graphics By A Single Pixel 
While any item is selected w ith either the 
Lasso or the Marquee. you can ·'nudge" it 
in any direction by using the arrow keys. 
l f your keyboard has no directional arrow 
keys, use Command-Y to nudge upwards; 
Command-] to nudge left; Command-K to 
nudge right; and Command-D to shift 
downwards. 

Closing All Open 
Windows At Once 
Hold down Option wh ile selecting Close 
from the File menu and all w indows that 
are currently open will close. 

Crosshairs Can Help 
You Paint From A 
Centered Point 
Instead of choosing D raw (Paint) From 
Center before draw ing one of the Quick­
Draw primitives to paint the shape from 
a centered point. you can double-click on 
the palette tool you select instead of just 
clicking. The icons in the palette w ill then 
show crosshairs to identify the difference. 

Reversing The Pattern 
When editing paint patterns or painr brush 
shapes, hold down Command w hile cl ick-
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ing the mouse anywhere in the pixel 
editing box to reverse the pattern , making 
black white, and white black. 

Creating A 
Spattered Effect 
You can create an interesting "spattering" 
effeC[ by choosing the paint brush pattern 
that you 'd like to spatter and then paint­
ing with the spray can w hile holding 
clown Option. The faster you move the 
mouse, the further apart the spatters will 
paint. 

Creating a 
"Screening" Effect 
A great ·'screening" effect can be created 
by using Paint On Black and the selection 
rectangle, especially in conjunction with 
the Laser Grey patterns. I f you don't like 
the effect, try moving the Marquee one 
pixel up or down to change most of the 
screen effects. 

Smoothing Bitmapped 
Images For Laser Printing 
If you have an extensive libraty o f b it­
mapped clip-art. there's a way to smooth 
images for printing on the LaserWriter. 
Open your image in SuperPaint and Save 
it. Then Open the new document, hit the 
Place Laserbits command, and tell it to use 
the file you just created. The resu lt will be 
a 1/ 16 original size document at 300 clpi, 
and it prints perfectly. Realize that the 
larger your original image, the longer it 
takes to prinr. 
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Turn Smoothlng Off To 
Speed Up Printing 
When printing a Laserbits docurnent, turn 
the smoothing effect off to speed up 
printing. 

Lower Detail Level Speeds 
Smoothlng 
When using FatBits, don't immediately 
jump to the finest detail level. Instead, use 
the left side of the screen, which displays 
the actual appearance of the work, as 
your guide. If you can see all of the object 
you'll be working on, stay on that magni­
fication level unless you really need a 
finer one. You'll save time smoothing 
work if you work in the lowest possible 
magnification. 

Adjusting Length 
On Imported 
MacDraw Graphics 

SuperPaint's print area is approximately 7 
11/16 inches by 9 5/8 inches, which is 
slightly wider, and shorter, than MacDraw. 
A quick fix is to set the Page Setup to 
enlarge at 104o/o. This results in 10-inch 
lengths when you need them. Just re­
member to watch the width of your job, 
since it expands sideways as well, and 
also set the print dialog box to print only 
the first page. This circumvents 
SuperPaint's need to send a blank page 
through whey1 enlargements are requested. 

Creating An Accurate 
Display Of Proportional 
Rectangle Resizing 
To accurately see the proportional re­
sizing of rectangular objects, draw a eli-

agonal line from one corner of the object 
to the other, and extend it, keeping it 
lined up against the two handles. 

Now, grab a corner handle at the end of 
the diagonal line and resize the object 
while keeping the handle on that line. 
Finally, delete the line. As long as the 
handle is on the diagonal line, the object 
is in proportion. 

Opening MacPaint Files 
Without Loading SuperPaint 
You can open any graphics file MacPaint 
can open just by double-clicking on it, the 
same way you would if you were using 
MacPaint. 

Using a resource editor like ResEdit or 
FEdit, you can alter your Super Paint 
program so that it opens files like MacPaint. 
Within the resource editor, select the 
paint program you like to use (in this case, 
SuperPaint). Check the field Creator and 
change what it says to MPNT. You'll also 
have to do this to the SuperPaint Prefs file. 
Then quit the resource editor and return 
to the Finder. You'll notice that your 
SuperPaint icon now looks like the 
MacPaint icon. If the real MacPaint is on 
your disk, get rid of it, or this tip won't 
work. 

As with any resource editing work, make 
changes only on a backup of Super Paint. 
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AUDIO OUTP.UT 

Connecting A Stereo 
To The Mac 
The proper cable to connect the Mac's 
audio output to a stereo system is ofte n 
hard to find. Fortunately all it takes is a 
trip to your local Radio Shack. Look for 
Part umber 42-2153. It's a Y adapter with 
a mini mono pho ne plug at one end and 
a pair of RCA phono plugs at the other 
end. You may need mo re than 42-2153's 
9-inch length. To extend this cable, use 
Radio Shack's 42-2472. You can use sev­
eral of these if necessa1y. 

DISKS 

Ejecting Disks 
There keyboard shortcuts to eject d isks 
from disk drives using the Command­
Shift keys. 
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Command-Shift-1 ejects a d isk from the 
first drive; 
Command-Shift-2 ejects a d isk from the 
second drive; 

Command-Shift-0 ejects a disk from a 
third d rive. 

To just eject a selected drive, press 
Command-E. 

Noisy Disks Signal Trouble 
If your d isk makes more no ise than usual 
upon being inserted into the disk drive, it 
might not have been a ligned properly by 
the Mac. Eject it and try to boot it again. 
If a certain d isk consiste ntly makes un­
usual noise, back it up as soon as possible 
and don 't save new data to it - the data 
may be corrupted. 

Magnets Are Lethal To Disks 
ever expose your disks to any magnetic 

fo rce, since it can wipe your clara clean off 
the d isk. If possible, sto re disks away 
from metals such as file cabinet'>. 

Also, avoid placing hard disks and floppy 
drives to the left of a Macintosh, since the 
power source (being on the left) has 
magnetic qualities. 

HARD DISKS 

Interleave .Factor And Hard 
Disk Performance 
The performance of your hard d isk re­
lates to its interleave factor. If you change 
machines or add an accelerator ca rd , you 
may need to change the interleave. As a 
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rule, drives attached to a Mac Plus work 
best with a 3:1 inte rleave; those attached 
to an SE require 2:1 ; and Mac Ils, Ilx's, SE/ 
30s, and a ll accelerated Pluses and SEs 
work best if the disk has a 1:1 interleave. 
To see what that inte rleave is and to 
change it, use the latest version of Apple 's 
HD SC Setup (which is part of the System 
Tools 5.0 o r 6.0 package). Hold down 
Command-I after you arrive at the appli­
cation's window to access the interleave 
areas of the program. Remember to back 
up your entire disk before changing the 
interleave. Changing the interleave re­
quires reformatting the disk - an opera­
tion that destroys all the data on the disk. 

HIGH DENSITY DRIVES 

Mixing High-Density And 
Double-Density Disks 
The high-density disks for Apple·s new 
High Density (FDHD) d rive can cause 
problems when you·re dealing w ith ear­
lier Macintosh floppy d rives. Let's say you 
want to copy a file from an SE, Plus, o r 
Mac II and bring it home to your SE/ 30 or 
Jlcx, but all you have is a high-density 
disk. The standa rd Apple drive can format 
and write onto a high-density d isk as if it 
were a regular double-sided, double­
density 800K floppy, hut when you insert 
that disk into an FDHD dri ve, it warns 
you, "This disk is nm formaued for use in 

this drive.·· The FDHD doesn't like a high­
density disk formatted as an 800K disk 
because the extra square hole on the Lop 
left corner of the high-density disk tells 
the FDHD drive to read it as a high­
density disk. To get arou nd this, simply 
cover up the square ho le with a piece of 
opaque tape. Then the FDHD thinks it has 
a standard 800K floppy and will read it. 

What You See Isn't Always 
What You Print 
When you print, lhe ImageWriter (I & II) 
uses a font twice the selected size (if it's 
available in the System) and then sca les it 
down to produce high quality output. 
Fonts usually don't change from one size 
to the next. But Geneva is the exception 
that proves the mle: its lower case "y" in 
12 point has a distinctly differe nt de­
scender than the 9-point "y" and both 
have different fo rms than the 24-point 
character. That means, when you print 
high quality in Geneva, you'll often get 
some characters that print quite d iffer­
ently than they display on-screen. 

How To Access 
The Self-Test Mode 
The IrnageWriter II can run self-test 
samples of a ll three printing modes. To do 
this, turn the printer off and ho ld clown 
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the Form Feed button while turning it 
back on. This starts the draft mode self­
test. While it's printing, deselect the printer 
by pushing the Line Feed button and then 
push the Print Quality button to select a 
new mode. Then reselect the printer by 
pushing Line Feed. When the print head 
begins a new line, it will print in standard 
quality. Repeat step two to enter high 
quality mode. 

IMAGE WRITER II 

Producing Near-Letter 
Quality Printouts From The 
ImageWriter Without 
Editing Codes 
There's an easy way to coax near-letter­
quality printing from the ImageWriter II. 
Rather than using ResEdit or MacTools 
(we're not all hackers!) and the Print 
Merge function of Word 3.0, simply select 
draft mode when the print dialog box 
comes up on the screen. Then, using the 
selection switches on the printer, select 
the typeface that you'cl like to use in near­
le tte r-qua lity mo d e (che ck your 
Image Writer II manual for details on how 
to select the various choices). 

How To Obtain Best Print 
Quality Fast 
Here's a way to obtain the fastest and best 
print quality from your ImageWriter II. 
You can access the Image Writer II's built­
in propottional fonts from within Mac Write 
or Microsoft Word . Certain fonts when 
printed with the "draft" quality access the 
printer's internal proportional fonts. These 
internal proportional fonts are: Boston II 
10 and 12 point, Toronto 12 po int, Chi­
cago 12 point, Venice 14 point, London 18 
point, Athens 18 point, and San Francisco 
18 point. Other fonts, such as Geneva, use 
a monospaced font in draft mode that 
produces awkward spacing. 

Using The ImageWriter And 
The HP Paintjet Film To 
Produce A Transparency 
If you've ever needed an overhead trans­
parency in a huny (and in color, no less), 
here's an inexpensive solution. 

By using HP Paint]et transparency film 
and an ImageWriter ll printer, you can 
easily make a color (or black-and-white) 
overhead. 



HARDWARE 

IMAGE WRITER LQ 

Extending The Life Of 
ImageWriter LQ Ribbons 
Here is o ne \vay of extending the life of an 
LQ ribbon. 

On the left side of the LQ (where the 
controls a re), there is a small switch. 
When this switch is depressed , the printer 
knows that a one-color (black) ribbon is 
loaded. The black ribbons have a tab 
protruding that should depress this switch. 
Color ribbons do not have this tab. Make 
sure that the tab is depressing the switch. 
Then most of the ribbon surface will be 
used for printing. 

Seating The ImageWriter LQ 
Ribbon Properly 
If the to p edge of your ribbon is receiving 
the brunt of the printing load , you may 
not have the ribbon seated pro perly. 

A well-worn LQ ribbon has four parallel 
wear lines spaced evenly up and down on 
its surface reflecting the up and down 
movement of the print head. An improp­
erly seated ribbon defeats this motion, 
and the result is the characte ristic top­
edge fraying. ln other words, you·re 
using only one-fourth of your ribbon. 

If you set up the printer as the manual 
instructs, the re·s evety chance that you 
won·t seat the ribbon properly, because 
doing so requires a degree of force and 
thumb pressure that most people will nor 
instinctively apply to a ne \-v S1 ,300 printer. 

To seat your ribbon properly, you must 
apply vety strong thumb o r finger pres­
sure to the extreme end o r each of the 
little arms that extend out from each end 
of the cartridge. You wi ll feel a very 
sa tisfying cl ick when it is properly in­
sta lled. 

. . 
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KEYBOARD 

There Are Three Apple 
Keyboard Options 
Mac SE and ll buyers actually have three 
keyboard choices from Apple. They are 
the Standard , Extended and IIGS key­
boards. The fiGS keyboard has the same 
key arrangeme nt as the Srandard key­
bo;ud but is about 10 to 15 percent 
smalle r. The feel of the keys is also 
slightly different, and the individual keys 
are re latively unsculpted and easier to re­
arrange (if, for example, you want to 
change it l<.> a Dvorak layout). If your 
dealer doesn 't know what you 're talking 
about, refer to Apple part number 658-
4081. 
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Using The Key Caps DA 
During Keyboard Failure 
If one or more of the keys on your 
keyboard ceases to function or in the 
middle of a letter or document and some­
thing similar happe ns to you, simply go to 
the Key Caps DA. Click the mouse on the 
inoperative key and that letter number 
or symbol will be shown in th~ text are~ 
at the top of the DA. Simply copy it from 
there and paste it where needed. 

Another optio n, which works in any 
program that has a global search and 
replace feature, is to use a symbol that 
you ordinarily don't use in place of what­
ever the keyboard won't produce through­
out the document. When you're done, 
use the Change command unde r the 
Search menu to have the program substi­
tute the correct letter (or whatever) for the 
symbol. Paste the correct letter from the 
Key Caps DA straight to the Change To 
area of the Change dialog. 

The Keyboard 
Remembers What You Type 
The Macintosh has a very effective key­
board memoty buffer. So, when you 
lau nch an application, you only have to 
wa it about four seconds before srarting to 
type, even if the application isn· t fully set 
up o n the screen yet. 

Curing Keys With WD-40 
The re comes a time in the life of every 
Mac keyboard when one of the keys fails 
to work. How-ro articles describe how to 
repair the keyboa rd by breaking out the 
trusty o l' solde ring pencil, tearing the 
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keyboa rd apart. and replacing the incli­
vidual key with one purchased from the 
local Apple deale r. Although this method 
does an admirable job. you may be un­
comfortable doing this kind of minor 
keyboard surge1y. There is an easier 
method that requires no soldering, based 
on the assumption that the key is proba­
bly suffering from a dirty contact and that 
tl~e contact can be cleaned with a judi­
ctous application of a solvent. 

Disconnect the keyboard from the Mac 
and carefully pty the key cap off the of­
fending key. Now take a can of WD-40 
(available at most hardware stores), insert 
the small straw tl1at comes with the lubri­
cant into the nozzle, and direct as shott a 
spritz of WD-40 as possible at the point 
where the white key plunger enters the 
black body of the key. 

Work the key plunger several times and 
then reconnect the keyboard to see if the 
key works. The first application ofWD-40 
ma y not do the trick, but the key should 
be resurrected by the second or third try. 
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LASERWRITER 

Avoiding The Startup Page 
Using The Paper Tray 
One way to stop your LaserWriter from 
printing a page each time it's started on a 
temporary basis is to pull the paper tray 
out an inch or so (the distance isn't 
critical) whe n you stan the LaserWriter. 
When the green light stops Oashing, incli­
cating the printer is wa rmed up and ready 
to go, push the tray back in. 

A Manual Fix 
For Envelope Jamming 
Envelopes freque ntly jam when going 
through a LaserWriter because they are 
too stiff to bend around the mechanism of 
the paper path. 

The low-tech solution is extraordinarily 
simple and takes about two seconds. 
Before printing, break the spine of the 
envelope . Run the flap edge of the enve­
lope between your thumb and forefinger. 
bend ing it at about a 45-degree angle as 
it passes through. Do this twice, bending 
once in each direction so that the em·e­
lope ends up flat . Avoid paper cuts en­
tire ly by folding the flap over backwa rds. 

For an even bette r pass through the 
printer, break the stiffness along both 

long edges. This makes the e nvelope 
more flexible and the like lihood of jam­
ming is substantially reduced . 

Paper Trays For Legal And 
Letter Size Paper 
If you regularly use two kinds of le tter size 
paper in your LaserWrite r (for example , 
lenerhead and regular paper), it's a good 
idea to get a second pape r tray to avoid 
taking paper out and putting the other 
paper in constantly. However, don't get a 
legal size tray, on the theory that it would 
be handy to have both tray sizes. You'll 
d iscover your pages print misaligned. 
That's because the LaserWriter doesn't 
check to see what kind of paper is in the 
tray, but, instead, checks to see which size 
tray is inserted! 

LASERWRITER II 

Jamming With Envelopes 
A simple solution to jamming envelopes 
in the LaserWriter II is to open the door at 
the end of the LaserWriter li so the paper 
path is straight. 
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MOUSE 

Mouse Ball Sticking 
To keep your mouse on the ball. check 
the ball your mouse is on. lf your mouse 
sticks and hesitates, even after a thorouah 
cleaning, it may be the ball that nee~ls 
replacing. Take it out and examine it 
closely. If you see any small bumps or 
irregularities, you've found the cu lprits. 
You can get a new ball from your Apple 
dealer (Apple part number 699-8001 for 
the Plus or 699-8038 for the ADB) for 
about $9. 

MAC PLUS 

The Vents On The Top 
Of A Mac Plus 
Don't b lock the vents on the top or the 
sides the Mac Plus, since it interferes with 
the circulation of cool air to the inside. 
Without adequate ventilation, the Mac 
Plus (and other models as well) may be 
permanent ly damaged. 

When The Calendar And 
Clock Aren't Working 
On A Mac Plus 
The alarm clock and calendar functions 
are regulated by the Mac's internal bat­
teiy. In the Mac Plus, its compartment is 
located in the upper right side on the back 
of the machine. After about two years. the 
battery w ill give out. Replace it w ith an 
Everrea cl y 523BP, Ray-0-Vac RPX21, 
Duracell PX21 or Panasonic PX21 , all of 
w hich are 4.5 volt batteries. You can find 
them at an electronics specialty store and 
through some Mac mai l order houses. If 
the above symptoms are occurring on a 
Mac other than the Plus. the battety is a 
lithium battery. w hich lasts about 7 years 
and requires a Certified Apple Technician 
to replace it. 

I ~ • ~ : l 

RAM 

Upgrading The RAM In A 
Macintosh Plus And SE 
Inside the Macintosh Plus and SE are four 
connectors for single in-line memoty 
modules (SIMMS). A SIMM holds eiuht 
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memory chips and snaps into one of the 
connectors. There are two kinds of SIMMs: 
256K SIMMs (a quarrer of a megabyte) 
and 1-megabyte SIMMs. 

Your SE requ ires matched pairs of SIMMs, 
so here are your choices with four slots: 



HARDWARE 

one pa ir of 256K, two pairs of 256K, one 
pair of each kind , or two pairs of 1 mega­
byte. Multiplying it out, you can see that 
these four configurations give you 512K, 
1 megabyte, 2.5 megabytes, or 4 mega­
bytes. respectively. 

The Mac comes initially with the 1-mega­
byte configuralion - two pa irs of 256K 
SIMMs. To upgrade, you can buy one or 
two pairs of 1-megabyte pans. But you 
have to remove one pair of 256K parts for 
each pair of 1-megabyte parts you install, 
because there are only four connectors. 

So, if you buy the 2-megabyte upgrade 
package (one pair of 2-megabyte SIMMs), 
you remove 512K worth of mem01y from 
your 1-megabyte Mac and add 2 mega­
bytes, giving you a total of 2.5 megabytes. 
If you buy the 4-megabyte upgrade (two 
pairs), you remove both pairs of 1-mega­
byte parts and replace them, leaving you 
with 4 megabytes. 

Either way, you'll have some 256K parts 
left over. Some people use those to up­
grade a 1-megabyte Macintosh II family 
models, because the Macintosh Il has 
eight SIMM connectors internally. 

Not all memory is the same - there are 
different speeds and shapes. Surface­
mount or low-profile SIMMs rake up less 
room but are more expensive than the 
bul kier DIP (dual in-line package) or 
high-profile SIMMs. (You need to worry 
about conserving space only if you plan 
to install o ther hardware - such as an 
accelerator board.) 

You must also pay atte ntion to speed. For 
the Plus, you shouldn 't buy RAM any 

slower than 150 nanoseconds. The maxi­
mum amount of memo1y you can have in 
the Plus is 4 megabytes. Unless you're 
really comfo rtable with opening your 
Mac, you should have your RAM installed 
by an authorized de::~ler. 

Removing and installing SIMMs is not 
difficult, but opening up a Mac Plus or SE 
is. You need a special Torx screwdriver, 
and it he lps to have a "spreader" tool to 
open up the case. You have to take 
special precautions to discharge the ex­
cess voltage on the cathode-ray tube so 
you don 't damage inte rnal compone nts 
(either the Mac's or your own!). And you 
should use grounded wrist straps and 
static-reducing floor and table mats in 
your work area when you're dealing with 
SIMMs. 

SCSI 

SCSI Device Setup 
Small-computer-system-interface (SCSI; 
pronounced ·'scuzzi") devices connect to 
the Macintosh by way or the SCSI port in 
the back of eve1y Macintosh from the Mac 
Plus on up, but they also introduce com­
plications in the way the Mac reads sig­
nals - even from an inte rnal hard-disk 
drive. Some conflicts are serious enough 
to damage your data or Mac, but most are 
common and easy to fix. The two most 
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conunon points of SCSI confusion are 
addressing and termination. 

SCSI devices are connected in a single 
daisy chain. A single daisy chain should 
not exceed 1 8 feet in length and each 
device must have a unique numeric 
address between 0 and 7; the Macintosh 
is a SCSI device with address 7, and in an 
SE or II , an Apple-installed internal hard 
disk in an SE or II has a defau lt SCSI 
address of 0. 

Diffe rent devices have their addresses set 
in differe nt ways - through software, 
through external DIP switches or simple 
push buttons or dials. Addresses must be 
unique, and two devices with the same 
SCSI address can cause System crashes or 
devices not to appear. Choosing certain 
addresses for each device is also impor­
tant. When the Mac statts up, it checks to 
see if there is a disk with a System Folder 
in the floppy disk drives, the n it checks 
for serially connected hard drives, and 
finally starts checking the SCSI chain. It 
looks at SCSI address 0 first and then 
jumps to address 6 and continues clown­
ward , booting off the first system it finds. 
The physical order in which you connect 
the SCSI devices doesn't matter - just their 
SCSI addresses . 

Termination is another SCSI principle . A 
te rminator is a resistor that reduces signal 
echoing along a chain of SCSI devices. It 
is recommended that only the first and 
last SCSI device be terminated, for a to tal 
of two terminators. 

The internal hard disk in an SE or II has 
an internal terminator, but if you have a 
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Mac Plus or an SE without an internal hard 
disk, then you need a terminator at both 
ends of a SCSI chain. 

Many SCSI devices (hard disks, scanners) 
have internal termination, and the easiest 
way to find out - is to check the docu­
mentation or call the manufacturer, and 
avoid peripherals with unremovable ter­
minators. 

If a device does not have inte rnal te rmi­
nation, then an external terminator can be 
placed into one of the two SCSI ports of 
the peripheral device, or into the cable 
before placing the cable on the SCSI port. 

SOUND JACK 

Silencing the Mac 
If you're annoyed by the way the Mac 
beeps when it wants your attention, there 's 
an easy way to get some peace and quiet. 
Pick up a Walkman-style mini jack (Radio 
Shack's mono-to-stereo mini jack will do 
fine) and plug it into the sound jack on the 
back of the Mac. From then on, the menu 
bar will flash to get your attention - in 
silence. 
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THUNDERSCAN 

ThunderScan 2.0/4.0 
Running Under MultiFinder 
Frustrated that ne ither version 2.0 nor 4.0 
of ThunderScan will operate in the back­
ground with Multifinder? Simply launch 
ResEdit, locate your copy of the Thunder­
Scan software that you want to use for a 
background scan, and double-click on it 
to open. Locate the Size resource, double­
click on it, then locate the 0 listing in the 
Size resource. Open this by double-click­
ing, at which time you should see the 
words "Can background" with two radio 
buttons to the side. Click o n the 1, and 
then close the file and save changes. You 
can now run ThunderScan in the back­
ground with MultiFinder. You can also 
make most programs MultiFinder com­
patible, if they aren"t already, by clicking 
on the "Juggler Awa re" button in the Size 
resource just above the ··can Background"' 
radio button. 

Solving Distortion 
With Acetate 
If you're getting a lot of unwanted distor­
tion from your Thunde rScan , and the 
program even crashes occasio nally, tty 
putting a piece of clear acetate over the 
item to be scanned. 

Focus in the high 50s and great scanned 
images will reduce possible distortion. Be 
sure the acetate lines up with the left­
hand edge of your document to be 
scanned . Also clean the le ns on your 
scanner and adjust the height of your 
scanner ca rtridge (according to you r 
printer manual) for optimum focusing. 

Adjusting Lines In A 
ThunderScan Image 
If you sometimes have trouble with just a 
few lines of a ThunderScan image, it may 
be because the scanne r is having trouble 
with the end of the timing tape installed 
on the left end of the Image Writer roller. 

The easiest way to see if this is your p rob­
le m is to scan an image at least 3 1/ 4 
inches long that contains a series of 
vertical lines. Watch the Image window 
closely as the end of the timing tape 
passes under the scanner. If you see patt 
o f the vertical lines displaced to the left, 
it is probably because the timing tape 
doesn·t reflect light back to the scanne r 
accurately and the scanne r misses its 
timing for a line or two. The problem is 
more noticeable if you magnify the image 
being scanned. 

An easy way to fix the problem is to 
ca re fully apply some typewriter correc­
tion fluid even with the edge of the tape 
to fill the gap. If you accidenta lly get 
correction fluid on the rubber roller, it can 
be removed with isopropyl alcohol. 
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VIDEO 

Care and Maintenance 
Of The Screen 
Turn the screen intensity down w hen 
you·re not using the machine.This pre­
vents images from burning into the video 
tube. Using a program like Screen Saver 
or Pyro accomplishes the same thing. 

I 

I 
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Working With The Tools 
Menu On An Mac SE 
When you 're authoring H yperCard stacks 
on an SE, you don't always have a con­
venient spot to stash the tools menu. You 
can hit the Tab key to go from button o r 
field mode to browse mode, but th is has 
the sometimes undesirable side effect o f 
selecting the first unlocked field. The 
contents o f fields can be lost th is way. 
This can be avoided by adding these lines 
to the Home Stack script: 

o n tabKey 
get the tool if it is "button tool" 
or it is " field tool " then choose 
browse tool 
pass tabkey 
end if 

end tabKey 

I f you have the extended keyboard, you 
can change tools by using the function 
keys. Put the second group of lines below 
into the Home Stack script: 

on functionkey num 
put "browse, button, field 
select" into fKeys 
if num > 4 and num < 8 then 
get "choose" && (item (num-4) 
of fKeys) && "tool " 
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do it 
else 
pass functionkey 
end if 

end functionkey 

Don't use Fl through F4, since these are 
rese1v ed for Undo/ Cut/ Copy/ Paste. 

Outlining Hidden Buttons 
Pressing the Command and Option keys 
simultaneously will outline all buttons, 
however Hidden buttons are only out­
lined in Button mode - other buttons 
will be shown in Button and Browse 
modes. 

\XIhile in Field mode, you can outline all 
fields. w hether hidden or not, by pressing 
the Command, Option, and Shift keys 
simultaneously. Th is is very useful when 
learning programming techniques from 
other stacks. Version 1.2 has a command 
to show all buttons. 

Using Font/ DA Juggler Plus 
To Minimize Disk Space 
To usc Font/ DA Juggler Plus to minimize 
the size o f HyperCard stacks, first, use the 
Fkey/ Sound mover, included w ith Font/ 
DA]uggler, to create the sound fi les. Hold 
down the Option key ~·hi le opening files 
to open a HyperCard stack . Then create 
new Fkey/ Sound mover files. ancl copy 
the HyperCard sounds w the new files. 
Font/ DA]uggler Plus can open these new 
Sound files at any time. Up to 12 sound 
files can be opened. The only limitation 
on the number o f sounds is disk space. 
You can switch sets o f sounds quickly 
and easily . 

One problem: HyperCard can play only 
llyperCard sound resources. The Mac 11 
beep sounds that come w ith Font!DA 
Juggler Plus cannot be played in Hyper­
Card. 

Reports 
\Xlh ilc using I l yperCard-compatible Re­
ports, you can encounter an unusual 
problem. In the IlyperCard script editor , 
using the Tab key simply realigns the 
indentation in the script. I [owever, w hen 
using Reports· script edito r 1xessina the 

' 1:> 
Tab key actually inserts a character 
(probably a tab character) that shows up 
as w hir:; space. When the script is exe­
cuted , I !yperCard cannot interpret the 
added character and th is result<; in a ·'can't 
unclerscancl ·' error. To fix it. you must 
delete the added character. So don·r use 
the Tab key in llyperCard Reports' script 
editor. 

Printing A Range Of Cards 
The HyperCard printing options allow 
only the printing o f the current card or the 
entire stack. But if you create a button on 
any card of your stack with the fo llowing 
script, ymdl be able ro print a range of 
cards that you speci fy. 

on mouseUp 
ask " First Card to Print?" 
put It into Start 
ask " Last Card to Print?" 
Put It into Finish 
open printing w ith dialog 

repeat with counter = start to fin ish 
print card counter 
end repeat 
close printing 

end mouseUp 
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Opening A Card To The 
Current Date 
If you'd like an appointtnent stack that'll 
always show the current day's card 
whenever you open the stack, do this: 
Make a copy of the Appointtnent stack 
contained in Stack Ideas, create three 
n1onths' worth of cards, then open the 
stack's script via the Stack Info dialog box 
and enter this script: 

on openStack 
if field "date" is the long 

date then 
exit openStack 
else 
find the long date 
push card 
hide message box 

end openStack. 

The next time you open the stack, the 
current day's card will be on top. If it's 
not, see if there's a card with today's date. 
If there isn't, open the Message box, type 
extend, and press Return. That should do 
it. To check this, open the Message box 
again and enter find the long date, press 
Return, and the current day's card should 
appear. 

Adjusting The Find 
Command 
The Find command of HyperCard searches 
only for the first occurrence of a string in 
a stack. The Find n1enu item continues its 
search for the next occurrence of the 
string in the stack after the Return key is 
pressed. 
If you ·want to prompt the user of your 
stack with a personal n1essage (not the 
standard Find of the Message box), and 
want to continue the search after the first 
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match, use the ··Ask" dialog box to enter 
the string to find. Then "type" it in the 
message box with the Type con1mand. 

All this cary be done with the l'vlessage box 
hidden if the BlindTyping is set to true. 
Here is an exatnple of a script of a "Find" 
button: 

on mouseUp 
go first card 
ask "Find what word or group 

of words?" 
type "find" & quote & it & quote 

& return 
end mouseUp 

I.~ you type "Macintosh" as the string to 
~~~cl, Hyp~rCard will itself type the string 
hnd MaCintosh" in the visible or invisible 

Message box, and will itself depress the 
Return key to begin the search. The next 
tin1e you press the Return key, the search 
will continue, as vvith the Find n1enu item. 
With the con1n1and Find It (it = "Macin­
tosh"), only the first occurrence of the 
string "Macintosh" would have been found 
and the Return key as a ''continue th~ 
search" conunand \Vould not have worked. 

Adding A Phone 
Hang-Up Script 
When dialing numbers fron1 the Address 
stack that con1es with HyperCard, there is 
no obvious way to hang up once a 
number is being dialed or has been eli­
ale(~. You can solve this prohlen1 by 
addtng a background button to the ad­
dress stack that sends a hang-up message 
to the moden1. The script is: 

on mouseUp 
send "dial" & quote & quote & 
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"with modem" & - quote & "+++ 
ATHO" & quote to HyperCard 

end mouseUp 

This sends a hang-up message to the 
n1oden1. If you have the phone off the 
hook, you will still be connected until you 
manually hang up. 

Dialing With A Prometheus 
Modem 
In HyperCard, using the dialing feature 
with a Prometheus n1oden1 can be a little 
difficult if the n1odem doesn't switch fron1 
data to voice transn1ission. Prometheus 
thinks this is a bug in HyperCard, but, not 
so. 

In the Phone Stack that is supplied with 
HyperCard, open the Stack script. Find 
the code that reads: then send "dial" & 
quote&- dialNumber & quote .. Change 
it to read: then send "dial" & quote &­
dialNlllnber &";H" & quote ... 

Now the modern will switch to voice 
transrnission immediately after dialing a 
number. 

Expanding The Cursors In 
HyperCard 
If you want to expand the cursors of 
HyperCard, n1ake the ones you need with 
ResEdit, and call then1 frotn HyperCard by 
indicating the ID Nun1ber. The browse 
tool and all other HyperCard icons and 
cursors are in the Font resource of Hyper­
Card, shown as a strange "12 ID 31756." 
You may not be able to open a resource 
with the ID number set so high. You can 
change the ID number, temporarily, to a 
lower number using Get Info from the 

n1enu bar. Now you can open the re­
source, n1ake your changes, then reset the 
ID nun1ber to the the previous value. Be 
sure to save the changes. 

Printing A Card With Better 
Quality 
If you want to print a card fron1 a stack 
with better quality, especially text, export 
the card data to a Paint program, and print 
in the best quality available. 

Getting The Name Of A Tool 
With HyperTalk 
If you need HyperCard to select a tool or 
pattern from the Tool menu or the Pat­
terns n1enu but you're not sure what it's 
called, follow this procedure: 

1. Tear-Off the tnenu that has the item 
in question. 

2. Select the tool or pattern that you 
plan to use. 

3. Type "get the tool" or "get the 
pattern" into the Message Box and 
press Return. 

4. Type "it" into the Message Box and 
press Return. 

The Message Box should contain the 
exact nan1e (or, for patterns, a nun1ber) 
that HyperCard needs to identify that 
iten1. 

Uninterrupted Keying While 
Refreshing Settings 
Showing the tin1e in a stack is nice, but it 
becornes a pain in the n1ouse if the stack 
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is used for keyboard inpul. At the end of 
each minute. HyperCard updates the time. 
If you happen to be typing when the 
clock strikes, HyperCard aba ndons the 
Text fie ld to update the Time field. One 
way to ensure uninterrupted keying is to 
have HyperCard only refresh the time 
whe n you are not keying. The following 
lines in your stack script will do just that 
(assuming a field named "Time·· is in the 
background): 

on openfield 
set lock Text of field "Time" to 

false 
end openfield 

on mouseleave 
set lock Text of field "Time" to 

true 
end mouseleave 

on idle 
if lock Text of field "Time" =true 

then put the time into field "Time" 
end if 

Adding The Time 
In Any Stack 
T! 's easy to show rhe time in any sta ck. 
Sta rt by creating a fie ld in the background 
calletl Time. Tltcn adtl this shon script to 
the existing background script, if any: 

on idle 
put the time into field "Time" 
pass idle 

end idle 
If you want to add this feature to a single 
card rather than to all the cards of a 
background. simply create a card field 
na med "Time.·· The script should now be 
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added to the card script, changing the 
second line to put the time into card fie ld 
'Time··. 

Compacting HyperCard 
Stacks With Hypertalk 
HyperCard stacks can be rea l me mory 
hogs, especially if you modify them 
occasional ly. The HyperCa rd manua l 
suggests you look at the amount of free 
space in the stack by selecting Stack Info 
from the Options me nu. If there is a lot 
of free space. you can reclaim it by 
selecting Compact Stack from the File 
menu . If you fo rget to do th is, your stack 
can g row to twice its no rmal size. 

Stan by choosing the Authoring level 
from the home stack. Then go to the 
desired stack and choose Srack Info from 
the Options menu. Click on the Script 
button and add the following script: 

on closeStack 
if the freeSize of this stacbO 

then doMenu Compact Stack 
end closeStack 

Another a lternative script is the following: 

on closeStack 
get the freeSize of this stack 
if it > 1 024 * 1 0 then do-Menu 

Compact Stack 
end closeStack 

This script will automatically compact the 
stack if you exit it and it has more than 
l OK (1024 = l K) of free memo1y. If there 
is a lready a script for this stack just add 
the new part at the end, and if the re is 
a lready an .. on closeStack .. scri pt, just add 
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the two lines before the "end closeS tack." 

Changing The Default Font 
In HyperCard 
HyperCard uses the default (application) 
font to label icons as well as in the 
tnessage window. It's also used as the 
default font for the Text tool and new 
fields. To make HyperCard use your fa­
vorite font as its default font, change your 
application font using any of the several 
excellent public domain and low-cost 
shareware programs that will do this. For 
example, to set the icon font to Geneva 9 
you'll need to n1ake the following changes 
using FEdit Plus or MacTools. 

Change: 

6720 3F2D F31 E 
To: 

6720 3F3C 0003 

The final 0003 is what sets Geneva. 

Using Alphanumeric Keys 
To Set Polygon Shapes 
When using the Polygon tool, it is not 
necessary to complete each polygon by 
clicking where you started drawing the 
polygon. If you are in the Fill n1ode, you 
can complete the polygon and fill it by 
typing any alphanumeric key. 

Outline mode acts differently. When you 
type an alphanumeric key in that mode, 
the polygon lines stop where you last 
clicked the mouse. These methods work 
in MacPaint, also. 

Blind Typing Out Of A Jam 
The message box is always there, even 
when it's not visible, just blind type your 
tnessage, such as "open resedit'' or "go 
home." Don't worry about getting the 
capitals right, but be sure you put spaces 
where they belong. Using this technique 
can get you out of a jam, such as when 
you use Recent to go to a card which you 
then discover has no menu or working 
buttons. 

Attaching FONT Resources 
To Stacks 
If you write a stack that includes text fields 
that use particular fonts, you can ensure 
that they will appear in your chosen font 
no matter what fonts other end users have 
available in their System. Using ResEdit, 
copy the Font ID nun1ber of the font you 
want to lock in fron1 the System file. Then 
paste this ID number into the Font file in 
the stack you want that font used in. Even 
if there wasn't a Font file to begin with, 
pasting in the Font 10 will create one. 

Now when others open your stack, the 
fonts included within that stack appear in 
the text menu in HyperCard, along with 
the Systen1 fonts. You no longer have to 
worry about your stack using the default 
fonts and not looking the way you had 
planned it. Remetnber that Fonts (and 
sounds) take up large an1ounts of space 
in a stack. 

Seeing All Hidden And 
Transparent Buttons 
It's easy to see where all the buttons are, 
including hidden and transparent buttons 
that have been painted over, on a Hyper-
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Card card. All you have to do is press the 
Command and Option keys at the san1e 
time. All buttons will be outlined with a 
dotted line. 

Returning To The Finder 
Instead Of HyperCard 
If you want to return to the Finder rather 
than to HyperCard when quitting applica­
tions or documents launched from Hy­
perCard, hold down the Option key while 
quitting. 

Creating A Scrapbook Of 
Buttons 
Often when creating a new stack you'll 
want to use the satne buttons on different 
cards, with different backgrounds. If you 
save these buttons in the Scrapbook, you 
lose all identifying information, and can 
easily forget which button is which. The 
solution is to create a "ScrapCard" on 
which to save these buttons. First, add a 
new card at the end of the stack. Paste 
any button you intend to use again onto 
this carcl. Now all you need to do is press 
Conlnland-4 to get to the ScrapCard (be 
sure to leave it as the last card in the 
stack), choose and copy the appropriate 
button, press Con1n1and- to return to the 
card you were working on, and paste the 
button in. 

Putting HyperCard Into 
MacroMaker Macros 
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HyperTalk is a verbose language -and 
typing con1mands is often tedious. But 
thanks to Apple's MacroMaker, typing 
HyperTalk scripts can be a breeze if you 
turn the most con1n1only used words into 
macros: 

1. When MacroMaker's active, its Cas­
sette icon appears on the menu bar. 
If it's not active, put MacroMaker in­
to your System Folder and restart. 

2. Launch HyperCard. Record your 
macro fron1 any stack, at any card 
(but not from the scripting window, 
which won't let you do anything 
other than enter and edit scripts). 

3. Select Start Recording from the Macro 
Maker tnenu (the Cassette icon starts 
flashing). 

4. Type in your most frequently used 
HyperTalk comn1ands, bearing in 
n1ind that you won't see what you've 
typed. 

5. After entering each con1mand, select 
Stop Recording from the Macro Maker 
menu (the icon stops flashing). 

6. Assign a keystroke to the macro 
you've created-Comtnand-Shift-U 
for on mouseUp, forexan1ple-and 
store it. 

Setting Control-Key 
Combinations To 
Set The User Level 
An easy way for Mac SE and II owners to 
switch between user levels is to create 
Control-key con1binations by inserting 
the following lines into the Home stack: 

on controiKey x 
if x=49 then set the user Level to 

1 
else if x=50 then set the user 



HYPERCARD 

level to 2 
else if x=51 then set the user 

level to 3 
else if x=52 then set the 

user level to 4 
else if x=53 then set the user 

level to 5 
else pass control Key 

end control Key 
end if 

end controiKey 

Now you can press Control and any 
number frotn 1 to 5 and be transferred to 
that user level. 

If you've ever wanted to make your 
HyperCard stacks like real Mac applica­
tions with an About ... con1mand in the 
Apple tnenu, copy the following resources 
(with ResEdit) to your stack from Hyper­
Card itself: 

OLOG "About" 10=2002 
DITl"About"' ID=2002 
STR# "About" 10=2002 
ICON "Bill" 10=2002 
ICON "Hypercard" ID= 1 001 

Once you've loaded the resources in your 
stack by means of the scary tnagic of 
ResEdit, you can alter then1 to your heart's 
content without actually n1odifying the 
originals in HyperCard. To do so, n1ake 
STR# read whatever you want; n1ove, 
add, or delete any of the icons; or place 
your own text inside the DITL. You can 
even n1ove the DLOG box elsewhere. 

Now, when you open your HyperCard 
stack, the About ... co1nn1and will really 
tell other users what your stack is all 

about. So if you're tired of the same old 
HyperCard programming team, add a 
little spice, delete Bill's lovely face- and 
put in whatever you want. 

Speeding Up The 
Performance Of HyperCard 
And SuperCard By Turning 
Off Color 
The speed of HyperCard varies depend­
ing on the color setting, but in general you 
will gain significant speed if you are using 
a color n1onitor and the color is turned off 
completely when you are n1oving a lot of 
n1onochrotne images. For HyperCard, as 
well as SuperCard, if you have 256 colors, 
you should use either no color or 256 
colors (2 colors or 256 colors). 

In the Control Panel, the Control Panel 
Device (CDEV) called Monitors lets you 
adjust the nun1ber of colors your monitor 
shows. If you have 256 colors, your 
monitor will typically be at 2, 4, 16 or 256 
colors. 

Loading Fonts Into 
HyperCard Stacks With The 
Font/DA Mover 
With the Font/DA Mover open to fonts, 
you can load fonts into HyperCard stacks 
if you hold down the Option key while 
clicking on the Open button for the 
second window. This lets you access and 
open applications and stacks in the Font/ 
DA Mover window. 
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Moving A Selected Range 
Of Cells In The Spreadsheet 
While in the spreadsheet, you can quickly 
move a selected range of cells by holding 
down Command-Option while clicking 
in an empty ce ll. The cell that you click 
in will become the upper left cell of the 
moved range. 

Using A Word Processor 
To Change Fonts 
Although the spreadsheet has no font 
changing capabilities, you can move a 
block of cells from a spreadsheet to a 
word processing document via the Clip­
board, and then change the font, sizes or 
styles in the new word processing docu­
ment. The only problem with this is that 
you lose the display grid , if you had one. 
Works' drawing functions allow you to 
easily reintroduce one. 

Sorting Columns 
The program's spreadsheet can sort rows, 
but there is no direct way to son columns. 
A column sort can be performed by 
selecting and copying Lhe range of col­
umns you want to sort. Then paste this 
selection into a new spreadsheet using 
Paste With Options instead of the stan­
dard Paste. Choose Both Formulas And 
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Values and Transpose, and click OK. 
Then reselect the range Cit's now in a row) 
and use the Sort command from the Edit 
menu. Once the sort is completed, cut the 
data and then paste it back into the origi­
nal range, using the Paste With Options 
command and Both Formulas Arid Values 
and Transpose options selected. 

Microscrolling 
When horizontally scrolling, your view 
usually shifts a fixed length. Scrolling in 
the word processor happens one inch at 
a time, w hile scrolling in the data base or 
spreadsheet moves you one column. 
Hold clown Shift w hile scrolling to micro­
scroll, allowing you to position all or parts 
of a w indow more exactly. 

Hanging Up Fast In 
Telecommunications Mode 
While in the communicatio ns mode, you 
can quickly hang up the phone or modem 
by typing Command-=. 

Pasting In Data 
Without Field Names 
If you have cut or copied information 
from the database, hold clown Option 
while pasting it into a word processor to 
avoid pasting in the field names along 
wid1 the data. 

Saving Files With 
Return At End Of Each Line 
Hold clown Option while saving a word 
processor file as text (Export File) to save 
the file with Return characters at the end 
of each line. This w ill come in handy 
when transmitting text files. 
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Bringing The Bottom-most 
Window To The Front 
When working with multiple documents, 
type Command-comma to bring the bot­
tom-most window to the front Use this 
to quickly switch betvveen different docu­
ments you're curre ntly working on. 

Entering Page Breaks 
From The Keyboard 
Enter a page break without having to go 

to the Format menu by hitting Shift-Enter 
while you're typing. The page break will 
be entered at that point. 

Quickly Accessing 
Graph Specifications Dialog 
Double-d ick in a chart window to quickly 
bring up the graph specifications d ialog 
box, wh ich allows you to change the 
graph. 

MUSIC 

=Jj 
CONCERTWARE 

Keep Instrument Files 
In The Same Folder 
As The Player 
Concert\X!are was designed before the 
Mac used the HFS filing system, so it 
might te ll you it can·r find the Instruments 
you're using, if they"re stored in a differ­
ent folde r than the Player fi le. 

·, : •• : _. 111. • 

DELUXE MUSIC 
CONSTUCTION SET 

Hooking Older Mac Models 
Up To Your Stereo 
You can get reall y g reat sound from older 
(1281< or 512K) Macs when working with 
DMCS or other music software. Hook the 
Mac up to your stereo with a cable that 
has a mini phone plug o n one end and a 
pair of phono plugs on the other. Put the 
phono plugs into the equivalent AUX 
jacks on you r stereo, then fit the mini 
phone plug into the back of the Mac, near 
the modem port. 
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When you do this, remember to turn the 
volume slider all the way clown on the 
Control Panel or else the music will 
distort. You should also set the External 
Speaker option on. Then, set the stereo to 
Mono, turn it on, and make music to your 
heart's content. 

Hard Disks Incompatible 
With Earlier Versions 
Earlier versions of DMCS don·t work w ith 
hard d isks. When you would normally 
see a prompt to insert your key eli. k , your 
hard disk w ill bomb instead. The only 
solution is to upgrade. 

Don't Modify The 
Program's System Fonts 
DMCS uses special musical notation fonts 
which won't work properly after they've 
been modified . 

Save Only When You Have 
Enough Room On Your Disk 
Make sure you have plenty of room on­
disk before saving a file. If the disk is 
short on memoty, the program could 
destroy your file instead of prompting 
you to insert a new disk . 
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PROFESSIONAL 

COMPOSER 
Workaround For 
Ignored Rehearsal Marks 
Cse the Print Parrs option under the File 
menu to ·'consol idate·· rests in parts. 
However, in all parts other than the first, 
rehearsal marks w ill be ignored if rests 
precede A D follow the rehearsal mark. 
You can fix the problem by inserting a 
thick barline from the palette at the left 
side of any measure in w hich a rehearsal 
mark is inserted. Any barline at rehearsal 
marks, other than the standard one, force 
Professional Composer to break consoli­
dated rests around rehearsal marks in 
parts w here rests precede and follow the 
mark. 

Place Ties And Articulations 
After Transposing Parts 
When working w ith transposing instru­
ments, make sure to place your atticula­
tions and ties AITER you Transpose Parts. 
This is because the program won't allow 
for the fact that the direction of note stems 
often change after transposition. Your 
articulations and ties w ill often end up on 
the wrong side of the notes, and redo ing 
all of them can be tedious work. 
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QUARTERSTAFF 

Let Your (Laser) Printer 
Do The Walking ... 
If you have access to a laser printer, 
choose Print from QuarterStaff's File menu 
while your Map window is active to create 
a complete map of the area- including 
unexplored places and even hidden rooms. 

=Jj 
STUDIO SESSION 

Note Entry Shortcut 
There's a quick way to enter notes with 
Studio Session. After purring any note on 
the staff, hold the mouse button down. 
Dragging it left or right changes the dura­
tion. and dragging up and clown changes 
accidenral. After moving one way back 
and forth, you'll have to click again to 
make a different kind of change. 

PRESENTATION 

MORE 

Personalizing Your 
Startup Screen 
Consider what you want to clo w ith your 
customiza ble startup screen before actu­
ally creating it, since once you've custom­
ized it, you're stuck with ir. 

Displaying More 
Than One Level Of Headline 
Sometimes you'll want to display more 
than one level of headline in a single 
buller slide chart. To do it , Cut or Copy to 
the Clirhoard each outline section that 
you'd li ke ro see appea r on one bul­
letchart slide. Open a document window 
and Paste in the contents of the Clipboard. 
The indentations remain intact. Edit the 
leader characters to your satisfaction, then 
go to the Buller Subheads dialog box and 
turn off the Subheads, then leave on 
Docume nts . Your slides will show mul­
tiple levels when you do bullet chart pres­
e ntations. 
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Centering Bullet Charts 
For Printing 
To center a bullet chart on a page w hen 
printing, make sur<:: to turn on the As 
Shown When Printed in the Bullet Op­
tions dialog box. If you don't, the chart 
will print the way it looks on-screen. 

Indicating Where 
Sum Total Should Go 
The Ca lculate command normally posi­
tions the sum tota l at the stan of a head­
line. although if there is already a number 
in the headline, the sum total w ill replac<:: 
that number. To indicate exactly w here 
the sum total should go, place a ··so.oo·· 
in the location you w ant to specify. 

Hiding Numbers 
From Calculation 
You can "hide" numbers from the Ca lcu­
late command. MORE considers num­
bers containing a slash (/) to be dates, 
w hile it thinks of numbers containing a 
colon to be times. That means. any figures 
that contain these characters w ill be ig­
nored w hen the Calculate command is 
executed. 

Dollar Figure 
Takes Precedence 
Over Other Figures 
rr a headline contains both a dollar figure 
and a non-dollar figure in the same head­
line, the dollar figure takes precedence 
for ca lculations. w hile the other figure is 
ignored. Fo r example, if you put both an 
expense amount and the date o f the 
expense in the same headline, put a 
dollar sign in front of the expense and for 
calculations, the elate w ill be ignored. 
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Hide A Headline While 
Reorganizing Outline 
You can reorganize an outline by drag­
ging a headline under another headline 
that has collapsed sub-headlines and 
"hiding" it there. This lets you clean up 
your outline and concentrate on organiz­
ing the main details. 
To move a head line under another one. 
select the headline you want to move. 
Then place the pointer to the right or left 
of the headline (or on the headline. i f the 
Recognizes preference is set). Now cl ick. 
The pointer changes to a right arrow. 
Hold clown the mouse button and Option, 
and drag the pointer underneath and to 
the right of a headline w ith collapsed 
subheads. Finally, release the mouse 
button. The chosen headline is no\v 
··hidden·· at the end of the collapsed sub­
headl ines. 

Fast Access To 
Tree Size Dialog 
You can quick ly access the Tree Size 
dialog box by double-cl icking on any of 
the o rientation icons (the first four icons at 
the top of the Tree Chart palette). This 
dialog box lets you alter the exact dimen­
sions of the boxes in your tree. 

Quickly Opening 
Tree Options Dialog 
A quick way to open the Tree Options 
dialog is to double-click on any of the box 
shape icons in the Tree Chart palette. This 
dialog box lets you adjust the patterns of 
the lines and boxes in the Tree, and also 
allows ad justment of grid lines, ru lers. and 
page lines. 
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Toggle Between Headlines 
And Document Window 
You can quickly toggle between a head­
line and its document window by press­
ing Option-Enter. 

Key Equivalents 
Work In Dialogs 
For all dialog boxes where there is no text 
input, you can use C for Cancel, 0 for OK, 
Y for Yes and for ro. lf there are text 
e ntry boxes, use the Command key along 
with the key for choosing the button. 

Quickly Cancelling Dialogs 
You can cancel any dialog by pressing 
Command-period. 

Reversing Text Entry Point 
While the Tab key advances through text 
entry boxes of a dialog, Shift-Tab moves 
the text entry point in reverse order. 

Entering Tabs 
Into Headlines 
Enter tabs into a headl ine by typing 
Option-Tab. 

SPREADSHEETS 

-II 

More ThanA 
Megabyte's Wasted 

• :r.+>·· 

Ea rly versions of Excel (u ntil version 1.5) 
access only the first megabyte of me moty. 
If you have more than that installed in 
your Mac and use the program under 
Switche r make sure to install it in the first 
memoty 'slot to give it the lowest possible 
memory allocation. 

Customizing Chart Formats 
If you use charts a lo t and like to use 
custom chart formats built from those 
already ava ilable, this tip will make your 
charting chores more pa latable. 

You can store libraries of custom cha11 
formats, instead of re-creating a custom 
format every time you need it. Simply use 
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the Clear comn1and to empty the formulas Show Or Print All 
of a chart with a fonnat you find particu- Worksheet Formulas 
larly useful, and use Save As to store it to To show or print all the formulas in a 
disk. worksheet (rather than the data), open a 

To use your custotn chatt format, copy 
the data from the worksheet that you 
want to see in the chart and use Paste 
Special to paste the formulas into the 
formatted chart window. You now have 
the data illustrated in your custom chart 
format, without spending an hour or so to 
re-create that custon1 format. 

If you encounter a situation where you 
can't copy the data directly (a discontinu­
ous selection, for exan1ple), select the 
data you want charted and create a new 
chart file. Then open your customized 
chart file. Do a Select Chart on the cus­
tomized chart file, use the Copy corn­
mand, and then switch to the new chart 
file. Use Paste Special to paste the format 
of your customized chart file onto the 
new chart file. 

Single-Letter 
Command Selection 
You can quickly select con1mands within 
most dialog boxes by typing the first letter 
of a radio button command. That often 
selects the con1mand without your having 
to actually click the Blouse on the button. 

Selecting The 
Entire Worksheet 
You can select an entire worksheet with­
out using the Blouse by typing Command­
A. This is the equivalent of clicking in the 
upper left corner of the worksheet. 
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new macro sheet, copy the required cells 
from the worksheet, and paste them into 
the macro sheet. If you don't include all 
related cells, the cell references within the 
macro sheet may be incorrect or rnislead­
ing. 

Insert New Row/Column 
Without Using File Menu 
You can select Insert to insert a new row 
or column without going back to the file 
menu every tiine. Hold down Option 
while clicking on the row or column in 
which you want to add a new area. 

Automatic Dates 
In Column Heads 
There's a way to tnake Excel autornati­
cally fill in the dates at the heads of 
coluBlns. For exaBlple, to fill in months, 
select the cells you want to fill in with the 
n1onths (12 in this case). Then, choose 
Number froBl the ForBlat menu. Type 
"tnmn1" into the dialog box for abbrevi­
ated rnonths, or "mtnmnl'' to have the 
month names spelled out. Then, without 
deselecting the cells, enter 1 in the first 
cell and press Enter. 

Now go to the data window and choose 
Series. Then, in the dialog box, select 
Series in Row, Type Date, Month Date 
Unit, and incren1ent of 1 without a stop­
ping point. 

Finally, go back to the spreadsheet, type 
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2 in the second cell, and press Enter. The 
dates should appear in the colun1ns. You 
can experiment with this method to see 
how it works for other time increments as 
well. 

You can also use the NOW( ) function to 
enter the current date or time into a cell. 
Define which part of the infonnation 
should be displayed by selecting 

DAY( ), HOUR( ), MINUTE( ), 
MONTH(), WEEKDAY(), or YEAR(). 

The formula for entering the current n1onth 
in a cell would be: 

=MONTH(NOW( )}. 

Displaying/Printing 
Columns Starting With Zero 
Son1e zip codes have leading zeros (for 
example, 05091 for Woodstock, Vennont). 
If you always want Excel to display and 
print these zeros, select the row I column 
in question and select Number ... frotn the 
Format menu. Type in five zeros at the 
bottom of the dialog, then click OK. The 
selected area will now allow for zip codes 
with zeros as their first digits. 

Copying A Spreadsheet 
As A Graphic Image 
Excel has a feature that allows you to 
copy a portion of a spreadsheet as a PICT 
file, instead of having to copy only the 
numbers. Select the area of the spread­
sheet you want and choose Copy Picture 
from the Edit menu. (To get this option to 
appear, hold down Shift before clicking 
on the Edit menu.) The selection, along 

with row and columr.t headings, will now 
be in your Clipboard, where you can 
transfer it to another program like 
MacDraw for resizing or "dressing up." 

Highlighting Multiple Cells 
Highlight a large number of cells by 
clicking on the top left cell of the range 
and choosing Go To ... from the Forn1ula 
n1enu. Then specify the lower right cell of 
the desired range and press Shift while 
clicking OK or pressing Return. 

Cursor Key Movement 
When a group of cells is highlighted, you 
can't n1ove the cursor outside the selected 
area if you're using the keyboard to 
control it. However, you can use the cur­
sor keys to n1ove around within the 
selected cells. When the cursor hits the 
bottotn or the edges, it will wrap to the 
other side. 

Naming Cells 
In Columns Easily 
If you find yourself entering a column of 
labels, only to have to tnanually name 
each cell in the colun1n just to the right of 
the labels for use in fonnulas, here's an 
easier way: Select the first cell that you 
want to have the same name as the 
contents of the label cell to its left. Then 
use Comn1and-L (or choose Define Name 
from the Formula n1enu) and press Re­
turn. Excel will autotnatically assign the 
contents of the label cell to the left as the 
selected cell's name. 
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Centering Tables 
With Borders 
To center a table ·with a border, increase 
or decrease the left n1argin. Check your 
center:ng by viewing the page with the 
Preview option in the Print dialog. The 
left and right margins will both appear if 
the table is centered. Only the left margin 
appears in the reduced view if it is not. 

Remove Formulas To 
Trim Document Space 
When entering a formula into a cell, press 
Enter or Return to confirn1 the formula. 
The results will appear in the cell, but the 
formula is saved with the sheet. Press 
Command-= instead and the results of the 
formula will be entered into the spread­
sheet, while the actual formula is lost. (If 
a new value is entered into a variable cell 
in the formula, the results won't change.) 
Use this n1ethod to trim a few K fron1 your 
saved document when disk space runs 
tight. 

Enter Some Text 
Strings As Formulas 
You might find that entering some text 
strings into a cell produces odd results. 
For example, pasting lOA into a cell re­
sults in Excel displaying 10:00 A.M. Work 
around this by entering the text as a 
formula. Instead of lOA, type= "lOA", and 
the cell will show lOA. 
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Copying Cell Groups For 
Page Layout Applications 
When copying a group of cells to be used 
in a page layout application, highlight the 
cells and then press Con1n1and-Shift-3 to 

copy cells, divider lines, and any other 
infon11ation in the spreadsheet. It will be 
converted into QuickDraw, so when you 
paste it into a word processor or desktop 
publisher, it can be easily resized while 
retaining its full resolution. 

Reopen Macro Sheet To 
Recompute Macro Functions 
You can only use macros from open 
macro sheets when building your spread­
sheet. If you close a macro sheet contain­
ing a n1acro that a cell in your open 
spreadsheet refers to, the value of the 
affected cell will change to "#REF!". The 
way to recotnpute your functions is to 
reopen the macro sheet. 

Using XMODEM 
To Import Lotus 1-2-3 
From MS-DOS Machines 
If you import Lotus 1-2-3 worksheets fron1 
a PC by moden1, use XMODEM. If the 
tern1inal progran1 on your Mac has se­
lectable MacBinary, turn it otT. If you use 
XMODEM, only 7 of the 8 data bits per 
byte come through, so the transfer is use­
less. If MacBinary is used, the first 128 
bytes of data will be lost. 

Command Key 
Combinations To Select 
Page Setup Options ... 
Excel provides con1mand key combina­
tions for ahnost all the choices in page 
setup and print dialogs. In both, Com­
n1and-C or Con1mand-period select Can­
cel, and Comtnand-0 or Return/Enter 
selects OK. 



SPREADSHEETS 

For The ImageWriter 
Page Setup Dialog ... 

Command-U activates "US letter" 
Command-A activates "A4 letter" 
Command-! activates "International 
Fanfold" 
Command-T activates "Tall Ad­
justed" 
Command-5 activates "50% 
reduction" 
Command-N activates "No Gaps 
Between Pages" 
Command-P activates "Print Row 
and Column Headings" 

For The ImageWriter 
Print Dialog ... 

Command- B activates "Best" 
Command-F activates "Faster" 
Command-O activates "Draft" 
Command-A activates "All" 
Command-H activates "Hand 
Feed" 
Command-P marks "Preview" 

For The LaserWriter 
Page Setup Dialog ... 

Command-U activates "US letter" 
Command-A activates "A4 Letter" 
Command-B activates "B5 Letter" 
Command-F marks "Font Substitu­
tion" 
Command-S marks "Smoothing" 
Command-P marks "Print Row and 
Column Headings" 

For The LaserWriter 
Print Dialog ... 

Command-A activates "All" 

Command-F activates "From ... To" 
Command-M activates "Manual 
Feed" 
Command-P activates "Paper 
Cassette" 
Command-N activates "No" {for 
No Cover Page) 
Command-L activates "Last Page" 
{for cover page) 
Command-H activates "Help" 

Formatting Commands In 
Headers And Footers 
To embed formatting con1mands or other 
instructions in the header or footer of an 
Excel docUlnent, insert the commands in 
the Page Setup dialog box. The keyboard 
equivalents are: 

&L: Align the characters that 
follow at the left margin 
&C: Center the characters that 
follow 
&R: Align the characters that 
follow at the right margin 
&P: Print the page number 
&D: Print the current date 
&T: Print the current time 
&F: Print the document name 
&B: Print the left, center, or right 
side of the header or footer in 
boldface 
&1: Print the left, center, or right 
side of the header or footer in 
italics 
&&: Print a single ampersand. 

Extra-Long Text 
In Headers Or Footers 
You can enter header or footer text that's 
longer than the box can display. If you 
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need to edit this rexr later, view it by 
placing the cursor in the visible text near 
rhe rightmost end of the ently box and 
then dragging off the end. The text w ill 
scroll to the left and the extra text, already 
highlighted, will appear. 

Hiding Sensitive Data 
From View 
Using the Cell Protection command only 
hides formulas from being v iewed. To 
rea lly protect sensitive information , elimi­
nate the column containing the clara from 
view. Select all of rJ1e columns you want 
to hide, choose Column Width from the 
Format menu, and set the width to zero. 
AlrJ1ough hidden, rhe values w ill still be 
used in computations. 

Now, protect the document with a pass­
word. No one will be able to view the 
hidden data without know ing your pass­
word and unprotecting your document. 

Protecting Sensitive 
Information While 
Working On It 
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To protect documents from p tying eyes 
while you 're working, open a new docu­
ment before opening the confidential 
one. Then use the new document's size 
box to make it as small as possible. and 
move it to the bottom of the page, so low 
that only irs title bar shmvs. Finally, open 
the confidential document. 

I f you're intruded upon while working, 
double-click the new document's title bar 
and it will instantly cover your private 
information. 

-
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Quickly Returning To 
Where You Left Off 
When you're using several worksheets, 
charts and macros simultaneously, quit­
ting the application and later returning to 
where you left off can be painful - you 
have to open evety worksheet, macro, 
and chart separately. 

However, Excel lets you return to w here 
you left off with the Resume Excel icon, 
which is created after quitting Excel. It 
works only if you haven't tried ro use 
Excel with another worksheet. 

If you want to save a configuration , drag 
the Resume Excel icon our of your System 
folder and rename it. Resume Excel re­
members all the windows last opened, 
their positions, and the locations of all 
files. 

This also works in earlier versions of 
Excel , where the Resume Excel icon ap­
pears in the fo lder tha t was open w hen 
you launched the application. 
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Quick Column Additions 
Quickly add a new column ro a spread­
sheet by holding down Shift while click­
ing in the head of the column directly ro 
the right of the position you wa nt to insert 
the row at. 

Copying Rows and Columns 
Into Word Processor 
It's easy to copy the rows and columns of 
your spreadsheet into a word processor. 
Just select a ll the cells in the spreadsheet 
and Copy them to the Clipboard. Then, 
launch your word processor, making sure 
its tab settings correspond to the spread­
sheer"s column widths. Then, Paste in the 
data from the Clipboard. 

Sorting A Series Of Rows 
To sort a series of rows, select all the 
filled-in cells in the column containing the 
·'field'' you want to sort on. Then choose 
the Sort. .. command. In the dialog box, 
click your sorting choice in ascending or 
descending order. The information in 
columns other d1an the one you sorted on 
will be rea rranged to refl ect the sorted 
column. 

Extra-Long Header 
Or Footer Text 
You can create a header or footer mat's 
longer than the box can display. To edit 
or view this text, place the cursor in the 
visible text near the right-most corner of 
the entry box and drag off its end. The 
text will scroll to the left and the "hidden'' 
text appears, highlighted and ready for 
ed iting. 

Recalculating New Values 
Or Formula Entries 
lf you're having a problem because new 
value or formula e ntries aren't recalcu­
lated into the rest of your cells until the 
document is saved , you must have turned 
o ff the Automatic Calculation feature. 
You can either just use Calculate ow 
from the Calculate menu (also accessed 
with Command-=) or you can reactivate 
Automatic Calculation from the Calculate 
me nu. 

Rounding Off Half-Pennies 
If your spreadsheet contains dolla r fig­
ures with decimal places Jess tlla n a 
penny, Multiplan executes the calcula­
tions exactly, using those values. You can 
choose the Round function to round the 
figures off ro two decimal places before 
ca lculation, if you don't need such exact­
ing figures. 

Fixed Numbers 
Act Like Text 
If yo u display a number with the Fixed 
function, it w ill act like text and can be 
treated as such for concatenation. 
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Use Forced Page Breaks 
When Printing Large Sheets 
When you·re printing large sheets of 
Multiplan documents, it's easier to use 
forced page breaks. These break up the 
spreadsheet into printable units. Then 
select pages from the Print dialog box. 

This may sound cumbersome. but it's a lo t 
easier than constantly selecting areas to 
print from a large spreadsheet. 

Squeezing More 
Data On A Page 
You can squeeze a little more data on a 
page by choosing a page size in the Page 
Setup menu that's larger than the actual 
size of the paper you're using. 

Another way of getting more data on the 
page is to select the Page Setup option 
and set all page margins to 0. 

Tall Adjusted Print Option 
Looks Good, Takes Longer 
The Tall Adjusted printout is much darke r 
and more legible than the printout you 
get using just the Tall setting. However, 
Tall Adjusted pages take almost twice as 
long to print. 

Simulating Freeze Titles 
Option On Printout 
You can simulate the Freeze Titles screen 
option on your printouts if you want to. 
Copy and paste an extra titles column at 
the leftmost side of each page , then 
obscure the column from view by drag­
ging from its right, over the clotted lines. 
You won't see it on-screen, but the printer 
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will produce the titles column in its proper 
position. 

You Can Print More 
Columns Than You Think 
Multiplan can print columns up to 128 
characters wide with the orientation print­
ing o ption, even though you can't enter 
numbers over 99 in the Colul11Jl Width 
dialog box. 

First, open the spreadsheet and Show 
Va lues. Then, use Column Widths to set 
the column \viclth to exactly half of the 
width you want for the printout. Finally, 
select Show Formulas, and the column 
width will do uble to what you want. 

Tf you choose Column Width again, you 'll 
get an '·Invalid Column Width" messaoe 1:> > 

but this won't affect any printing or opera-
tions. 

Highlighting Sections With 
A Graphics Program 
It's not impossible to highlight particular 
sections of a Multiplan sheet. However, 
pasting the documents into a graphics 
program like MacDraw lets you add tints 
to highlight headings and important to­
tals. 

Showing Cells 
That Need Alteration 
Use the Protect Document and Remove 
Cell Protection o ptions together to set up 
a model in which cells that might require 
alteration show up as highlighted and un­
protected . Then, to make changes, you 
can move instantly between these unpro-
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tected cells by using the Enter key. A plus 
is that row and column lines are sup­
pressed on a protected sheet, making 
them cleaner looking and easier to read. 

An Easy Way To Unprotect 
Protected Spreadsheets 
To recover protected spreadsheets, all 
you have to do is open the protected 
document and Save As. Pick a new fi le 
name, Save, Close, and then open the 
Saved copy and get to work. Protection 
doesn't transfe r to new copies of old 
documents. 

Putting Titles At The 
Top Of Lists After Sorting 
If you compile lists and want the title at 
the top after the soning, type a space be­
fore the title . This space has a lower ASCII 
code than any other single character. 

-II 
WINGZ 

Using HyperScript To Add 
Hide And Show Commands 
You can use HyperScript to easily add 
Hide and Show commands to the Sheet 
me nu. 

First, select ew Script from the Script 

menu, and then type the following script 
(tl1e indents are unnecessary): 

select menu "sheet" 
add menu separator 
add menuitem "Hide" command 

" repaint off 
hide sheet hide tool box 

hide entry bar 
select report border no 

line border 
repaint on 
repaint w indow" 

add menuitem "Show" command 
" repaint off 

show sheet show tool 
box show entry bar 

select report border 
single line border 

repaint on 
repaint w indow" 

The Repaint Off command in this script 
stops Wingz from redrawing the screen 
after hiding each element, which would 
slow down the script. The No Line Border 
command hides the border that Wingz 
normally draws around evety printed 
sheet. 

5 Ways To 
Extend Your Wingz 
Wingz features a HyperScript program­
ming language. which lets you easily 
create custom features and menus. You 
don't have to be a programmer to use the 
following scripts. To enter a script into 
Wingz, select ew Script from the Script 
me nu; type the text of the script; and then 
save it, using whatever name you like. To 
run the script, select Run Script from the 
Script menu and open the file conta ining 
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your script. If you create a script natned 
Startup and put it into the same folder as 
Wingz, it will be executed automatically 
each tin1e Wingz is launched. 

1. Improved date formats 
Wingz's five date forn1ats all use hyphens, 
but you n1ay prefer Excel's con1pact tn/d/ 
yy format. This script replaces the fourth 
date fom1at (mm-dd-yy) with m/d/yy. 
The fourth fom1at was chosen for n1odi­
fication because Wingz uses it by default 
for entering a date into a cell, but you can 
change the script to substitute this new 
fom1at for any of the five Wingz formats: 

select menubar "main" 
select menu "format number" 
select menuitem "MM-DD-YY" 
rename menuitem to "MID/YY" 
date 4 "mldlyy" 

The new date forn1at is not stored with 
spreadsheets - to use it, the script must 
be executed each time you start the 
Wingz program, making it a good candi­
date for placen1ent in your Startup script 
(see item 5). 

2. Restoring row height and 
column width 

Wingz lets you adjust the height of rows, 
but this ability is a n1ixed blessing. Rows 
are narrow, and it's easy to accidentally 
change the height of a row when all you 
actually n1eant to do was select it. Once 
it's been changed, there is no simple way 
to restore a row to its original height. This 
script does exactly that - all selected 
rows are reset to their default height: 

row height 240 

The 240 n1easurement is in TWIPs, Wingz's 
standard unit of measure. One TWIP is 1/ 
20 point, so 240 is 12 points, the standard 
row height. A sin1ilar script restores de­
fault column widths: 

column width 1480 

3. Setting row height and 
column width 

This script allo\vs you to set the height of 
all selected rows by sin1ply entering the 
desired height, in points, into a dialog 
box: 

row height value(dg:dgask 
("Enter neight in points" I round 
(rowheight () I 201 0) 1 5)) * 20 

The dialog box initially displays the height 
of the first row in the selection. The 
dg:dgask function, which ships with 
Wingz, displays a dialog box with a 
tnessage and a text field in which the user 
can enter a response. 

It takes three arguments: the message 
string, the initial value to display in the 
response field, and that field's desired 
size in characters. The tnultiplication and 
division by 20 handle the conversion of 
values between points and TWIPs. 

A silnilar script lets you set the width of all 
selected colun1ns: 

column width value (dg :dgask 
("Enter width in points" 1 round 
(column width () I 20, 0) ,5)) * 20 
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4. Time made simple 
Wingz is not sn1art when it comes to 
accepting time values. For instance if 
you enter 10:35 or 12:30pm into a c~ll 
Wingz does not understand that you ar~ 
entering a time- it interprets the entry as 
ordinary text. 

This script converts the text in the active 
cell to a genuine titne value and then 
fom1ats the cell to use the HR:MN AM 
format: 

put timevalue (cell () into 
range (makecell (col 0~ row ())) 
format time 2 

5. Putting it all together 
This script combines all the previous 
scripts and includes an additional script 
for selecting the last cell in a spreadsheet. 
Directly out of the box, Wingz won't let 
yo~ select the last cell - this script 
deftnes the last cell. The Startup script 
provides the new date forn1at and then 
creates a Goodies n1enu that has an entry 
for every one of the remaining com­
mands. Be especially careful to type the 
script exactly as it is shown here: Quo­
tation marks in the scripts appear doubled 
when they are embedded as menu com­
mands in the Startup script. Name this 
script Startup and put it into the san1e 
folder as Wingz; that way, you'll get the 
Goodies menu automatically each tin1e 
you launch Wingz. 

{set 4th date format (the default date 
format) to m/ d/yy} 

select 
menubar "main" 

select menu "format number" 
select menuitem "MM-DD-YY" 
rename menuitem to "M/D/YY" 
date 4 "m/d/yy" 

{create Goodies Menu} 

add menu "Goodies" with 6 items 

{restore selected rows to default height} 

add menuitem "Fix Row Height" 
command "row height 240" 

{set row height in points} 

add menu item "Set Row Height ... " 
command "row height value 
(dg:dgask (""Enter height in 
points"// I round (rowheight () / 20 
0)) * 20 11 

I 

{restore selected colUlnns to default width} 

add menuitem "Fix Column 
Width" command "column width 
1480" 

{set colun1n width in points) 

add menuitem "Set Column 
Width ... " command "column width 
value (dg:dgask (1111 Enter width in 
points"" I round (columnwidth () / 
201 0)) * 20 11 

{convert current cell's text representing 
time to tin1e valuel 

add menuitem "Fix Time" 
command "put timevalue (cell () 
into range (makecell (col () 1 row 
())) format time 2" 
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(select last cell in spreadsheet} 
add menuitem "Select Last Cell" 
command 
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"define sel, lastrow, lastcol 
repaint off 
select Active Cells 
sel = selection( 1) 
lastrow = rowof(sel) + rows(sel) - 1 
lastcol = colof(sel) +cols(sel) - 1 
select range range 
(makecell(lastcol, lastrow)) 
repaint on 

repaint w indow" 

SYSTEM ENHANCEMENTS 

. . .. .; 
,' •, . • I •' 

n 
~ 

ALARM CLOCK DESK 
ACCESSORY 

Why Your Menu Bar 
Or Apple Is Flashing 
If your menu bar (or the Apple icon at the 
top left of the screen) is flashing and you 
don't know why, chances are it's because 
someone set your alarm clock. Choose 
Alarm Clock from under the Apple menu 
and cl ick on the tiny flag at the far right 
side of the window. From there, choose 
the alarm clock icon (in the far right 
corner). Look into the middle section of 
the window- see that small switch image 
on the left? Set it to the up position by 
clicking on it, and your alarm should stop 
fl ashing. 

In I 
~ 

APPLE fiLE EXCHANGE 

Fooling The SuperDrive 
Here's a tip aimed at people who do a lot 
of MS-DOS-to-Macintosh convers io n, 
using the Apple File Exchange. II3M PS/ 2s 
and compatibles that use a 3.5-inch 1.44-
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megabyte drive can read, write, and for­
mat a high-density disk at the lower 720K 
density. Unfortunately, when ny ing to 
read these disks on a SuperDrive-equippecl 
Macintosh, Apple File Exchange assumes 
that it formatted a t the 1,440K density. 
ArE is looking at the extra notch on the 
disk before it attempts to read the actual 
format. 

You can fool the SuperDrive hardware 
into thinking it has a standard DS/ DD 
(double-sided/ double-de ns ity) disk by 
using a piece of tape to cover the extra 
notch (or to further confuse the issue, you 
can use a write-pro tect sticker, as used on 
those archaic 5.25-inch floppies). 

Also, AFE displays hidde n files, such as 
the desktop , and seemingly transfers them 
to an MS-DOS disk. However, the only 
thing that gets transferred is an empty file 
that is hidden on the MS-DOS side (i .e., 
the file 's contents are not transferred, but 
a hidden file is created). If you make a 
habit of hiding your data files under a 
security program, you'd best un-hide them 
before ny ing to transfer them to an MS­
DOS disk. 

fiYl 
~ 

APPLElALK 

Finding A "Lost" Printer 
Sometimes the reason for printing prob-

lems is software-based. For example, if 
you use a printer over AppleTalk, you 
might one clay find that the printer doesn't 
show up in the Chooser Printer dialog­
box. If this happens to you, first Quit the 
application and make sure your disk 
conta ins all the files you need. If it does, 
tty this: 

ln the Choose Printe r dialog box, if the 
printer you need doesn't show up as a 
print option, disconnect AppleTalk and 
close the dialog box. Then, reopen the 
dialog box and select AppleTa lk Con­
nected. Hopefu lly, the missing printer 
icon will mysteriously reappear so you 
can select it and t1y to print again. 

Another reson is to reinstall the printer 
drivers in your System Folder. 

~ 
I~ 
I I 

DESKTOP MANAGER 

Substituting The Desktop 
Manager For The Finder 
The Finder uses the Mac's Resource Mana­
ger, which was designed to work with 
400Kbyte floppies, to maintain the Desk­
top file. So it is not efficient when you 
begin to build up 1000 files or more; it is 
especially noticeable when copying and 
moving files takes a long time. The Desk­
top Manage r is a Finder enhancement 
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·which speeds up the Desktop mainte­
nance over a network. lt is included with 
the AppleShare server disk, and used 
automatically if present in System 6.0 and 
later. To reduce the amount of time the 
Finde r spends maintaining the Desktop , 
put the Deskto p Manager fil e in the Sys­
tem Folder and reboot. You r single Desk­
to p file will be replaced with two invis ible 
files, Desktop DB and Desktop OF. 

DIALOG Box SHORTCUTS 

Switching Drives 
In The Dialog Boxes 
When presented with a Save or Open 
dialog box, pressing the Tab key is a short 
cut to clicking on the Drive button. It 
selects the next available disk drive. 

~ 
~·~·. 
I I 

DIREOORY DIALOG Box 

Three Ways To Search 
The Directory Dialog Box 
You have just selected Open from the File 
menu to find you rself staring at a folder 
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with multitudes of files. I-Iow can you 
speed up you r search for a file that's in the 
middle or toward the bouom of the list? 

1. Scrolling or using the arrow keys lets 
you see every file in a folder, but 
these are also the slowest ways to 
search the directo ty dialog box. 

2. No matte r how you have your view 
set in the Finder windows, the direc­
to ty dialog box always lists files in 
alphabeticaVnumerical o rder. Typ­
ing the beginning letter (or number) 
of the filename rakes you right to the 
file or to a range close to it. If the file 
is near the bottom, tty typing Z. 

3. Typing the tilde (-) key takes you ro 
the vety bottom of the lis t. 

These techniques also work o n windows 
in Res Edit, Symantec Tools, DiskTop, and 
DiskTools II, but they don't work with all 
file editors. You might find o ther in­
stances in which these work . 

I 
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EASY AccEss 

Using Easy Access 
Easy Access is a st<u1up utility which 
comes with recent versions of Syste m 
software for those who can't use a mouse. 
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Easy Access turns the numeric keypad 
into a substitute n1ouse. Put Easy Access 
into your System Folder and restart your 
Mac. Cotntnand-Shift-Clear invokes the 
Easy Access-mode mouse keys. The 5 
key performs the mouse-button functions 
(clicks and double-clicks), and the other 
numeral keys from 1 through 9 move the 
tnouse. The 0 key locks the tnouse button 
clown, and the Period key unlocks it. This 
is docun1ented in the New Features Update 
bundled with System 6. 

Sticky Fingers Feature 
Of Easy Access 
Sticky Keys is a feature of Easy Access that 
allows single-finger operation of the 
keyboard. 

To turn the Sticky Finders feature on, 
press the Shift key five titnes in a row. Be 
careful not to n1ove the mouse at all while 
pressing Shift, or you'll have to start all 
over. 

A Frozen Screen May 
Really Be Easy Access 
Here is a sin1ple tip for those who often 
use cursor keys in Easy Access. If your 
screen freezes and it appears that your 
Mac has bombed, always try pressing the 
period key on the nun1eric keypad. You 
may have accidentally hit the keypad 0 
key, causing the n1ouse to stay clicked 
and creating the illusion of a System error. 

With Sticky Keys turned on, the "tnodi­
fier" keys (such as Shift) can be pressed 
before the key they n1odify, rather than at 
the same tin1e. Pressing the tnodifier key 
once modifies the next keystroke only; 

pressing it twice locks it on until it is 
turned off by being pressed again. Mul­
tiple-n1odifier key sequences (like Shift­
Option) can he executed using Sticky 
Keys. An indicator in the n1enu bar shows 
you which modifier key is active. 

With Sticky Keys turned on, you type as 
usual until you want to type a multiple­
character keystroke. Instead of pressing 
the keys together, you can now press one 
of the tnodifier keys, and the icon in the 
n1enu changes to a down arrow inclicat­
ing that the last key you typed is still 
pressed. 

The other half of Easy Access, Mouse 
Keys, uses the nun1erical keypad for mouse 
tnoven1ents by pressing the keystroke 
combination COinmancl-Shift-Clear. 

Using Easy Access 
For Fine Tuning Graphics 
Easy Access was meant primarily to aid 
physically impaired Mac users who have 
trouble using the keyboard and the n1ouse. 
But any user can profitably use the utility 
fron1 titne to time. For example, using the 
Mouse Keys function of Easy Access, you 
can easily in1plen1ent a "nudge" com­
mand, which moves a selected object one 
pixel at a time in any direction. Such a 
comtnand exists in Super Paint and Cricket 
Draw but is sadly lacking in n1any other 
draw progratns- like FreeHand. Here 
are the steps: 

1. Make sure Easy Access is in the 
System folder when you start (or re­
start) your con1puter. You have to 
be using System 4.1 or later. 
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2. Open your draw program and posi­
tion the po inte r over the item you 
want to nudge. Click the item to 
select it. 

3. Press Command-Shift-Clear to turn 
Mouse Keys on. With Mouse Keys 
on, the numeric keypad operates as 
a mouse substitute. 

4. Press the keypad's 0 key to lock the 
mouse button down. (This is an 
electronic locking, not a physical 
one.) 

5. Tap any of the keys surrounding the 
5 key to move the selected item 
exactly one pixel in the direction 
specified by the position of the key. 
For example, the 2 key moves the 
item straight clown, the 8 key moves 
it up, and the 6 key moves it to the 
right. 

6. When you've nudged the object into 
place, press the keypad period key 
to unlock the mouse button. You 
can leave Mouse Keys on as long as 
you don 't need to use the keypad for 
regular input (the Enter key is unaf­
fected by Mouse Keys, however). 
To tu rn Mouse Keys off, press Clear 
on the keypad. 

Mouse Keys can be incredibly useful for 
vety fine mouse movement- and it's lots 
of fun once you get used to it. 
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Keep Folders Small 
The more items there are in a folde r, the 
longer it takes to open it, so you want to 
keep folde rs small. On the other hand, 
when folders contain fewer items, folder 
nesting becomes deeper. You ·11 want to 
find a balance between too many items in 
a folder and roo many levels of nested 
fo lders. Some programs locate files by 
using their full pathname. This includes 
the name of the volume the file is in and 
evety folder name, in order, on the path 
to the file , with each name separated from 
the next by a colon (:). For example, the 
full pathname to Write row 2.0 in the 
hierarchical organization might be like 
this - Hard Disk:Applications: Word 
Processing:WriteNow:Write ow 2.0. As 
you can see. the deeper folders are nested, 
the longer the pathnames get. Most pro­
grams can't handle fu ll pathnames longer 
than 255 characters. This 255 character 
limit is also a reason not to make file or 
folder names too long. 

RAM Caching 
When you activate RAM caching in the 
General section of the Control Panel DA, 
remember to reboot the machine. Only 
then w ill the RAM cache activate. The 
same applies to turning the RAM cache 
off. 
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Changing Close 
In The File Menu 
In the Finder, holding down the Option 
key while pulling down the File menu 
changes the Close n1enu itern to Close All. 

Rebuilding The 
Desktop Of A Disk 
Holding down the Option and Cornmand 
keys when the Finder launches rebuilds a 
disk's desktop. Rebuilding the desktop 
speeds up the process of launching appli­
cations. Be aware that you will loose any 
comments in the Get Info box of all 
documents and applications when you 
rebuild the desktop. 

Clicking And Dragging 
Files And Folders 
When a folder is shown by name, date, or 
kind, n1any users feel compelled to double­
click or drag a file by the itsy-bitsy icon on 
the far left. Even though this works just 
fine, it's unnecessarily precise and can 
slow you up. You can, in fact, click or 
drag a file anywhere in the row (including 
the white space after the name). If you're 
double-clicking, however, avoid the nan1e 
column because two clicks there rnakes 
the narne editable and puts an insertion 
point where you clicked. 

Organizing Applications 
If you regularly use many applications 
and want to keep then1 all handy, the 
usual solution is to group all of them in a 
single folder on your hard disk. Unfortu­
nately, many applications require that 
you keep several utilities and sample files 
in the sarne folder as the application, 

which makes spotting the application 
itself difficult. You can remedy this prob­
len1 by hiding these utilities outside the 
visible window or by burying then1 in 
folders within the application folder, but 
there is a better way: 

Create an etnpty doctunent in each of the 
applications you use regularly and keep it 
in a folder separate from the application. 
When using one of these blank docu­
ments to create a new file, choose Save As 
to save the new file and to preserve your 
template. Lock the empty document (using 
Get Info); this will prevent you from 
making any changes to it. 

These blank pages take up little n1emory 
and can he customized to your particular 
needs and serve as style sheets. 

Organizing Icons 
Alphabetically 
Here's a quick way to alphabetize a 
column of icons: Select thern, drag them 
to a new folder, set that folder to View by 
Name, then reselect all the files and drag 
them back to the original folder, and don't 
forget that you can rnake a colun1n look 
tidy by dragging a selection rectangle 
around it and then choosing Clean Up 
Selection from the Special menu. 

Neatness Counts 
It's worth the effort to arrange your desk­
top neatly- and to keep it that way. You 
can size and place windows so that as you 
open nested folders, the display is com­
pact and all the windows are visible. You 
can also drag a folder to the desktop and 
keep it there over the span of your 

105 



SYSTEM ENHANCEMENTS 

project, tnaking it easily accessible. Later, 
you can select the folder and use the Put 
A way command in the File menu to return 
it to its home location. 

Tab Stop Assignments In 
The Finder 
You can save a considerable amount of 
horizontal space by resetting the gener­
ous tab stops Apple assigns in the Finder. 
To do so, run ResEdit and open the Finder 
on the disk you want to change (do this 
on a copy of the Finder other than the one 
you are currently ntnning), open LA YO, 
open LAYO=ID 128, scroll down to the 
Tab-stop labels, and substitute the follow­
ing values: 

Tab stop 1 20 
Tab stop 2 114 
Tab stop 3 154 
Tab stop 4 208 
Tab stop 5 304 
Tab stop 6 352 
Tab stop 7 384 

You can change these values to suit your 
preferences. These values save the most 
space without obscuring too n1uch of the 
coltnnn's contents. 

Opening Applications Easily 
The mouse button on the Mac is buffered 
so, when you need to open an application 
directly on one of your hard disks, just 
make sure that all the in1ages of the 
folders and the application's icon are 
aligned. Let's say that you have a folder on 
your desktop called "Word Programs", 
tnside of which are several folders con­
taining various word processors and as-
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sociated files. Odds are that there is one 
application you'll use n1ore than the others 
such as Word 3.01, that is in a folder byth~ 
same name. Click open the Word Pro­
granls folder, and align the newly opened 
window so that the Word 3.01 folder is 
directly over the outline of the Word 
Progran1s folder (This might take a few 
tries). Once they are aligned, open up the 
folder called Word 3.01 and align the 
application Word 3.01 in that window 
with the previous windows. 

Now when you want to open your n1ost 
used word-processing application, all you 
have to do is place the arrow cursor in the 
tniddle of the Word Programs folder and 
click six titnes to open the two folders and 
launch the application. No n1ore moving 
the mouse each titne a folder window is 
opened to get the next folder to open. 
And this trick still allows you to keep a 
neat desktop with everything in its correct 
folder. 

Finder Tips 
When in the Finder, here are some re­
minders and advanced tips: 

1. If you hold down the Option key 
while opening a folder or disk, the 
window opens only tetnporarily. 
When you launch an application 
and then return to the Finder the 
window will be closed. ' 

2. By holding clown the Option key 
while closing a window, you can 
n1ake all the windows on the desk 
top close. 

3. When you hold down the Com-
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n1and key and click in the title bar of 
an inactive window, you can move 
that window on the desktop without 
activating it and bringing it to the 
front. 

Cleaning Up Windows 
In The Finder 
Want to neaten the appearance of the 
application and docun1ent icons inhabit­
ing windows in the Finder? Open the 
window you want to tidy up. Go to the 
View menu and set it so that the window 
is showing your applications and docu­
tnents by Name and not Icon or Sn1all 
Icon. Use the Select All cotnn1and under 
the Edit n1enu. Drag eve1ything out onto 
the Desktop and wait a second or two 
while the Finder catches up with you. Go 
back to the View menu and reselect By 
Icon or By Small Icon - whichever you 
prefer. Then go to the File menu and 
select Put Away. Your applications and 
docun1ents will begin quickly arranging 
themselves in the window in alphabetical 
order. 

Running A Mac 
With A Copilot 
Did you know that you can ntn Macs from 
the SE and II fatnilies with a real live 
copilot at your side? Just have your near­
est Mac expert bring a second keyboard 
(and mouse) to your desk and plug it into 
one of the Apple Desktop bus (ADB) 
ports on the back of your Mac. 

The extra keyboard and Inouse turn your 
Macintosh into a state-of-the-art training 
system, complete with room for a copilot. 
Your resident expert can sit beside you 

and demonstrate various techniques. This 
gives you the chance to try out the 
techniques yourself without having to 
share the keyboard or tnouse. 

Preventing Pirating Of 
Applications From Your 
Hard Disk or Network 
Here's a way to stop people from pirating 
applications fron1 a hard disk or a net­
work: 

First, create a blank docutnent with the 
application you want to protect and give 
it a name sitnilar to that of the application 
(such as "Word 4" for Microsoft Word 4.0) 

Next, use ResEdit to n1ake the program 
invisible (highlight the application name, 
choose Get Info from ResEdit's File rnenu, 
and click on the Invisible box). Quit 
ResEdit and restart. 

Copying Disks 
From The Finder 
When using the Finder to copy a disk, you 
can avoid typing the new disk name. 
Simply click on the icon of the original 
disk and select Copy fron1 the Edit menu 
(Cotnmand-C), then click on the icon of 
the disk. 

Getting Screen Shots 
OnAMacll 
In order to get Comn1and-Shift-3 (the Sys­
tem utility that creates MacPaint-type 
snapshots of the screen) to work on a 
Mac II, configure the video card to use 
only two shades of gray. If the card is con-
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figured for 4 or 16 shades, the Command­
Shift-3 combination won't work. 

Virus Protection 
Here's a very simple and effective way to 
protect programs on your hard disk from 
virus infection. 

While in the Finde r, do a Get Info on each 
of the programs on your disk and click in 
the Locked box at the upper-right corner 
of the window (see Figure 1). This usually 
protects the selected file from accidental 
deletion, but it also guards it against virus 
contamination, since it prevents new 
resources from being written to the appli­
cation. Don't forget to protect mini-appli­
cations like Fonr/DA Handler. 

Vivid Color Icons 
If you have a color Mac, you can change 
the way colors are used with icons and 
change the colors displayed on the Color 
menu using an application called Layout 
(Latest version is 1.9). Layout is a free but 
copyrighted resource-editing tool by 
Michae l O'Connor that is available on 
CompuServe and other on-line services. 

Open Layout and select Color Style from 
the Options menu. This will bring up two 
radio buttons labeled Normal Color Style 
and Alternate Colo r Style. Click on the 
latter for more-vivid icons. You 'll also see 
eight color bars like the bars on the Find­
er's Color menu. Click on any color and 
use the Color Picker to change its value . 
Quit, saving your changes (you can rees­
tablish the old colors later by choosing 
the default) . 
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A Pre-Trash Folder 
For those who worry about throwing files 
in the trash and then later regretting the 
decision, just create a new folder on your 
startup disk called "Pre-Trash", "Today's 
Garbage", or the like and place it above 
or next to the true trash on the desktop. 
You could even place it so that it mostly 
cove rs the icon. Then, instead of throw­
ing files d irectly into the trash, put them 
first into the pre-folder. At the end of 
every session, you can calmly sort through 
the files placed in this folder and render 
judgment on them- no more accidental 
trashing of vital documents . 

Quick Disk Erase 
The quickest and easiest way to erase a 
disk is to copy a blank disk over it. To do 
this, just insert a blank, formatted disk in 
a drive and drag its icon onto that of the 
disk you want to erase. You 'll usually save 
a minute or so over using the Special 
menu 's Erase Disk command. 
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FKEYS 

Testing Fkeys With ResEdit 
If you are looking around in a file with 
ResEdit and you see an Fkey resource, or 
you just want to t1y an Fkey before putting 
it in your System file , you can try the Fkey 
while in ResEdit. The system looks through 
the chain of open files, not just the System 
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file, to find Fkeys. Since ResEdit has 
opened the file, when you press Com­
mand-Shift-N, where 1 is the lD of the 
Fkey, the Fkey is invoked. The most re­
cently opened fi le is searched fi rst, so 
even if the Fkey you wa nt to tJy has the 
same ID as an Fkey in your System file, 
the Fkey you want to ny is invoked 
instead of the one in the System file. 

~ 
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FoNT /DA MovER 

Adding And Removing Fonts 
From HyperCard And Other 
Applications 
Sometimes you want to add and remove 
fonts from an application (as opposed to 
the System). On launching Fonr/ DA Mover, 
you'll see a list of all the fonts in your 
System file. To open the font file of any 
application - or even a HyperCard stack 
- press the Option key while clicking on 
the Open button. Font/ DA Mover works 
the same with applications as it does with 
System files. You can have two applica­
tions open simultaneously to swap fonts, 
or just one to remove them. 
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FONTS 

Screen Font Alignment 
Most Macintosh screen fonts supplied by 
Apple and all LaserWriter fonts have 
constant-width digits. It's been a standard 
in typography since the birth of financial 
printing. So if you're having trouble lining 
up columns of numbers, tJy the following 
suggestions. 

Tn spreadsheet programs such as Excel, 
use a cell format that has a constant 
number of places after the decimal and 
left-align them. Usi ng the General format 
in Excel with numbers that vaty in preci­
sion is a sure way to have your columns 
wander. Similarly, in word processors, 
use a right-aligned tab and keep a con­
stant number of places after the decimal 
o r use the decimal Lab that many word 
processors include specifically for this 
purpose - it a ligns a tabbed column on 
the decimal point (or on the right if no 
decimal point is present). Both MacWrite 
and Word include decimal tabbing. 
i{emember - use the Tab key, not spaces, 
before each numbe r in the column. 

The presence of non-dig it characters, 
such as commas, parentheses, and dollar 
signs, may alter the a lignment of d igits in 
columns, but they shouldn"t be a problem 
if you use the m consiste ntly. 
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Obtaining Special 
Characters Using Key Caps 
The following Control keys within Key 
Caps define special characters in the 
Chicago font that may be useful: Control­
Q (8€ ), Control-R (V"), Control-S ( + ), 
Control-T (j). 

If, in the text of your document, you are 
using any other font besides Chicago, the 
symbol will appear as a box outline. To 
get the symbol in your text, highlight the 
Key Caps line and choose Cut or Copy 
from the Edit menu. Close the Key Caps, 
place the cursor where you want the 
character, and choose Paste from the Edit 
menu. The box outline will appear. You 
must select the box and change your font 
to Chicago for that space. 
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HARD DISKS 

Interleave Factor And Hard 
Disk Performance 
The performance of your hard disk relates 
to its interleave factor. If you change 
machines or add an accelerator card, you 
may need to change the interleave. As a 
rule, drives attached to a Mac Plus work 
best with a 3:1 interleave; those attached 
to an SE require 2:1; and Mac lis , Ilx's, SE/ 
30s, and all accelerated Pluses and SEs 
work best if the disk has a 1:1 interleave. 
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To see what that interleave is and to 
change it, use the latest version of Apple 's 
HD SC Setup (which is part of the System 
Tools 5.0 or 6.0 package). Hold down 
Command-! after you arrive at the appli­
cation's window to access the interleave 
areas of the program. Remember to back 
up your entire disk before changing the 
inte rleave. Changing the interleave re­
quires reformatting the disk - an opera­
tion that destroys all the data on the disk. 
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I NITs 

The Scoop On INITs 
An INIT is an initialization resource - a 
System resource that is loaded into the 
part of the Mac's RAM called the System 
heap and run as part of the normal startup 
procedure. You can buy !NITs commer­
cially or download public-domain INITs 
from a bulletin-board service CBBS). INITs 
are generally neither menu- or Command 
key-driven; they are designed to function 
automatically. 

When !NIT-based utilities first appeared, 
there was no way for the average user to 
install them into the System file. Develop­
ers invented their own installation meth­
ods, and some neglected to provide a way 
to remove INITs when they were no 
longer wanted. What users needed was 
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an INIT equivalent to Apple's Font!DA 
Mover. 

Responding to this need , Apple released 
INIT 31. It worked at startup, searching 
the System folder for any files of type INIT 
and loading the enabled ones it found. So 
now you can simply drag an INIT into the 
System folder and INIT 31 would do the 
rest. 

Because I IT 31 executes only at startup, 
the Mac must be rebooted before a new 
I IT becomes active. To disable an INIT, 
simply remove the file from the System 
folder and reboot. The !NITs that are 
active in your System file wi ll usually 
display a small square icon at the bottom 
of the screen during stattup. 

LoadingiNITs 
At Startup Time 
I ITs (or Startup documents) p laced in 
your System Folder will normally be loaded 
and active in the System upon starting up 
your Macintosh. When starting up your 
Mac you can actively not load cenain 
INITs by holding clown the Shift key until 
the menu bar appea rs. This is an option 
that not all developers take advantage of, 
so some I TJTs will work and others will 
not respond to this key press. Suitecase 
and On Cue are two I 'ITs which do 
respond to this action. 
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LARGE fiLES 

Transportation Of Files 
Larger Than SOOK or 1440K 
(High Density Disk) 
If you have to split up a file too large to 
fit on an 800K or 1440 K (High Density) 
floppy so that you can take it to a service 
bureau there is a solution. If you have a 
program for backing up your hard disk, 
bring a copy of it with you the next time 
you visit the bureau. If a file becomes too 
large to save to a floppy-disk, use the 
backup program to back up the file (the 
program will break the file up- you can 
restore the fragmented fil e on your hard 
d isk when you get home). 

~ 
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LASER PREP 

Mixing Various 
Macintosh Models 
On An AppleTalk Network 
Do you have a mix of Mac 512Ks, Pluses, 
SEs, and Mac II models on your Ap-
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pleTalk netwo rk? Are all the 512K users 
cursing because they have to manually 
reset the LaserWriter evety time they want 
to use it? 

The problem is that the LaserWriter driver 
and LaserPrep programs versions 4.0 and 
later (supplied with a ll Macs after the 
512KE) initialize the printer differently 
than the version 3.0 programs supplied 
with the 512KE. The version 4.0 programs 
offer the user the options to reinitialize 
the printer (from the ir computer) if needed, 
while the version 3.0 programs simply 
return an e rro r message and abort the 
print job. A possible solution is to up­
grade the 512Ks to System 4.0, but Apple 
does not recommend this, and System 
version 4.0 needs more memoty than a 
512K can afford to g ive to the System. 

The real solution is to trash your o ld 
version 3.0 LaserWriter and LaserPrep 
programs and copy the version 4.0 Laser­
Wri ter and LaserPrep programs onto you r 
Syste m version 3.2 d isk. Do this only o n 
a copy of your System. 

The new driver and prep programs work 
fine with the older System and they fix the 
"Can't Initia lize Printe r" syndrome for 
good. The version 4.0 Lase rWrite r and 
LaserPrep files can be identified by the 
creation date of April 14, 1987, which is 
available in the Get Info window. 

Using The 
LaserPrep File With 
Non-Apple Laser Printers 
If you've purchased a laser printer other 
than an Apple LaserWrite r. you've proba-
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bly found that '·Smoothing" does not 
work. The LaserPrep file checks to see 
whethe r the printer is a Laser\XIrite r. If 
not, the bit-smoothing algorithm is not 
loaded into your printer. Tfyou have a file 
editor utility, such as FEclit, it is possible 
to enable bit-smoothing for any lase r 
printer. First, copy LaserPrep from your 
system folder to a blank floppy disk. 

Use FEdit to open the floppy volume. Use 
"Display Sector in ASCI!" under the Dis­
play menu. Turn "ASCII Modify'' on in the 
Edit me nu. Perform an ASCII sea rch to 
find the string: "0] ifelse exch" Change the 
"0" to a "2." Do a "Write Sector" from the 
Edit menu. Quit FEdit and return to the 
Finder. Make sure you save a copy of the 
orig inal LaserPre p before you perform 
the next step. Copy the modified Laser­
Pre p to your System Folder. If you printed 
a document before modifying the Laser­
Prep fil e, cycle power on the printer, and 
whe n you print your ne>.'t document, 
smoothing will work. 

' I 
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LASER WRITER 

Using Different Versions Of 
The LaserWriter Printer 
Driver On A Network 
When using AppleTalk on a network. 
make sure all Macintoshs have the same 
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version of the LaserWriter driver in their 
System Folder, assuming you are using a 
version of the LaserWriter driver which is 
less than version 5.2. The LaserWriter 
driver from System version 6.0x and 7.0 
can be mixed on a network without 
reinitializing the printer. 

Using ResEdit To Place The 
PostScript File Option in the 
Print Dialog Box 
Pressing Command-F after clicking on 
OK in the LaserWriter dialog box w rites 
the PostScript output, minus the Laser­
Prep file, to a file. But some applications 
intercept this Command-F event, prevent­
ing the file from reaching the laserWriter 
driver. 

1. In ResEclit, open the copy of the 
LaserWriter driver, version 5.2 or 
6.0, and select DITL from the list of 
resources. 

2. Using the Open as Template option 
(labeled Open As in earlier version 
of ResEdit), select DITL ID = -8191 to 
open it as a DITL resource. 

3. Find the Item for Disk File with a 
Display rect (display rectangle) of 0 
0 0 0. Change the Display rect to 49 
320 65 400. Save your changes, and 
exit from ResEdit. 

4. When the LaserWriter Print dialog 
box appears, you should see a new 
option called Disk File. Clicking on 
it results in the creation of a Post­
Script file of the output ca lled Post­
Scripta ( or 1, 2, 3, and so on). This 

file will appear in yolll·System Folder 
or in the Spool Folder within the Sys­
tem Folder. 

5. To avoid confusion with other Laser­
Writer driver files on your hard disk, 
rename this altered driver. You 'll 
have to select this driver from the 
Chooser to access it after you've 
changed its name. 
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Fixing Transposed Letters 
With A Keystroke 
If you catch yourself making typos such 
as typing teh for the, you're not alone­
transposing letters is one of the most 
common typing mistakes. Here's a macro 
that fixes transposed letters with one 
keystroke. It can be used with Macro­
Maker and Word, or you can use the same 
general procedure with AutoMaciii, Mind­
Write, or o ther combinations of word 
p rocessors (that support the arrow keys) 
and macro programs. 

1. If you don't already have Macro 
Maker installed, put a copy of the 
MacroMaker file, which comes on 
the Macintosh Utilities Disk 2 in 
System 6 and later, into your System 
folder. For MacroMaker to take 
effect, you have to restart your Mac. 
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2. Place the cursor immediately after 
any two transposed letters in your 
word processing document (if you've 
just typed them, this is where the 
cursor will be anyway). 

3. From the MacroMaker menu , select 
Sta1t Recording. 

4. Press Shift-left arrow to highlight the 
second of the two letters to be 
swapped (don 't use the mouse to 
highlight the le tter, or the macro will 
operate only on this position of the 
screen). 

5. Cut this letter (with Conun and-X) . 

6. Press the left arrow to move the 
cursor to the left of the first letter 
(aga in, do not use the mouse). 

7. Paste (Command-V) the second let­
te r on the left side of the first le tter. 

8. Press the right arrow to re turn the 
cursor to its original position follow­
ing both le tters. 

9. Immediately select Stop Recording 
from the MacroMaker menu. 

10. Give the macro a name, such as 
Swap Letters or transpose, and 
assign it a keystroke. 

11. Store the macro. 

To use the macro, make sure the cursor is 
positioned immediately after the tra ns­
posed le tters and use the keystroke you 
assigned in ste p 10. 
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Tempo 
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When composing macros, avoid the use 
of the cursor keys. Use the keypad equiva­
lents instead. By doing so your macros 
will work both in Microsoft Word's out­
line mode and also in the regu lar text 
mode. Remember that Word assigns spe­
cial outlining functions to the cursor keys 
but the keypad equiva lents function the 
same in either mode. For example , to 
construct a type transposition macro, 
instead of Shift-Left cursor arrow, Com­
mand-X, Left cursor an·ow, Command-V, 
Right cursor arrow - use the following: 
Shift-4, Commanci-X, 4, Commanci-V, 6. 

Tempo 1.2 
When writing macros using Tempo 1.2 
inside of an applicatio n, it can be tricky to 
save a file to a particular folder different 
than the one it was loaded from. Tempo 
starts at the main or root directo1y of the 
disk when doing a Save As in a macro. Al­
though o ne can use mouse clicks to step 
clown through the fo lders, if you later add 
to or othe1w ise change the list of folders 
on your disk, this approach can land you 
in the wrong fo lder when using the macro. 
However, it's possible to set up the proper 
path by using the Open command first, 
before the Save As. The Open conunancl 
allows you to type the characte rs of the 
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folder's name, and the inverse selection 
bar will automatically jump to the match­
ing folder in the list. You can press Return 
and repeat this process until you've 
reached the folder that you wish to save 
the file in. At this point you cancel the 
Open and perform your Save As to the 
subfolder that has now been set up. Even 
if you add a lot of new folders, your macro 
will still fu nction correcrly. 
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MAP CDEV 

Magnifying The Map 
Control Panel Device 
(CDEV) 
The Apple documentation on the Control 
Panel Map utili ty mentions that if you 
want a magnified map image, you should 
press the Option key while clicking the 
Map icon. This results in an image that's 
so magnified as to be virtually unusable. 
What the manual doesn't mention is that 
you can get a slightly magnified version of 
the map by pressing Shift while clicking 
the Map icon . 

Changing The Map Figure 
The world map image in Apple 's new 
CDEV Map can be copied to the Clip­
board simply by choosing Copy from the 
Edit me nu when Map is on- screen. Make 
sure the city name box is not highlighted 

(or you will copy the name instead of the 
map). So what's so great about that? 
Several things. 

First, if you have a color system, you can 
copy and paste the map image into a 
program like PixelPaint, color it, and then 
copy and paste the colored version back 
into the CDEV's window. Oceans could 
be blue , continents in contrasting colors, 
and so on. 

Jf you live in a black-and-white world, 
you can still modify the map in MacPaint, 
using patterns instead of colors. 
And in any case, you have a fairly decent 
world map that you can store separately 
with your clip art for use in other docu­
ments. 

And, by the way, you don't have to worry 
about cutting or clearing the map image 
accidently - only Copy and Paste work 
from the Edit menu w hile you have the 
CDEV open. 
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MuLti fiNDER 

Starting MultiFinder 
Temporarily When 
In The Finder 
While running the Finde r, you can start 
the MultiFinder without resta rting your 
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Macintosh by double-clicking the Multi­
Finde r icon (in your System Folder) while 
holding down the Option and Command 
keys. The next time you do Restart, you 
will be back in the Finder. 

Loading Desk Accessories 
Into The Finder's 
Application Heap 
Under MultiFinder, holding clown the 
Option key and then selecting a DA (desk 
accessoty) loads the DA into the Finde r's 
application heap instead of loading it into 
the DA Handler. 

Reinserting Disks To Find 
Disk Icons 
It's often necessaty to return to the Finder 
from an open application for file informa­
tion. But when you are working under 
MultiFinder, open documents obscure 
the desktop, hiding the disk icons you 
need. One way to open a disk's window 
from beneath the clutter is to eject it, using 
Command-Shift-1 o r Command-Shift-2 
(depending on what drive the disk is in) 
and then reinsert it. Re insertion automati­
cally causes the disk's icon to be selected 
(even if you can't see it) . Then you will 
be able to open it with Command-O, and 
its window will pop to the forefront. 
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MuurftNDER 1.0 

Bypassing The DA Handler 
In MultiFinder 
When using MultiFincler 1.0 and selecting 
a desk accessoty, press the Option key as 
you click on the Apple menu. TheDA you 
select w ill bypass the DA Handler and 
operate only in the application you're 
currently using. Bypassing the DA Han­
dle r allows DAs such as Icon Maker to 
perform properly while using MultiFin­
der. Make sure you've allocated enough 
mem01y to the application (use Get Info) 
so that the application and the DA can run 
at the same time. 
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PARAMETER RAM 

Resetting The 
PRAM In The Mac 
The parameter RAM (PRAM) is where the 
Mac stores basic information like the time 
and default font (and other things) that it 
must know when you statt it up. It's 
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powered by the batte1y. And occasionally 
it gets fouled up and must be reset. 

On Macs and Mac Pluses resetting the 
PRAM is simple. Just shut the machine off 
and remove the batte1y fo r 5 o r 10 min­
utes. It's impossible to do that on theSE 
or the II , however. But Apple has pro­
vided another way to reset the PRAM. 
You must be using Control Panel 3.1 (or 
higher) . Version 3.1 is included with Sys­
tem 4.1 and Finder 5.5. Here's what to do: 

As you select the Control Panel hold 
down the Shift, Option, and Command 
keys. You'll get a dialog box asking if you 
want to zap (reset) the parameter RAM. 
Select Yes, and then Restart you r Mac. 
This will set most of the PRAM to zero, 
and will change all your Control Panel 
settings to defau lt settings, but will not 
reset the clock. Reset all your other op­
tions as they were or as you wish. 
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PARTITIONING SoFTWARE 

Partitioning Your Hard Disk 
Partitioning software (including ALSoft's 
MultiDisk, FWB Software's Hard Disk 
Partition, and the HD Partition program in 
Symantec Utilities for Macintosh) divides 
your disk into multiple volumes, each of 
which is its own "virtual" disk. You can 
use pa1titions to help organize your files. 

They're a great aid with most backup 
programs, which work volume by vol­
ume. If you create a small partitio n for 
your recent documents, you can back up 
that volume daily and the backups will go 
quickly. Keep o lder documents in a sepa­
rate partition. For security, pa1titions can 
be password-protected, and if you share 
your hard disk, partitions can give all 
users their own private work areas. 

You can keep o lder versions of software 
in a separate partition fo r when it's neces­
sary to use an o ld version of a program. 
You don 't want both the old and new 
version o n the same volume , because 
when you double-click on a document, 
you don't know which version of the 
application will open. 

The Finder also slows down whe n a disk 
has too many files and the System Desk­
top fil e gets too big- so partitioning your 
disk limits each volume to a size the 
Finder can manage. 
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PUBLIC fOLDER 

Moving Files From 
One Mac To Another 
With Public Folder 
In the past, if all you wanted to do was 
move a fil e from one Mac to another, 
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SneakerNet was one of the few viable 
options - unless you spent money on 
commercial networking products. Now 
there's a better solutio n, aptly named 
Public Folder. This handy network file­
transfer utility is distributed free by Claris 
to registered owners of its products, and 
is also available from most on-line seiv ­
ices and user groups. 

Public Folder is a Chooser document that 
allows you to designate a folder on your 
hard disk as public. You can't send a file 
anywhe re, but any file you put into your 
public folder can be retrieved by anyone 
else on your network who is using Public 
Folder. 

When people are moving a file from your 
Mac to theirs, you will fee l a performance 
hit- your mouse may become twitchy 
and reaction time may be slower than 
usua l, however Public Folder moves files 
rapidly from one Mac to the other, the 
speed depending on network traffic. 

It is not a replacement for AppleShare or 
TOPS, but for occasional transfe r of files 
Public Folde r provides an elegant an­
swer. 
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Using QuicKeys To Print 
If you program QuicKeys to scan the 
menus looking fo r "Print. .. " and find that 
it doesn't work in some applications, re­
member that some applications do the 
ellipsis after Print with three periods and 
some do it with Option-semicolon. They 
may appear the same on tl1e screen, but 
to QuicKeys they're quite different. Solu­
tion: Define an application-specific Quic­
Keys file for each of these applications. 
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RES EDIT 

Reducing The Amount 
Of Space Between Files 
When you have many documents in a 
folder, you can use the By Name option 
in the View menu to see more of my 
documents at one ti me, though they still 
have large spaces between them. To re­
duce the amount of space and make more 
files visible, modify the Finder using 
ResEclit. 
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To do this, run ResEdit and open the 
Finder on the disk you want to change. 
Double-click on the LAYO resource. 
Double-click on LAYO = 128. Click once 
on the gray part of the scroll bar. Change 
the number in Line Spacing from 16 to 11. 
Save the Finder and quit ResEdit. Now 
your documents will be listed in a tighter 
format. 
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SouND CoNVERTER 

Editing Sounds 
When you want to turn sounds into sound 
resource files, the sounds are often at the 
wrong sampling rate. A utili ty called Sound 
Converter converts SoundEdit, Sound­
Wave, or SoundCap files into sound re­
sources and lets you choose the sampling 
rate when you convert sounds (although 
it doesn't let you change the sampling rate 
of an existing sound resource). 

Sound Manager is a sound-manipulating 
shareware utility that can do any type of 
conversion, play sounds, and let you do 
some light editing. But you'll also need 
SoundEdit (one of the applications that is 
included with Farallon's MacRecorder 
sound digitizer) if you want to change the 
sampling rate of the resource. Sound 
Manager can convert sounds to SoundEd it 
format; SoundEdit can save the sounds 
w ith a d ifferenr sampling rate (although it 

can convert only from faster rates to 
slower rates). 
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STEPPING Our II 

Disabling Stepping Out TI 
Upon Launching An 
Application 
Stepping Out II is a useful addition to the 
Mac, giving the effect of a larger screen. 
Many peop le kee p it on all the time. But 
some programs, particularly games and 
telecommunications software, are better 
off without it. To save yourself a trip to the 
Control Panel DA, launch your program 
while holding clown the Option key, and 
Stepping Out II will automatically shut 
off. You should use the Control Panel to 
turn it back on when you Quit, though. 
This is an undocumented and handy 
reversal of Stepping Out's QuickStart 
feature . 

Stepping Out 
As A Screen Shrinker 
The DA Stepping Out II is a screen 
extender that allows the creation of large 
virtual screens on the Mac. Although most 
people can readily see the benefit of this 
(panicularly for the 9-inch screen of the 
Plus and SE), there is another benefi t for 
those who would rather use a larger 
monitor while deve loping applications 
for the smaller, standard screens. 
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Stepping O ur II also functions quite effec­
tively as a screen shrinker. Creating a 
small screen size is simple. First, ca ll up 
Stepping Out II from your Control Panel. 
Click ew and enter the pixe l count for 
the screen size you wa nt (512 pixels wide 
by 342 high for the Mac SE). The n, ente r 
a name for your screen definition (such as 
"Mac SE Screen") and cl ick Save. Finally, 
highlight the name of your new screen 
setup and click Set. If you have enough 
memo•y reserved for the new screen (and 
assuming that Stepping O ut II is active), 
the change takes place immediately, o th­
eJw ise, you will first need to reboo t. 

Once all this is accomplished , you can 
easily switch from one screen size to the 
othe r by simply turning Stepping O ut II 
on or off from the Control Panel. 
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STUFFh 

Automatically Unstuff1ng 
All Archived Files 
Stufflt, which has become the industJy­
standard utili ty for archiving and com­
pressing Macintosh fi les, has a hidden 
(and very handy) feature. After selecting 
the archive you wish to open (or after 
clicking in the About box if you opened 
an archive and nor the program it<>elf) , 
hold down the Shift key and Stuffrt w ill 
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automatica lly select all the files. decom­
press them. and save them to d isk. 
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SUITE CASE 

Getting Just The 
Applications Under The 
Menu While In MultiFinder 
If you use Suitecase and you don 't want 
to scro ll to the bottom of the Apple menu 
to see what applica tions have been 
launched, hold clown the Option key 
while selecting the menu. The DAs are 
not lis ted , and you have easy access to the 
applications list. 

mrll 
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SYSTEM 

Slimming the 
System Folder 
What doesn't belong in the System Folder? 
Many applications, DAs, fonts, sound 
files, and sometimes dictionaries, filters, 
and help files. A rule of thumb here is to 
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take out items such as prefs files or 
dictionaries if the application doesn't 
require their presence in the System Folder. 
S01netin1es the Systen1 Folder sprouts 
new files on its own. Word, for example, 
puts Word Temp files into the Systen1 
Folder. These are tetnporary files that 
Word fails to cleanup . Just make sure you 
quit the application first before deleting 
its temp files; otherwise, your Mac may 
crash. 

What does belong in the System folder? 
System files, Control Panel devices 
(CDEVs), startupdocun1ents, and Chooser 
documents (PRERs and RDEVs) all be­
long there. Also include any utility whose 
documentation specifies such placement 
or that won't work unless you place it 
there (these will mostly be !NITs). 

Consign everything else to a utilities folder 
(outside the System Folder), along with 
any of the above file types for which you 
have no present need. If you are not sure 
of a file's status, click on a questionable 
file's icon and type Command-I (Get Info) 
to bring up the file's Info box, or view the 
System Folder window as text (under the 
VIEW menu) to see if the file fits into any 
of these categories. 

Launching An Application 
From A Floppy Disk 
Without Switch-Launching 
Pressing the Option key while launching 
an application from a floppy disk equipped 
with its own System Folder prevents 
switch-launching - that is, you can con­
tinue operating under the current Systen1 
(as opposed to the floppy's Systen1-note 

that System 5.0 (and later versions) will 
not let you switch-launch from a hard­
disk drive unless you hold down the 
Option key. 

Selecting A New Active 
System Folder 
To bless or select a new active System 
Folder, hold down the Option and com­
mand keys while double-clicking on the 
Finder icon in the desired System Folder. 

Turning The Color Off Of 
Color Monitors To Speed 
Application Performance 
If your work doesn't depend on color, 
you should turn off the color display. 
Color can really cost you time in ordinary 
operations such as scrolling. The two 
main time consmners are: 

1. The cost in time required to put the 
color in, including the time needed 
to make appropriate color choices. 

2. The cost incurred in using the color 
file, which will take up more disk 
space and tin1e than a monochro­
tnatic document. 

In the Control Panel, the Control Panel 
Device (CDEV) called Monitors lets you 
adjust the number of colors your monitor 
shows. If you have 256 colors, your 
tnonitor will typically be at 2, 4, 16 or 256 
colors. 

Creating a Finder-less 
Startup Disk 
When you need to create a disk with a 
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System folder and an application. and 
want the System on the disk to be as sma ll 
as possible you may be able to get along 
without a lot of the common files listed 
above. 

One way to trim the d isk is to manage 
without the Finder. You can get rid of the 
Finder completely on a startup disk: Elimi­
nate all fo lders by placing everything o n 
the desktop and make an applicatio n o n 
the disk the startup fil e. You can do th is 
by selecting the application's icon (or 
launching it if you're in MultiFinder) and 
selecting the Set Startup option unde r the 
Special menu. When you use this Finder­
less disk, you'll see at least one Finder­
related error message that you can ignore. 

n 
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SYSTEM ERRORS 

How To Avoid Restarting 
The Macintosh During A 
System Error 
To avoid restarting your Macs if a serious 
system error occurs you can press the 
inte rrupt switch (also known as the pro­
grammer's switch) when your Mac bombs 
and typing '·G 40F6D8." This works fine 
on a Mac Plus, but not on a Mac SE or a 
Mac II. To accomplish this on a Mac SE, 
use the procedure above, replacing 
"G40F6D8" with "G409B24". If you are 
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using a Mac II . substitute "G4080D5CE" 
for "G40F6D8. ·· This method has been 
used many times to copy files from a RAM 
disk after a system error occurred. If you 
use this method however, you should 
keep in mind that a serious system e rror 
reaUy does mean serious . Your safest bet 
after copying the files is to restart your 
computer. 
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THUNDER II 

Don't Wait To Finish 
Searching Before Choosing 
A Correction 
Most people assume d1at you have to wait 
for Thunder II to finish searching through 
its voluminous dictionaries before you 
can choose the correction- but you don't. 
As soon as the word you want appears in 
the list, type the number beside it to make 
the correction. If you're certain that the 
word flagged will nor be in d1e dictionary 
(as is d1e case with names, for example), 
click on the Add to Diet. button. Thunde r 
II immediately le ts you append the word. 
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(OMPUSERVE 

Cutting Noise On 
CompuServe 
On CompuSetve, as on any other net­
work, line noise can ruin an upload or 
download. To cut out the noise, make the 
first character in each ·'typing" command 
in your macro the control character that 
says to the network , "Igno re what I've 
typed so far. " This cuts down o n prob­
le ms associated with your program's read­
ing noise input as your typing. When 
you're on CompuSetve, type Control-U. 
This tells the setv ice to ignore noise. 

GENERAL INFORMATION 

Getting Cheap Practice 
If you 're new to telecommunications, or 
are just getting to know a new telecom­
munications program, you don't have to 
pay a lot of expensive connect charges 
while you learn how to upload and 
download on networks. Conract your lo-

ca l Macintosh users' group or an experi­
enced friend and get the phone number 
of a free local bu lletin board. Practice 
uploading and downloading on the free 
network. 

Once you know your way around the 
local network, look for shareware and 
public domain libraries, where you might 
be able to download programs for far less 
than you 'd be charged by a national 
net'\;vork. 

When Call-Waiting 
Disconnects Transmissions 
If you have call-waiting and a modem, 
you can run into a lo t of interrupted 
telecommunications sessions. A little­
known trick is to add "*70'' on touch tone 
phones, or to dial 1170 on pu lse phones, 
just before the number to be dialed in 
your modem dial command. This disables 
call waiting. This tip may not work in all 
areas of the country. Ask your phone 
company for more details. 

Telephone Noise Can 
Interrupt Transmissions 
If you expe rience continued failures 
midway through transmission while us­
ing a protocol transmission, your prob­
le m could be telephone noise. Try getting 
a cleaner connection by hanging up and 
redialing. 

Disabling Internal 
Modem Speaker 
The internal modem speaker of a Hayes­
compatible modem can be temporarily 
disabled. just type ATMO from your termi­
nal program and press Return. The com-
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mane! w ill be acknowledged by an '·OK. ·· 
Turn the volume back on by typing ATMl 
and pressing Return . 

Getting Your Program To 
Wait Longer To Redial 
Many terminal programs allow users to 
change the amount ofrime that the modem 
waits for a carrier before redialing w hen 
in auto-redial mode. The command 
ATS7=x sets the number of seconds the 
program waits, w ith X= the default num­
ber o f seconds. Default value is usually 20 
seconds, but you can change it to almost 
any number less than 255 by changing the 
default value. 

IN Box 

Setting The Time On The 
Message Server 
The Mac that runs your In Box mail system 
resets all of the Macintoshes on the net­
work to its clock . So, if you are frequently 
resetting your clock, check the server 
clock. 
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MAc TERMINAL 

How To Use Cursor Keys 
Instead Of The Mouse 
If you prefer using cursor keys to mice 
while connected to a remote computer, 
hold clown Option to transform the cursor 
into a four-way, VT100-type arrow cursor 
that can be moved w here you want. Then 
click the mouse. The cursor key sequences 
will be transmitted to the remote com­
puter. 

Command Key 
Combinations 
MacTerminal 's key combinations always 
work when you're off-line; they're less 
reliable w hile you're connected. The com­
binations are: 

Command-! 1: moves the cursor back 
one space 

Command-!: moves the cursor to the 
right. stopping at the 
next tab market 

Command-j : moves the cursor down 
one line 

Command-K: moves the cursor clown 
two lines 

Command-M: moves the cursor to the 
start of the current line 

Commancl-G tells the Mac to sound a 
tone. 
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Use Hard Backspace When 
Correcting Mainframe Data 
When you're communicating with main­
frames, pressing Backspace will not cor­
rect data stored in the mainframe, even 
though it corrects your screen display. To 
remove the character you backspaced 
over on the mainframe as well , use 
Command-Backspace. 

Create Replacement Mac-To­
Mac Document 
The program supplies its own Mac-To­
Mac document with preconfigurecl termi­
nal settings. If you 've accidentally trashed 
this document, you can make a re place­
ment: 

Start by pulling clown the Settings menu 
and change the dialog boxes in Terminal 
Compatibility, and File Transfer, in that 
order. In the Terminal Settings, click New 
Line, Local Echo, On Line, Auto Repeat, 
and Auto Wraparound to On; in the 
Compatibility Settings dialog, choose 8 
bits per character, o parity, ro hand­
shake, and the baud rate the host com­
puter will use; in the File Transfer Settings 
dialog, choose XMoclem, Reta in Line 
Breaks, Word Wrap Outgoing Text, and 
Remote System equals MacTermina l. 
Leave all the other default settings, and 
save the document as "Mac To Mac." 

Avoiding System Hang 
Once in a while, MacTerminal will hang 
up after the host computer has answered 
the call. If you' re using a Hayes-compat­
ible modem, solve the problem by insett ­
ing a few conunas after the phone num­
ber. Each comma causes the modem to 

wait two seconds, allowing MacTerminal 
to registe r the fact that a connection has 
bee n made. 

MODEM 

Quiet Dialing 
If you're using a Hayes-compatible mo­
dem and don't wa nt to hea r all those 
beeps and clicks during dialing, turn off 
the speaker using the ATMO command. 
To turn it back on, type in ATMl. 

If You Can't Connect, Tell 
Your Modem to Wait Longer 
If you have tro uble connecting to an on­
line service, adjust the length of time the 
modem waits for a ca rrier signal before it 
hangs up and redials. The command 
ATS7=x sets the number of seconds the 
modem waits for a carrier. The default 
value for x is 20 seconds, but you can 
substitute a new number of seconds for x. 

When Call-Waiting 
Disconnects Transmissions 
If you have ca ll-wa iting and a modem, 
you can run inro a lot of inte rrupted 
te lecommunicatio ns sessions. A little­
known trick is to add '·*70'" on touch tone 
phones, or to dial 1170 on pu lse phones, 
just befo re the number to be dialed in 
your modem dial command. This disables 
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call-waiting. The tip may not work in all 
areas of the country. Ask your phone 
company for more derails. 

QuiCKMAIL 

QuickMail Tips 
QuickMail Power CE Software's Quick­
Mail2.0, on irs way to becoming the most 
popular electronic-mail program for the 
Macintosh, is an efficient system- espe­
cially if you use some of these hints. 
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l.Tired of scro lling through a long di­
rectoJy every time you want to send 
a message to the person at the bot­
tom of the list? An easy way to force 
names to the top of the list is to use 
QuickMail 's Group command to 
create a group for the person (yes, a 
group can have just one member). 
Groups always appear at the top of 
the directo1y list. 

2. Want to know if someone read your 
message but don 't want to be inter­
rupted by a return receipt? Select 
Preferences from rhe QuickMail 
menu and cl ick on Log Handling. 
You can then enable your Mail Log. 
A Log ently shows who has read 
each message and when. 

3. Tired of sending the standard retrac­
tion "Ignore that last message - I 

forgot ro ... "?You can un-send a 
message that hasn't yet been read by 
using the Mail Log (but only if you 
have it enabled). 

4. Is QuickMail more like SnailMail for 
you? Here's how you can speed 
things up: In the Preferences dialog 
box, uncheck "Fill folders w hen 
opening" and disable your Mail Log 
(yes, we know that the last two tips 
tald you to use the Mail Log, but 
there we were ta lking about fea­
tures, and here we're talking about 
speed). Select and file new mes­
sages before reading them ; this 
moves them from the server to your 
own hard disk , speeding up access. 

5. Want to read a message you 've filed 
on your hard disk but don't want to 
log in to a Mail Center? Use QM Re­
mote. l t can open text files as well 
as QuickMail letters you 've filed. 

6. Too busy to be bothered with open­
ing your Quici<Mail? Often, the 
substance of a message can be 
ex pressed in the title, leaving intri­
cate deta ils for the body of the mes­
sage. Fo r example, instead of 
entitling amessage "Meeting 
Reminder'' and furnishing the date 
and time in the body of the message, 
you can entitle it "Meeting 10/ 22 1 
P.M." The title then acts as an effec­
tive reminder. You get all the 
information you need just by look­
ing at the QuickMail w indow. 
(I lowever, QuickMail truncates 
long message titles to fit into the 
main QuickMail w indow.) 
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7. Wish you could attach messages to 
Apple 's Alarm Clock DA? Use Quick 
Mail to address a message to your­
self and press the Delay button to 
postpone sending it until a specified 
date and time. 

• ' ... ! ..... ~· ' 

RED RYDER 

Disabling The 
Opening Screen 
Disable the opening screen by creating a 
dummy file (such as a text fi le w ith a 
single character in it) with the name RRJ$, 
then place it in the same folder in which 
you keep Red Ryder. 

White Night, the commercial upgrade to 
Red Ryder, has a menu option to disable 
the opening screen automatica lly. 

Turning The Mac Into 
A Mainframe Terminal 
You can use Red Ryder to turn your Mac 
into a mainframe terminal. The ability to 
write procedures simplifies logging on, 
and you can use the VT100 e mulation 
mode to produce a good fu ll-screen ter­
minal. The abili ty to define macro keys 
and have thirty of them available at a 
mouse click reduces the need to remem­
ber a jumble of mainframe commands. 
Perhaps the most convenient feature of all 
is the ability to copy from the screen by 

dragging the mouse. Combine this feature 
with the Paste to Modem command, and 
an IBM mainframe can be given a substi­
tute clipboard . 

Smooth Scrolling 
in TTY Mode 
Implement smooth scrolling in TTY mode 
using Reel Ryder. Just select VT100 Mode 
from the Special menu and then check the 
Smooth Scroll Mode box. Reel Ryde r will 
now produce smooth scrolling, even in 
TTY mode. This only works with version 
9.4 or higher. 

SMARTCOM II 

Capture Routine 
Saves Only Selected Text 
If you capture data to disk after receiving 
a transmission, highlight the text you 
want to save. The Capture routine saves 
only selected text, so if you save a file with 
nothing selected, nothing is what you'll 
end up with. 

Saving Text From 
The Capture Buffer 
If you acCidentally Close your document 
w ithout having saved the contents of the 
capture buffer, don't panic - yet. Try 
reopening a communications document. 
If you didn't use the Clear command from 
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the Edit n1enu to purge the buffer before 
you closed the transn1itted docun1ent, the 
text is still in the capture buffer, and it will 
appear in the docun1ent window. This 
won't work if you accidentally Quit 
Smartcom, though. 

Save And Save As ... 
Don't Save What's 
In The Capture Buffer 
The Save and Save As ... comn1ands only 
save the settings, not the data in the 
capture buffer. 

Put Your Work Files 
At Root Level On Disk 
Some earlier versions of Smartcom (2.1a, 
for example) can't recognize documents 
or applications that are in folders on 
anHFS system. Remetnber to put your 
work files on the root level before starting 
and you shouldn't have any problerns. 
(Version 2.2b corrects the folder prob­
len1s.) 

128 

Use Different System File 
When Using Sidekick 
If you'll be using Smartcom II with Side­
kick desk accessories, replace the System 
file with a new one. Hayes removed 
sorne resources from the Sn1artcom II 
System, and this can cause operating 
probletns with Sidekick. 

Forcing Smartcom 
To Use Text Protocol 
Instead of Sending a file, Paste it from the 
Clipboard. This makes Smartcom use a 
text protocol, even if MacBinary or Hayes 
Verification protocol has been selected. 
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fULL WRITE PROFESSIONAL 

Don't Try To Print 
With The Tall Adjusted 
Option Turned Off 
What you see on-screen isn 't necessarily 
what you get printed out whe n you 're 
using an Image Writer printer. When uying 
to print across the fu ll \vidth of the page 
when the Tall Adjusted o ption is off, you 
won't get the complete data on your 
printed page. The solutio n is to always 
print with the option turned on. 

If you don't want to reset the print options 
every time you open the application, you 
can use FuliWrite's stationery documents 
to save. 

First, start a new file. Check the Tall 
Adjusted on the Page Setup dialog box, 
then do a Save As ... and click on the File 
Format button. Then select Full Write Pro­
fessional Stationety. Name the document 
"FullWrite Stationery" and save it in the 
same folder as the Fu liWri te application. 
Remember to spell "srationety'' correctly! 

When you've fin ished, evety time you 
open FullWrire or ask it to create a new 
document, it will use the ··FuiiWrite Sta­
tionery" file as its defa ult. In addition to 
any font o r style settings you want to 

reuse, the stationery document will re­
member the Tall Adjusted setting, so you 
won't have to reset it agai n. 

MAcWRITE 4.5 

Save As Text When 
You're Exporting Files 
Wh ile there are a few word processors 
that can't recognize and open MacWrite 
files (most notably Microsoft Word), in 
general you' ll find it easier to export data 
to othe r programs or via modems by 
saving it as a Text Only file. The Text fo r­
mat is easily transmissible over ASCII data 
lines, and works well whe n you're u·ans­
ferring data to other types of computers. 

Numbering Pages 
Using The Page Icon 
The page icon in the Header automati­
cally begins numbering pages at 1. You 
can change this by selecting Set Page :r ... 
from the Format menu. To eliminate the 
number on the first page, select Title Page 
from the Format menu. 

Decimal Tabs 
Override Regular Tabs 
When you drag a decimal tab on to a 
regular tab, it automatically overrides the 
tab stop and turns it into a decimal tab. 
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The tab marker may look like a regular 
tab, but it w ill behave like a decimal tab. 
To get a good look at which kind of tab 
is placed on the ruler, click on the tab 
marker or move it around to reveal w hich 
tab it really is. 

Command-Backspace 
Restores Backspaced Text 
If you w ant to restore up to 50 characters 
o f text that you backspaced over, press 
Command-Backspace. This is especially 
useful if you want to insert a word without 
taking your hands off the keyboard. 

Hidden Spaces 
Can Affect Printouts 
Jf your text doesn't print correctly after 
you've set up tabs for columns, check 
problem lines or columns carefully to see 
if any spaces w ere mistakenly entered 
there. As soon as these inadvertent spaces 
have been erased, your printouts should 
come out spaced the way you meant 
them to look. 

Lack Of Disk Space Can 
Cause Printing Problems 
You can run into trouble uy ing to print 
documents if there isn't enough space on 
the disk to save the document to the buf­
fer. Jf your disk is too fu ll to print. either 
delete some files or else transfer the docu­
ment to a less-overburdened disk. In a 
pinch, you can print a few pages at a time. 

Identifying 
Hookup Problems 
If you're getting the message that your 
document can't be printed, tty again, 

130 

watching the dialog box while the Mac 
tries to print. I f the Mac displays the 
message '·Looking for the ImageWriter/ 
LaserWriter'' for longer than usual and 
then tells you it can't print your docu­
ment, check all the connections to be sure 
the printer is hooked up correctly. 

When MacWrite Says It Can't 
Print A Document 
If you tty to print a document from the 
desktop, only ro be told tl1at you can't, 
launch MacWrire by double-clicking it. 
Then, close the new file and open the one 
you want to print. 

' 
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MAcWRITE 4.6 

Using Cursor Keys Instead 
Of Mousing Around 
MacWrite 4.6 gives you the option of 
using cursor keys instead of tl1e mouse to 
perform various functions. 

To go to a point in a text passage. just 
use the Arro\\' keys: 

To go to the beginning of a line, press 
Command-Right Arrow Key or Com­
mand-Left Arrow Key to go to the 
beginning of a line. 

To go to the bottom o r top of a page, 
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press Command-Up Arrow or Com- Numeric Keypad 
mand-Down Arrow. Commands 

There are a few keyboard commands 
To move the cursor left or right one which can be useful: 
word at a time, press Option-Right 
Arrow or Option-Left Arrow. 

To move up or down a paragraph at a 
time, press Option-Up Arrow or Op­
tion-Down Arrow. 

Select a paragraph, letter, word or page 
by pressing Shift simultaneously with 
the above instructions. 

New Keyboard Sequences 
When going from Mac write 4.5 to 4.6, 
there are new keyboard sequences. The 
most noticeable is the use of the Cursor 
Keys. 

To go to a point in a text passage, just 
use the Arrow keys. 

To go to the beginning of a line, press 
Command-Right Arrow key or Com­
mand-Left Arrow key. 

To go to the bottom or top of a page, 
press Command-Up or Command­
Down Arrow key. 

To go left or right a word at a titne, 
press Option-Right or Option-Left Ar­
row key. 

Finally, to go up or down a paragraph 
at a time, press Option-Up or-Down 
Arrow key. You can select a paragraph, 
letter, work, or page by combining 
these key combinations with the Shift 
key. 

The asterisk (C') on the numeric keypad 
helps to highlight characters and words. 
If you select a few characters with the 
n1ouse and discover that you missed a 
letter or two, the asterisk key extends 
the selection by one character for each 
press. 

Extend your selection rapidly by hold­
ing down the asterisk. 

Comtnand-* (using the asterisk from 
the nun1eric keypad) selects the entire 
line from the position of the cursor to 
the end of the line. 

Option-* (using the asterisk from the 
keypad) selects one word at a time. 
The + key causes the selection to be 
made to the left of the cursor instead of 
to the right. 

The = and I keys highlight all of the line 
above or below, up to the point di­
rectly above or below the cursor. 
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MAcWRnE 5.0 

When The Spell-Checker 
Tells You The 
Clipboard Is Too Large 
If your Mac doesn't have a lot of extra 
RAM, sometimes running MacWrite S.O's 
spelling checker might result in the mes­
sage, "The clipboard is too large to trans­
fer for use by desk accessories or other 
applications." You won't be able to use 
the spelling checker again until you quit 
MacWrite and then reopen the program 
or file you want spell-checked. 

Picking Up 
Where You Left Off 
You can zip off to the insertion point you 
last saved off at by pressing Enter on the 
numeric keypad when you launch the 
file. 
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MAcWRITE II 

Nifty Smart Quote Feature 
The new MacWrite II has a nifty smatt­
quote feature that automatically converts 
the typewriter-style single- and double­
quote marks Clike"this") to the more-pro­
fessiona l - looking curly quotes. 

What do you do if you customarily use 
special foreign quote marks (such as 
guillemets in French, Italian, and Ger­
man)? You can change MacWrite II to be 
smart in any language by changing the 
SMQT resource with ResEdit. Open the 
resource and substitute the guillemets 
(both single and double) for the curly 
quotes. The keystrokes for<< and >> are 
Option-backslash and Shift-Option-back­
slash, respectively. The keystrokes for< 
and > are Shift-Option-3 and Shift-Op­
tion-4, respectively. Close ResEdit and 
save the changes you've made. ow the 
program will smartly insert the new types 
of quote marks as you type. 
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lEACH TEXT 

Placing Pictures In Teach 
Text Documents 
To place pictures in Teach Text docu­
ments, type Option-space where you 
want the picture to appear. The pictures 
must be stored as resources of type Pier 
in the document, copied there by ResEdit. 
The first Option-space is drawn as picture 
1000, the second as 1001 , etc. Leave 
enough blank lines after the Option­
space so d1e picture does nor cover the 
following text. To make the document 
read-only, change the file type to "ttro." 
Teach Text will display additional lines of 
credits while holding down Command­
option and selecting About Teach Text. 

WoRD 

Fast Save Uses Disk Space 
Microsoft Word has a Fast Save feature , 
which lets you save files relative ly quickly 
in exchange for greater disk-space con­
sumption. 

When the Fast Save option in the Save As 
dialog box is checked, Microsoft Word 
doesn't actually delete text or graphics 
that you remove from a document; it just 
skips over them when you're displaying, 
editing, or printing the document. So, 
files do n't get smaller when you delete 
things from them, and there is more 
overhead when you add new informa­
tion. When you choose Save As and un­
check the Fast Save check box, Microsoft 
Word actually erases all the deleted infor­
mation, so the file size should decrease. 

Spell-Checking Without 
Putting The Cursor At 
Document Top 
It's possible to run your spelling checker 
on a Word document without having to 
move all the way back to the beginning. 
First, select the entire document by moving 
the cursor to the left margin, where it 
changes into an arrow, and then click the 
mouse while pressing the Command key. 
When you run your spe lling checker, the 
entire dqcument will be checked in a 
single pass, without the annoying "Con­
tinue Check from beginning" message. 

Re-spacing Between Letters 
Word creates its own "normal" spacing 
between letters, based on the type and 
size of the font you're using. The problem 
is, sometimes the spacing created isn't 
exactly what you want. 

You can fix spacing between letters by 
selecting the text you want to change, 
choosing Character on the Format menu, 
and then selecting Expanded when the 
list of options appears. The program will 
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suggest an expansion amount in the By 
box. Override this suggested spacing by 
typing in any value from . 25 to 14 points. 
As you experiment with different results, 
you'll find the re-spacing that works best 
for you. 

Hiding Outline Headings 
People who compose a lot of outlines will 
be vexed to find that most headings must 
be left out of the finished product. You 
can delete the outline headings manually, 
but in a long document this can be 
extren1ely time-consuming and can hin­
der your efforts to revise the file later. 

A solution is to use Define Styles to create 
a style sheet on which all outline styles are 
based. Its style would be the same as 
Normal Text. Using Define Styles again, 
you can define each of the subsequent 
outline styles as being based on this 
"nonnal" style by entering that name in 
the "based on" box. Now, any changes 
you tnake to the definition of the base 
style will automatically be tnade to all 
outline styles. 

When you've finished composing and 
want to hide the outline, choose Define 
Styles and add Hidden Text to the style 
definition. All outline headc;; will vanish, 
unless you select Show Hidden Text. 
When you print documents created with 
this method, be sure Print Hidden Text 
isn't selected in the Print Dialog Box. 

Using Deflne Styles To 
Create Outline Styles 
A problem with Word's outlining capa­
bilities is that there is no Hide Outline 
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Headings comn1and. Often, one wants to 
compose in an outline, but n1ost headings 
must be left out of the finished product. 
You could delete the outline headings 
manually, but this can be very time con­
suming in a long document and can also 
hinder future document revision. 

The solution is to use Define Styles to 
create a style sheet on which all outline 
styles are based. You could call this "base 
style." Its style would be the same as 
Normal Text. Again, using Define Styles, 
each of the subsequent outline styles 
should be defined as being based on this 
Normal style by entering that name in the 
Based On Box. Now, any changes made 
to the definition of the base style will 
automatically be n1ade to all outline styles. 

When you have finished con1position and 
want to hide the outline, choose Define 
Styles and add Hidden Text to the style 
definition. All outline heads will vanish 
(unless you select Show Hidden Text). 
When you print, n1ake sure Print Hidden 
Text is not checked in the Print Dialog 
Box. 

"Auto-Date" Headers 
And Footers Can Be 
Copied Or Pasted 
Anywhere In A Document 
When you paste "auto date" headers and 
footers anywhere you want in your docu­
tnent, it continues to change automati­
cally whenever you start a new docu­
ment. This is especially useful if you work 
from templates. 
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The "auto-date" can be distinguished from 
text by using the Show Paragraph com­
mand (press Command-Y), which dis­
plays a dotted outline around all "auto­
dates." 

This also works for time and page num­
bering. As an extra shortcut, try pasting 
"auto-date" into your glossary and then 
add it to your Work menu. 

Key Strokes 
For line Formatting 
In Word, the Return key is used to end a 
paragraph, while Shift- Return is used to 
end a line without creating a new para­
graph. Shift- Return works fine as long as 
it isn't used in a justified paragraph. In the 
latter case, the line created with Shift­
Return is justified - something most peo­
ple will want to avoid. And you can avoid 
it by pressing Shift-Option-Return. 

This undocumented method of conclud­
ing a line is very useful for lines within a 
justified paragraph that, for example, are 
to contain only a tnathematical equation 
located at a center tab. It's also the only 
way to create the appearance of tnultiple 
justified paragraphs within a single box. 
Simply apply the boxed format to the 
paragraph and conclude each pseudo 
paragraph within the box with a Shift­
Option-Return. The concluding line of 
each "paragraph" will not be fully justi­
fied. 

Incidentally, the Shift -Option-Return sym­
bol that appears when Show 9f is active 
looks just like the Return symbol. 

Accessing The ImageWriter's 
Bullt-In Fonts 
Word provides an easy way to access the 
In1ageWriter's built-in fonts. 

In the lower-left corner of the Word 
window is a rectangular box that usually 
contains a shadowed page nun1ber. Click 
in this box and the word Code appears. 
This invites you to type a decimal (not 
hex) character code. Press Return to place 
that character in the text. 

The decimal code for the escape charac­
ter is 27 (this appears as a small box in 
your Word document). To access the 
variety of special fonts and font sizes built 
into the ImageWriter, simply add the 
escape codes at the beginning of your 
document and, if desired, at other points 
in your document. To do this, click in the 
Page box, type 27 in the place of Code, 
and press Return. Then in the main win­
dow, right after the small box that should 
now be showing, type the letter that will 
tell the Image Writer what to do. Here's a 
partial list: 

Esc n (Extended character set = 9 cpi) 
Esc N (Pica = 10 cpi) 
Esc E (Elite = 12 cpi) 
Esc p (Pica proportional) 
Esc P (Elite proportional) 
Esc e (Setnicondensed = 13.4 cpi) 
Esc q (Condensed = 15 cpi) 
Esc Q (Ultracondensed = 17 cpi) 
Esc A ( 6 lines per inch) 
Esc B (8 lines per inch) 

When you're ready to print, make sure 
that you have Typewriter selected in the 
Chooser. Do not choose ImageWriter. 
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Condensing The Space 
Between Italicized 
Characters 
Sometitnes Word puts too much space 
between italicized words (especially if 
each word is capitalized, as in subheads 
or titles). Simply condensing italicized 
type usually results in squished type. But 
if you tum on Show from the Edit menu, 
you can select the space markers be­
tween the words and condense only them 
by using the Condense feature found in 
the Character dialog box. You can con­
dense by anything from 0 to 1. 75 points. 
After you've highlighted the first space 
mark and condensed it, go on to the next 
space mark, highlight it, and press Com­
mand-A ("Again") so you don't have to 
reenter the values in the dialog box. 

Dialog Box Command Keys 
Word allows users to substitute command 
key combinations for mousing in all dia­
log boxes. Any dialog box can be can­
celed by using Command-period. 

In The Save As ... dialog box: 
Command-S saves the file; 
Command-C cancels; 
Command-D switches drives; 

In the Open ... dialog box: 
Command-O opens the highlighted 
file; 
Command-C cancels; 
Command-D switches drives; 

In the OK or Cancel dialog box: 
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Command-O presses the OK button; 
Command-C cancels the box. 

In the Change ... dialog box: 
Command-F finds the next; 
Command-C selects Change 
Selection or Change All. 

Creating Double And Triple 
Lines In Word 
Set Below and Double borders on the 
Paragraph selection under the Format 
menu to create a double line underneath 
a paragraph. For a really interesting ef­
fect, go to the paragraph directly below 
the double-underlined one and set the 
borders for Double and Above. The re­
sults will be three horizontal lines. 

Changing Your 
Personalization Of The 
Master Disk 
Word lets you "personalize" your master 
disk by entering your name and/or or­
ganization into a dialog box. Unfortu­
nately, once you do it, all future backup 
copies will display this information in an 
Info box as soon as you open the appli­
cation. Even though Word's documenta­
tion states that your disk will be "perma­
nently marked," you can change the 
personalized information display pretty 
easily using a file editor like FEdit or 
ResEdit. First, display Word's data fork 
with FEdit. Pull down the Options menu 
and select SET EOF or SET END OF FILE. 
Then select ZERO, which eliminates 
Word's data fork. 

The next titne you run Word, it will 
pron1pt you to enter the "personal" infor­
mation again, as if you had a brand-new 
master copy. (This also works with the 
personalization screen of Excel.) 
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Finding The Next 
Occurrence Of A Format 
To find the next occurrence of a font or 
character format, put the insertion point 
within an example of whatever format 
you're searching for and type Command­
Option-Q. Word will then search for the 
next appearance of text with the same 
formatting as that around the insertion 
point and select it. 

To make using style sheets faster, you can 
add unique letters or numbers to your 
style-sheet names that let you call them 
up by these characters rather than the 
sheet's full name. 

Open the Define Styles dialog box, select 
a style sheet, type a comma after the 
sheet's name, then enter the character 
you want to use. The next time you want 
to apply this style, just type the abbrevia­
tion. 

Placing A Box Around Text 
Here are two ways to place a box around 
text while in Word. 

If the text isn't justified, select all but the 
last paragraph to be boxed and then use 
the Change command to replace all the 
paragraph markers (Ap) with line returns 
(An). This tricks Word into thinking it's 
looking at one large paragraph, so you 
can now apply whatever formatting you 
like from the Paragraph Dialog box. You 
can do the same thing with justified text, 
but to prevent partial lines from spreading 
across the page, replace the normal spaces 
with non-breaking fixed spaces (Option­
spacebar or Command-spacebar). 

For paragraphs that have different mar­
gins or indents, you can use Side by Side 
formatting to create your boxes. Insert a 
graphics box in its own paragraph above 
the paragraphs to be boxed, making sure 
that its left margin lies to the left of the text 
you want to enclose. Size the box to the 
appropriate width and length, and then 
add whatever outline formats you wish. 
Select the box and the paragraphs and 
apply the Side by Side Paragraph format. 
You can check the results in Page Preview 
and resize the box as necessary. 

Placing A Background 
Screen Behind A Paragraph 
There are times when you may want to 
accent Word paragraphs with a back­
ground screen. The following PostScript 
command, placed before a paragraph, 
will do the job: 

para. 0 0 moveto 0 1000 rlineto 
1 000 0 rlineto 0 -1 000 rlineto 
closepath gsave . 97 setgray fill 
grestore 

This instruction must be in PostScript 
style, which is one of Word's automatic 
styles and can be applied by entering 
PostScript in the Define Styles dialog box. 
The value 1000 will handle any paragraph 
up to 13 inches square, but if you want a 
smaller area, which will also print faster, 
you can pick a more realistic value by 
multiplying the number of inches by 72 
and using that result. You can adjust the 
intensity of the gray scale by changing the 
.97 next to setgray. The closer this value 
is to 1, the lighter the screen. Word con­
siders the space above and below your 
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paragraph to be part of it, so some white 
space may get filled unless you use the 
Paragraph command and set this space to 
ze ro . 

Printing Legal-Sized 
Documents On The 
Laserwriter 
You might find that tly ing to print legal­
sized Word docume nts on a LaserWriter 
results in the top two inches of text being 
cut off. The solution to the p roblem is to 
select a larger printing area . 

Just hold clown the Shift key when you 
choose Page Setup. After selecting Legal 
Size, click the Option button. Choose Lar­
ger Print Area from the Option menu. 
Your documents should print without 
any problems. 

WORD 3.0 

PostScript Code To Place 
A Border Around A Page 
He re's a PostScript seque nce that places a 
borde r around an entire page: 
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. pa9e . 
/wp$new [ newpath 36 36 
moveto wp$x 72 su b 0 rl ineto 0 
wp$y 72 sub rlineto wp$x 72 sub 
neg 0 rlineto closepath ] def 4.0 
setlinewidth wp$new stroke 

This sequence places a box with a 4-
point-wide border indented 36 points 
fro m eve1y edge. The number 72 is simply 
2 x 36. Change 36 to 72 and 72 to 144 to 
achieve a l-inch border and modify the 
number before the word setlinewidth to 
suit your needs . 

Marking A Document Draft 
If you wa nt to mark a draft Word docu­
ment to print out on a LaserWriter as such , 
insert, in PostScript style, the text below in 
a header before the normal header infor­
mation. You can also insert this code just 
before the first paragraph on each page of 
a document, but putting this into the 
heade r saves you a lot of pasting and 
formatting. And in case you need remind­
ing: to format this text in the PostScript 
style, select it, go to the Define Styles 
menu , and type PostScript . 

. page. 
/ TM {wp$y wp$top sub} def 
/ LM [wp$1eft] def 
/ RM {wp$x wp$right sub} def 
/ printline TM 100 sub def 
/ putcenter 
{dup 
RM LM sub 
exch stringwidth pop sub 
2 div lM add 
3 -1 roll move to} def 
/ AddToPath 

{ putcenter 
true charpath 
} def newpath 
/Ti mes-Bold findfont 140 scalefont 

setfont 
printline (D) 

AddToPath 
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printline 140 sub (R) 
AddToPath 
printline 280 sub (A) 
AddToPath 
printline 420 sub (F) 
AddToPath 
printline 560 sub (T) 
AddToPath 
gsave 
0.9 setgray fill 
grestore 

When you print your docume nt, this code 
will place the lette rs "DRAFT" centered 
down the page in a light gray. 

WoRD 3.01 

Numeric Keypad 
Equivalents For Mac SE 
And II Users 
Here are !>ome shoncuts for Mac SE and 
II users who work with numeric keypads: 

I re peats the last thing you d id. 

• scro lls down one line when pressed 
and released, or scro lls continuously 
when held clown. 

+ scro lls up one line when pressed 
and released, or scrolls up continu-

ously when held down. 
- extends the selection to the next oc­
curre nce of any item you ente r, such 
as characters, paragraphs, number 
signs, bullets, e tc. 

= finds the next Search Ite m, even if 
you've cancelled the Find dialog box. 

0 returns the cursor to its last three 
locatio ns, o ne location for each press 
of the button. 

5 returns to the regular screen from 
Page Preview. 

Shortcuts When 
You "Save As .•. " 
There are a number of keyboard shortcuts 
you can take if you 'cl rather work through 
the keyboard than the mouse: 

Command-S saves the file. 

Command-£ ejects the disk. 

Commanci-C cancels the dialog box. 

In the Delete dialog box, the same com­
mands work, except that Command-S 
activates the De lete command. 

Using MacDraw To Convert 
Typed-In Capitals To 
Lowercase Letters 
Word can't convert text that was typed in 
capitals into lowercase letters . Pressing 
Command-Shift-K toggles berween text 
"as typed"' and all uppe rcase, but it doesn't 
convert text initially typed as capitals into 
lowercase letters. Also, the capita lizing 

139 



WORD PROCESSING 

e ffect can't be used in a document saved 
as "Text O nly. " The re 's a work-around to 
this problem if you have a copy of 
MacDraw: 

Text copied from Word can be pasted into 
MacDraw. Then, select the pasted text 
while in MacDraw, and choose Lower­
Case from the Style menu. Then, copy the 
text and paste it back into your Word 
document. The text will now be perma­
ne ntly saved as uppercase le tters .. . even if 
you save the document as Text Only. 

Using Uppercase 
Commands When You're 
Using Capitals In A 
Document 
If a large amount of your docume nt is 
going to be typed in capital letters, use the 
All Caps character format (Command­
Shift-K) instead of the Caps Lock key. 
This lets you check your text fo r spelling 
erro rs without deselecting the default 
Ignore Words in All Caps setting, and also 
lets you change the text back to normal 
lowercase fom1at (including proper nouns, 
as lo ng as you remember to Shift when 
you type) by removing the All Caps 
selection . 

Creating Structured 
Footnotes 
The footnote command may be very 
useful, but if you try to create scientific 
structures such as " ... can be fo und in 
several review anicles 1-12" it can be a 
trying experience. You can work around 
this limitation by using Word's hidden 
text feature. 
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While typing a manuscript, use the foot­
note command to enter all of the foot­
notes. Separate the first and second foot­
note numbers with a hyphen or an em 
dash, and then separate the rest of the 
footnotes w ith commas. This creates a list 
of reference marks that display as " ... can 
be found in several review articles 1-2, 3, 
4, 5, 6, 7, 8, 9,10, 11, 12." 

1 ext, select the second through the next­
to-the-last numbe rs, including the last 
comma (in this example, 2-11). Format 
the selection as Hidden text, using the 
Character command in the Format me nu 
o r by typing Comma nd-Shift-X. The 
modified sente nce displays and prints as 
'· ... can be found in several review articles 
1-12" when the Show Hidden option in 
d1e Edit Preferences dialog box is not 
selected. 

Creating A Solid Underline 
When using Word to create a form, you 
can't rely on using a series of typed 
underline characters to create a solid line. 
Some fonts show the line on-screen as 
being solid, but when you print them out 
the results will be far less even. To make 
a solid line that stays solid when you print 
it out, set Underline as your style and then 
type in blank characters with the space 
bar. If you press the Command key while 
typing, you'll create "hard'' spaces, which 
the program will keep on the same line. 

How To Keep 
Outline Entries Intact 
When an outline is renumbered , so are 
entries that start with numbers. A work­
around is to choose Styles from the For-
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mat menu to set the font for your various 
outline levels to some font that doesn't 
use the square sytnbol (the one you get 
when you press Option-H). Palencia is 
one such font. 

Every time you type a number which 
starts an entry in the outline tnode, pre­
cede the number with the Option-H 
square. When you renumber and leave 
the outlining window, the square charac­
ters will disappear. 

This allows your outline to print, and you 
won't lose any of the data or text you 
entered. 

Copying Parts 
Of A Style Sheet 
It's possible to copy one or just a few 
styles from one Word document's style 
sheet to another, without bringing in the 
entire style sheet. First, open the docu­
ment that contains the style(s) you want 
to copy. Select a paragraph that's forn1at­
ted in that style (to copy several different 
styles, copy a series of paragraphs). 

Now, open the docutnent to which you're 
going to copy the styles, and paste the 
paragraphs into the style sheet. The new 
styles are now a part of the old style sheet. 
So now, you can delete the text you 
pasted in, and the styles will remain in the 
document. 

Spell-Checking Around 
Ligatures 
If you use a lot of fi and flligatures in long 
documents, you'll save time n1nning the 
spelling checker by replacing the charac-

ter pairs "fi" and "fl" with the ligatures 
AFTER the spell-checking is completed. 
The spelling checker can't recognize liga­
tures as alphabetic characters, and you 
can't add words that contain then1 to your 
dictionary. So, if you put the ligatures in 
before running the spelling checker, the 
program regards any retnainder of a liga­
ture word to be tnisspelled - unless the 
remainder happens to n1atch a word in 
the Main dictionary. 

After the spelling checker has finished 
running, go to the start of the document 
(Cotnmand-Keypad 9), open the Change 
dialog box (Command-H), set the re­
placetnent parameters, select Match 
Upper/Lowercase, and click Change All. 

Avoiding Disk-Swapping 
Hassles 
A lot of people use several different docu­
ment disks during a single work session. 
If you do, and you work on a floppy disk­
based systen1, you can avoid a lot of disk­
swapping by double-clicking on the Word 
application, instead of a document, when 
you start working. 

Correcting Pagination 
Problems With Serial 
Printer Drivers 
When you use the serial printer driver 
with either a 12- or 15-pitch printer, you 
tnust first set the line spacing for all 
paragraphs, or the pagination will be 
incorrect. When you create a new docu­
tnent, first go to the Paragraph dialog box 
under the Format rnenu and set the line 
spacing to 12 points instead of the default 
spacing, "auto." 
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If you are having problen1s printing an Just ren1ember to redefine your Graphics 
existing document, select the entire text style by cancelling the Hidden character­
and then go to the Paragraph dialog box istic before you print or repaginate. 
and do the procedure described above. 

Twelve is the proper setting to e1nulate a 
single-spaced typewriter which produces 
6 lines per inch. To en1ulate other spac­
ing, set a value of 72 divided by the 
nun1ber of lines per inch. 

Pasting Some Graphics 
Can Cause Problems 
When pasting a graphic from an object­
oriented program (such as MacDraw ), 
you might experience some problems if 
the graphic's rightmost elen1ent is a verti­
cal line. To get the line to appear, place 
a non-printing character, like a space, just 
to the right of the line. The character 
won't show up when you print the docu­
ment, but Word will no longer think that 
the line is the righttnost object on the 
screen, so it will allow the entire drawing 
to be pasted in. 

Speeding Up The Graphic 
Redrawing Routine 
Word can take what see1ns like forever to 
redraw a cotnplex graphic, especially one 
that has had smoothing activated for its 
curves. You can avoid this by creating a 
special Graphics style for each graphic, 
and including Hidden as one of its char­
acteristics. Make sure that your Prefer­
ences setting has Show Hidden Text set to 
Off. Now, you'll be ahle to quickly scroll 
through and edit text in the document, 
without having to wait forever for graph­
ics to redraw. 
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Code-Replace Capability 
Comes In Handy When You 
Import Text 
A little-known Word feature is an ASCII 
code search-and-replace capability that 
c01nes in handy when you use Word to 
edit and refonnat text files created on an 
MS-DOS-based c01nputer. To find a par­
ticular ASCII code within a Word docu­
ment, type a caret (Shift -6) followed by 
the decin1al value of the ASCII code in the 
Find What dialog box. 

Here's an exan1ple, based on a typical PC 
text file itnported into a Mac environment: 
First, select Change from the Search Menu 
or type Con1mand-H. 

Then, replace the double carriage-return 
I line-feed (CR/LF) pairs at the end of 
each PC text paragraph with a special Mac 
character as follows: 

Click the I-bean1 to the left of the first 
character in the file. In the Find What box 

' type /\13/\10/\13/\10 (13 is the decimal 
value of the ASCII carriage-return code; 
10 is the decimal value of an ASCII line 
feed). 

Now, in the Change To box, type Option­
S to get a bullet or another special Mac 
character not used in the file. Click Start 
Search or Change All to make the changes. 
Then, replace the CR!LF codes at the end 
of each line within paragraphs with a 
space: With your insertion point at the top 



WORD PROCESSIN~ 

of the document, enter "13/\10 in the Find 
What box; in the Change To box, type one 
space; and then click Start Search or 
Change All. 

Finally, go back and replace the special 
Mac character (like the bullet) you used to 
mark the end of PC text file paragraphs, 
with a Return. First, click the I -beam at the 
top of the file. In the Find What box, type 
a bullet (or whichever special character 
you used). In the Change To box, type "P 
(a caret followed by a lowercase p repre­
sents a Word Return character). Click Start 
Search or Change All as you did before. 

You can also use this ASCII code search 
feature to fix PC word-processing docu­
ments within Word. For example, some 
PC documents contain normal text with 
only occasional ASCII control codes (such 
as decimal value 12 for form feeds or 9 for 
tabs). Use FEdit Plus or another file edit­
ing utility to examine the codes in the PC 
document, and then use the technique 
described above to search for and delete 
these codes within Word. For a complete 
list of the decimal values of all ASCII 
codes, see the Appendix of the Word 
manual. 

As it happens, you can also reverse this 
process. You can replace Return charac­
ters in a Word text file with ASCII CR/LF 
codes. This allows you to create files that 
PC friends and co-workers can use. 

Of course, only perform the search func­
tions on a backup copy of your file, just 
to be on the safe side. 

Printing Long Documents 
With Page Numbers 
The Word tnanual describes a rather in­
volved procedure for people who need to 
print long documents (n1eaning docu­
ments con1posed of several Word files) 
that have page ntnnbers. One particularly 
annoying hoop you have to jump through 
is having to repaginate each part of your 
document, finding out what its last page 
nun1ber is, and then having to set up the 
next file so that it starts with the next page 
number. 

There is a work-around to this situation. 
Choose Page Setup for each file, and type 
the file nan1e of the next file, as the 
tnanual says. Then, WITH THE EXCEP­
TION OF THE FIRST FILE of the set of files 
composing the docun1ent, blank out the 
Start Page Numbers At box. That is, leave 
a 1 in the Start Page N un1bers At box for 
the first file, and erase the 1 in that box for 
all the other files. Now, reopen the first 
file of the document and tell the Mac to 
print. 

The entire document will print out with 
the right pagination, without your having 
had to repaginate each file. 

This only works if you begin printing with 
the first file of the series. If you print a file 
that appears in the n1iddle or end of the 
set of docun1ent files, you'll have to 
follow the instructions in the Word man­
ual. 
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Cleaning Up Returns In 
Print Merge Documents 
When creating a list of nan1es or ad­
dresses, for example, for print-merging in 
Word, making sure you have appropri­
ately "Commanded" and "Shift-Returned" 
each and every set of data can be unnerv­
ing. (Remember a Return is only entered 
at the end of each record, while a Shift­
Return may be used for arranging the data 
more logically.) To eliminate most of the 
problem, you can use the Document Re­
number command to nun1ber each set of 
data which isolates the entries with just a 
Return instead of the desired Shift-Return. 
Where you find the erroneous Retutn, put 
the cursor in front of the entry and press 
the Delete key, then press Shift-Return. 
Using the Document Renumber com­
mand also lets you know just exactly how 
many names or addresses you have. 

Changing The Length Of 
Word's Menu Titles 
You can't change Word's menu titles to 
something less verbose with a utility such 
as ResEdit, because Microsoft doesn't use 
tnenu resources. So, use a file editor such 
as FEcHt and perform an ASCII Search for 
the capitalized word "Document." This 
reveals the program area where the names 
of menu titles are stored. Each title is 
preceded by the length of the title. For 
exan1ple, change the 8 in front of "Docu­
nlent" to 3, then issue the con1n1and 
WRITE SECTOR. That's it. Using this tech­
nique, you can cotnpletely rename or 
shorten Word's menu titles. If you rename 
titles, n1ake sure your new titles are no 
longer than Word's old ones. 
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Finding The Missing Comma 
in Data Record 
The easiest way to find a missing comma 
in a data record, while doing a Print 
Merge, is to select the New Doclllnent 
button in the Print Merge window. This 
creates a document on the screen. When 
you come across the "Missing Comtna in 
Data Record" dialog box, quit the Merge 
and scroll the document to the last record. 
The next record in your data file is the one 
with the probletn. Once you have a 
successful Merge to the screen document, 
select Print and you are assured of print­
ing the entire batch successfully. 

One Way To Count Words 
Here's one way to count words in Word 
3.0 and 3.01. 

Make a copy of your document and use 
that, as this procedure will change the 
document. Select Change fron1 the Search 
menu. Enter w (the white spaces) in the 
Find What box and n (end-of-line marks) 
in the Change To box, then choose Change 
All. When this operation is complete, 
you'll find the number of changes (which 
is very nearly the nun1ber of words) in the 
lower left corner. 

If, by mistake, you do this on your original 
docun1ent, all the words will be arranged 
in a column. Save the situation by closing 
the docun1ent and clicking No when the 
dialog box asks if you want to save the 
changes. 
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How To See The Size Of A 
File Without Returning To 
The Finder 
Here's a good way to see how big (in K) 
your Word 3.0X files are. This method 
works without having to return to the 
Finder. 

Start by saving the document. Then close 
its window and choose Delete from the 
File menu (if you don't see Delete, that 
means you're in Short menus and must 
change to Full or Normal menus). Select 
the document you wish to see the size of 
from the list. The size will be shown 
under the buttons. This size is rounded 
down to the nearest kilobyte. (That's dif­
ferent from the Finder, which displays the 
size to the nearest K rounded up; and Get 
Info, which shows the exact size in bytes. 
Here's an example: The file is actually 
9728 bytes long. Get Info will show that 
number or 9.SK; the View option of the 
Finde r will show lOK; and the Delete 
dialog will show 9K.) Remember to hit the 
Cancel button afte r you check the size. 

When You Get The "Missing 
Comma In Data Record" 
Error Message 
Word's Print Merge capability requires 
that you separate field names with com­
mas or tabs. Unfortunately, when you ac­
cidentally omit o ne, the program simply 
puts up an error message, without telling 
you whe re your comma might be missing. 
Instead of going through each and evety 
record you're working with, you can use 
this shortcut: 

Count the number of commas in the 
header record , and then use the Change 
command to systematically isolate the 
record that's missing a comma. You do 
this by e ntering a comma into both the 
Find What box and the Change To box. 
Then select sections of records and statt 
searching. 

~ord counts the number of changes that 
tt makes, and puts that number into the 
lower left corner. If the number of 
changes is not evenly divisible by the 
number of commas in the header record 
you know that the defective record i~ 
somewhere in the records you just se­
lected. If the number is evenly divisible, 
you can move on and select another 
section. Continue this process until you 
nar:row down the data records sufficiently 
to rsolate the one or more records with 
missing commas. 

WoRD 3.01 

Accessing Help Fast 
You don't have to d ig out your manual 
evety time you need he lp, if you have 
Apple's Extended Keyboard. The key, 
labeled "Help,·· is right under d1e F13 key. 
When you p ress it, you'll see a question 
mark appear. This is your cursor. Move 
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it to w hatever you want explained , in­
clud ing menu choices, and then just click 
the mouse for the help you need. 

I f you don 't have the Extended Keyboard, 
press the Command key and and the? key 
to get the question cursor. 

Word Features Not 
Appearing In The Menus 
Word 3.01 has several features that are 
only accessible through the use of special 
key combinations. These features nor­
mally never appear in menus. Yet, work­
ing with the program vvoulcl often be 
simpler if they did. 

Let's take the example of Insert Page­
Break. The only way (normally) to access 
this feature is to type Shift-Enter. Here's 
how to make th is feature a menu cho ice. 
Start w ith a blank document. Be sure you 
arc in Full Menus mode. Type Shift-Enter 
to produce a forced page break. Select the 
cloned line that results by clicking in the 
Selection Bar (the column at the left o f the 
screen w here the cursor points northeast 
instead of northwest). Then choose Glos­
s~uy from the Edit menu. Type in a de­
scriptive name, such as "PageBreak ," and 
click on the Define button. ext, press 
Option-Command-+ (plus sign) and click 
on the name Pagebreak in the glossa1y 
list. A Work menu w ill be created (or 
added to . if you already have one), in 
which the new glossaty entty will be 
found. Now w henever you want to insert 
a page break, just go to the Work menu 
and select one. 

This method will work w ith the orher key 
combinations \XIo rd forces you to memo-
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rize. These include: Section Mark, Com­
mand Enter, End-of-Line Mark, Shift-Re­
turn , Optional Hyphen, Command­
(hyphen), Non-breaking Hyphen, Com­
ma ncl--(tilcle). 

WORD 3.02 

Repaginating Without 
Crashing Using Word 3.02 
And The Laserwriter II SC 
Opening a document in Word 3.02 and 
then doing any procedure which repagi­
nates the text causes a Bomb message 
and a crash. 

To correct this, select the Laser Writer II SC 
driver using the Chooser evety time you 
open Word. Do this even if the Laser­
Writer II SC driver is the only one in the 
System folder, and it's already been cho­
sen while you were in the Finder or 
another application. Once you·vc chosen 
the Laser\Xfriter II SC \Vhile in Word 3.02, 
you·ll be able to switch applications and 
print with no further problems. 

Swapping Adjacent 
Paragraphs 
Want to swap the positions of two adja­
cent paragraphs quickly, without using 
multiple executions of Cut, Copy, and 
Paste? 
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Highlight the paragraphs and check the 
alphanumeric position of the tlrst word in 
each paragraph. Then use the Sort con1-
n1and (Word will sort in ascending order) 
or Shift-Sort (descending order) accord­
ing to the alphanumerics. With a little 
forethought, you can figure out how to 
move two paragraphs around a third 
paragraph that separates them. You can 
also install n1arkers at the heads of as 
rnany paragraphs as you wish to rear­
range. 

Use Sort and ren1ove the markers when 
you're finished. The variations of Sort are 
endless once you get the hang of this 
useful and underused tool. . 

Bonus Disk 
Word 3.02 and above c01ne with a Bonus 
Disk, with aDA called Word-Finder. The 
thesaunts only works with Word or the 
Finder- it only functions if the informa­
tion in the About... box of the active 
application says "About Microsoft Word ... ", 
"About MS Word ... ", "About Word ... ", 
"About Finder ... ", or "About DAs ... ". 

Using ResEdit, you can custotnize Word­
Finder to work with any application that 
has a MENU resource. First, open ResEdit 
and then open the desired application. 
Open the application's MENU resource 
and open MENU ID= 1. Change the first 
menu iten1 to "About Word ... " (with three 
periods!) and save your changes (see 
Figure 3). WordFinder can now provide 
you its riches in the modified program. 

Using The ASCII Code 
Search-And-Replace 
Capability 
Microsoft Word 3.02 and above have an 
ASCII code search-and-replace capability 
that can come in handy when using Word 
to edit and reforn1at text files created on 
an IBM PC or PC clone. To find a particu­
lar ASCII code within a Word document 
type a caret (Shift-6) followed by th~ 
decimal value of the ASCII code in the 
Find What dialog box. Here's how to use 
this feature to fix a typical PC text file 
in1ported into the Mac environment 
(always work on a backup copy of the file 
you wish to convert): 

1. Select Change from the Search Menu 
( Cotnmand-H). 

2. Replace the double carriage-Return 
I line-feed ( CR/LF) pairs at the end 
of each PC text paragraph with a 
special Mac character as follows. 
Click the I -bean1 to the left of the first 
character in the file. In the Find 
What box, type A13A10A13A1QA (13 
is the decin1al value of the ASCII car 
riage-return code; 10 is the deciinal 
value of an ASCII line feed). 

3. In the Change To box, type Option­
S for a bullet ( •) or another special 
Mac character not used in the file. 
Click Start Search or Change All to 
n1ake the changes. 

4. Now, replace the CR/LF codes at the 
end of each line within paragraphs 
with a space: With your insertion 
point at the top of the document 
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enter " 13"10 in the Find What box; 
in the Change To box, type one 
space; and then click Start Search or 
Change All. 

5. Finally, go back and replace the 
special Mac characters (used to mark 
the end of PC text file paragraphs) 
with a Return. First click the I-beam 
at the top of the fil e. In the Find 
What box, type a bullet (or whatever 
special character you used). In the 
Change To box, type " P (a caret fol­
lowed by a lowe rcase p represents a 
Word Return character) . Click Starr 
Search or Change All as before. 

You can also use this ASCII code search 
feature to fix PC word-processing docu­
ments within Word . For example, some 
PC documents contain normal text with 
only occasional ASCII control codes (such 
as decimal value 12 for form feeds or 9 for 
tabs). Use FEclit Plus or anothe r Mac file 
editing utility program to examine the 
codes in the PC document, and then use 
this technique to search for and delete 
these codes w ithin Word. For a complete 
list of the decimal values for all ASCII 
codes, see the Appe ndix in the Microsoft 
Word manual. 

By the way, the reverse of this process 
works as well. You can replace return 
characters in a Word text file with ASCII 
CR/LF codes. This allows you to create 
readable text files for your PC frie nds and 
customers without leaving your Mac. 
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Making Word Finder Work 
With Any Application 
Word 3.02 and above come with a Bonus 
Disk, with a DA called Word Finder. The 
thesaurus only works with Word or the 
Finder- it only functions if the informa­
tion in the About.. . box of the active 
application says "About Microsoft Word ... ", 
"About MS Word ... '·, "About Word ... " 
"About Finder ... ", or "About DAs .. . '· . 

Using ResEdit, you can customize Word 
Finder to work with any application that 
has a MENU resource. First, open ResEdit 
and then open the desired appliq tion. 
Open the applications ME U resource 
and open MENU ID=l. Change the first 
menu item to "About Word ... " (with three 
periods!) and save your changes. Word 
Finder can now provide you its riches in 
the modified program. 

WoRD 4.0 

The Word Screen Saver 
Ordina1y screen savers may dim your 
screen or offer fireworks and clock dis­
plays, but in Word 4.0, there's an ani­
mated display that is quite beautiful in 
color. Select Commands from the Edit 
menu and choose Screen Test from the 
list of commands in the dialog box. Click 
on the Do button. If you click once while 
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the images are dancing across the screen, 
a dialog box will let you customize the 
display or cancel it. 

Smoothing The Transition 
From Word 3.0 To Word 4.0 
1. Word 3 and Word 4 can coexist on the 
same hard disk, each with its individual 
preferences file in the Systen1 folder, but 
we recommend against keeping the old 
version on-line. Docutnents have the same 
creator and type IDs in Word 4 and Word 
3, so keeping track of document versions 
can get very confusing. If your Word 4 is 
sensitive to errors in its preferences files, 
however, and it might be a good idea to 
erase the "Word Settings (4)" file in the 
System folder and redefine your prefer­
ences if the application is bombing. 

2. It's easy to move your personal style 
definitions from Word 3 to Word 4. Sim­
ply go into Word 4 and select Define 
Styles. Then use the Open menu item to 
open a Word 3 file, which tnakes all its 
styles available. Any styles you want to 
keep in Word 4 can he saved with the Set 
Default button. 

3. Word 4 retains the ability to deal with 
any ASCII characters, invisible or other­
wise, by specifying their numeric equiva­
lents. In the older version, you could find 
the value for a selected character by 
clicking on the page number at the lower 
left corner of the screen. In the new 
version, Command-Option-Q is the only 
way to show the numeric equivalent. 

4. Word docun1ents that are "fast-saved" 
cause problems for Working Software's 
Spellswell spelling checker and may be 

troublesome for other applications that 
try to convert then1. There is a clever 
work-around, however, that allows you 
to change Word's default format fron1 Fast 
Save to norn1al. Use Word 4's Con1mands 
menu to add Fast Save Enabled to a menu 
such as the Edit menu. Once it is on a 
menu, you can select it to uncheck it, and 
it will retnain off until you specifically turn 
it on again. 

5. Finally, for a little fun, select About 
Microsoft Word... , then click on the 
Word icon while holding down the Com­
mand key. 

Creating Tables With 
Varying Column Widths 
The Insert Table con1mand in Word 4.0 
only lets you create a table with columns 
of equal width. Ordinarily, you have to 
struggle with the colurnn markers across 
the ruler to vary the column widths, but 
there is a shorcut that n1akes it easy: 

1. Say you're creating a three-column 
table with one narrow column on 
the left for labels and two wide col­
umns to the right for entries. As you 
create the table, enter 5 in the Number 
of Columns box. 

2. Select all the cells in the second and 
third columns by holding down the 
Option key while dragging the mouse 
over these colun1ns. 

3. Choose Table fron1 the Edit menu 
and select the option for n1erging the 
tow columns. Repeat this procedure 
with colmnns 4 and 5. 
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You now have a three-colun1n table. To 
get a narrower first column and wider 
entry columns, just increase the number 
of columns in the table by a factor of 2. 

Creating An 
On-line Hints Menu 
Word users have been inundated with 
docutnentation, help files, and third-party 
books discussing all the progratn's intri­
cate features. Trying to keep track of all 
this information in its present state is 
tnind-boggling but worth the effort. 

To have this infonnation literally at your 
fingertips, create a file natned Hints in 
which you store a personalized set of 
con1tnands, shortcuts, and tricks that you 
want to keep at your fingertips. Give this 
Hints file menu-bar status by adding it to 
the Work tnenu. Press Conlmand-Option­
+ (plus syn1bol). When the cursor turns 
into the plus symbol, click on your Hints 
document, either in the Open dialog box 
or in its title bar (if it is the active docu­
ment). 

Word will create a Work tnenu on the 
right-hand side of your menu bar or add 
your Hints docUinent to an existing Work 
tnenu. 

Launching MacWrite 
Documents With Word 
Whenever you double-dick on a plain­
text MacWrite document (such as the 
docUinentation files you download fre­
quently from bulletin boards), it won't 
open unless you have MacWrite on your 
disk. As a lot n1ore people use Word 4.0 
than Mac\Xfrite, here's a way to make 
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Word 4.0 auton1atically open those 
MacWrite documents in its own format 
when you double-click on then1. 

First, make a backup copy ofMacWrite (if 
you have it installed) on a floppy and then 
delete it from you hard drive. 

Next, tnake a duplicate copy of Word 4.0 
on the hard drive and rename it Mac Word. 
By using ResEdit, you can change the 
Creator of Mac Word from MSWD to MACA 
(highlight MacWord and choose Get Info 
from the File menu). Make the changes in 
the Creator box. 

Now, when you double-click on a 
MacWrite document, MacWord will launch 
and the document will be converted 
automatically. 

Quickly Adding Fonts To 
Word's Font Menu 
If you need to add font names to Word 

4.0's Font menu, pressing Command­
Option-+ each time can get tedious in a 
hurry. Here's a fast, undocumented way 
to add all the currently installed fonts to 
your menu. 

Choose Commands from Word's Edit 
menu, and choose List All Fonts from the 
list of cotnmands. Then click on the Do 
button. 

The n1enu bar will flash as Word adds 
suitcase fonts one at a time to the Font 
menu. 
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A Patch For Fractional Font 
Widths On lmageWriters 
If you do not own Adobe Type Manager, 
and you are using Microsoft Word, there 
is a patch- a set of n1odifications to Word 
- that allows for fractional font widths on 
Image Writers. It's called WORD4MOD.SIT. 
Ot should be available fron1 the usual 
shareware outlets such as user-group 
libraries, BBSs, and so on. On Con1puS­
erve its's called WORDMO.BIN in the 
Macintosh Productivity Fonm1's word­
processing library.) 

Installing the patch requires fan1iliarity 
with ResEdit (available fron1 the same 
outlets). Obligatory ResEdit warning: 
Never use ResEdit on an original or n1aster 
of anything. Always work on a copy. And 
don't forget to lock your n1aster disks. 
That way, if you happen to make a 
mistake and dan1age son1ething, you can 
always make a fresh copy from the n1aster 
disk. 

Recovering Word 
Temp Files 
Before you save a Word docUinent, Word 
sets up a temporary file and places it in the 
System Folder. If your system has crashed 
and you want to try recovering a Word 
Temp file, you can try opening it by 
holding down the Shift key and choosing 
Open Any File from Word's File menu. 
That should enable you to open the Ten1p 
file (try the one with the highest nunlber). 
If you want to, you can add the Open Any 
File command to your rnenu pennanently 
by using Word's corntnand option, which 
you'll find on the Edit n1enu. 

Kerning With The 
Displace Command 
Microsoft doesn't mention kerning any­
where in the Word manuals, but you can 
do ntdirnentary kerning with the Displace 
Command. To kern two characters: 

1. Choose Show 9f fron1 the Edit menu. 

2. Place the cursor between the two 
characters you want to kern. 

3. Press Option-Cotntnand-backslash 
and then type the letter D (the 
forn1ula code for Displace). 

4. Press Option-Comrnand-backslash 
again, and then type the letters BA 
(the fonnula code for Backward). 

5. Enter the nun1ber of points to kern 
(in whole points). 

6. Follow this with both open and dose 
parentheses ( ) to end the forn1ula. 
The code you see on-screen should 
look like this: \d\ ba3 ( ) (using3 
points as an example). 

7. Choose Show again or print your 
text, to see the difference in spacing. 
If you save this formula as a Glossary 
itern, you'll have to enter it only 
once. 

Inserting The Date 
Into Documents 
Word lets you insert the date into docu­
n1ents through its Commands dialog box, 
but you're stuck with its date formats, 
which include the day of the week (ex-

151 



WORD PROCESSING 

cept for the short format- for example, 3/ 
31/89). If you want a date such as March 
31, 1989, you'll have to suppress the 
weekday in the Systen1 file with ResEdit 
1.2. (Try this on a copy of your System file 
before you change your working System 
file.) 

1. Open the Systetn file and scroll 
down to itll. 

2. Open it11. Select it11 US" ID=O and 
open it. 

3. Next, click on the Suppress Day box 
(see Figure 2). 

4. Close ResEdit and save the changes. 
Open a Word document. To get the 
date, make sure you're using Full 
Menus and select Glossary fron1 the 
Edit menu. You'll see the following 
date entries: date - now - abbrevi 
ated, elate - now - long, and date -
now- short. 

Select either the long or the abbreviated 
format and click on Insert. The date will 
appear either as March 31, 1989, or as 
Mar. 31, 1989, respectively. 

Using Insert Graphic To 
Speed Printing Thne 
Inserting a graphic in a word-processing 
document can significantly increase print­
ing tilne. Here's a trick for trimming your 
printing tin1e on working drafts and proofs. 
Measure the illustration's height (many 
object-oriented draw programs have a 
Show Size option). Insert the graphic into 
a Word document. With the graphic se­
lected, choose Paragraph from the For-
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mat menu. Type a n1inus sign in the Line 
Spacing box and then enter the graphic's 
measurement. The minus sign adjusts the 
paragraph's height to match the size of 
the graphic. 

Select the graphic again, choose Charac­
ter from the Fonnat menu, and format the 
graphic as hidden text. When you print 
draft doctnnents, he sure Print Hidden 
Text in the Print dialog box is not se­
lected. The illustrations will he replaced 
by an appropriate amount of white space, 
and you'll know where your page breaks 
are. When you're ready for the final ver­
sion, recheck Print Hidden Text, and the 
graphics will print properly. 

Inserting PostScript Code In 
A Word Document 
Placing bits of PostScript code (or even 
lengthy routines) into a Word document 
is simple. But Word requires that you first 
clearly define what part of the page will 
be affected by the PostScript code. Is it 
going to affect the entire page (for ex­
ample, a box enclosing the page) or just 
a paragraph or inserted graphic? 

You define the boundaries by inserting a 
group comn1and in1mediately before the 
page element it will affect. In Word 3.02, 
you could use three such con11nands: 
.page., .para., or .pic. (referring to the 
entire page, the next paragraph, or the 
next graphic insertion). Version 4.0 has 
added .cell. and .row. to facilitate Post­
Script manipulation of tabular n1aterial. 

1. Group Commands - Group cotn­
mands create a drawing rectangle that 
specifies the overall size of a PostScript 
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graphic. The actual din1ensions of the 
graphic never have to be entered, be­
cause the con1mand gathers this informa­
tion from Word it'ielf. The drawing rec­
tangle created by .page., for exatnple, is 
determined by the page size you've speci­
fied with the Page Setup comn1and. If 
your page is 5 x 7 inches, the drawing 
rectangle mirrors those tneasuretnents 
exactly. Most other group con1n1ands, 
such as .p a r a. and .p i c. let you focus 
on increasingly smaller or n1ore precise 
areas of the page - a paragraph, or a 
graphic frame within a paragraph. 

After the group cotnn1and is entered, you 
can enter PostScript code you've written 
or copied frotn another source. Here's a 
simple example that places a 5 x 7 -inch 
box on a page. At the top of the page, type 
the following: 

.page. 
newpath 
.25 setlinewidth 
126 144 moveto 
360 0 rlineto 
0 504 rlineto 
-360 0 rlineto 
close path 
stroke 

Anyone with PostScript savvy will notice 
some peculiarities here. The prin1aty one 
is that the PostScript inclusion hasn't been 
bracketed by a save /restore or gsave/ 
grestore pair, which prevents certain 
PostScript operators (rotate, for example) 
from changing the graphics environn1ent 
of the entire page. Why this apparent 
breach of PostScript etiquette? Because 

the group comn1ands automatically 
bracket each grouping of PostScript code 
with a save/restore couplet. 

You might also notice that the origin point 
(0 0) in Word's version of the PostScript 
coordinate systen1 corresponds exactly to 
that found in PostScript itself. This means 
that the origin point (0 0) is found at the 
lower left corner of the current drawing 
rectangle, whether it is a page, paragraph, 
or graphic frame. 

2. Creating Global Commands- When 
PostScript requires specific measures or 
positions that can't be referred to through 
the built -in variables, the dimensions are 
expressed in points. If you feel more 
con1fortable working in inches, simply 
place the following code after a group 
con1n1and such as .para. or .page. (and, 
of course, format it in Word's PostScript 
Style): 

/inch (72 mul} def 

Then you can use code such as I inch 1 
inch n1oveto instead of 72 72 moveto. The 
routine you've inserted automatically 
n1ultiplies the inch units by 72, converting 
them into PostScript's point systetn. 

Ordinarily, such a routine applies only to 
the drawing rectangle indicated by the 
group comn1and. So if you had a .page. 
and several .para. PostScript groups on 
the same page, you would have to insert 
/inch 172 mull def in each group. When 
Word scans the page for PostScript, it 
does each group in turn and discards the 
variables or routines of that group as soon 
as it has been processed. Even routines or 
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variables placed after the .page. coin­
mand can't be used by other groups on 
the san1e page. 

3. Executing The PostScript Code - If 
you print the document now, you won't 
n1agically have a PostScript-generated box 
on the page. The code prints as ordinary 
text. To have it executed, you must do 
several things. 

First, select the PostScript code (including 
any group con1n1and). Then hold down 
the Shift key and pull down the Forn1at 
menu. You'll see that Styles has been 
replaced by the All Styles con1n1and. All 
Styles has several predefined styles, in­
cluding one called PostScript. Select it 
and dick on OK. The PostScript code has 
now been changed into a fonn that will he 
interpreted rather than printed. To see the 
code after this point, n1ake sure that Show 
Hidden Text is selected in the Preferences 
dialog box (Edit n1enu). You can't see the 
results of your tinkering by using the Print 
Preview con1111and; you must print the 
document on a LaserWriter. 
When you print, n1ake sure that Print 
Hidden Text isn't selected in the Print 
dialog box and check the Chooser to 
make certain that Background Printing is 
turned off. If Background Printing is left 
on, the PostScript effects will he shifted 
down and to the right from where you 
want then1 on the first page of the docu­
ment. Subsequent pages will print cor­
rectly. 

4. Modifying Word's PostScript Code 
Style - The on-screen appearance of 
Word's native PostScript style leaves 
something to be desired. Fortunately, you 
can easily modify n1ost of the attributes. 
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While holding down the Shift key, select 
Define All Styles fron1 the Forn1at menu. 
Select PostScript. The description box 
defines the style as "Normal + Font: 10 
point, Bold Hidden." The n1ain culprit 
here is Bold, which makes the type hard 
to react. So just pull down the Format 
tnenu while the dialog box is showing 
and turn off Bold. You can safely change 
anything in the PostScript style other than 
the Hidden attribute. 

Using PostScript To Place 
Screen And Crop Marks 

1. Screen Marks - If you want to place, 
say, a gray screen behind a single para­
graph, you do not need to know the 
precise location and size of the paragraph. 

First, remetnber that the group con1mand 
. para. creates a drawing rectangle that 
corresponds to the size and position of 
the paragraph it precedes. And Word has 
another card up its sleeve- built-in Post­
Script variables. There are 22 variables, 
which will aid you as you develop code. 
~or a list of the variables and their descrip­
tions, see pages 285 and 286 of the User's 
Guide. 

To make a screened paragraph, we need 
the variable called wp$box. Here's what 
you need to type in front of the paragraph 
and then fom1at in Word's PostScript style 
by forn1atting the code in the Postscript 
fonnat by holding down the Shift key and 
selecting All Styles: 

.para. 
9 setgroy wp$box fill 

By the way, you don't have to use carriage 
returns, although they make the code 
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more legible. You could simply type: 
.para . 
.9 setgray wp$box fill 

In any case, the variable wp$box is equiva­
lent to defining a drawing rectangle the 
same size as the paragraph. Without it, 
you'd have to determine the coordinates 
of the paragraph (with a ruler on a 
printout) and type something like: 

1 2 6 1 4 4 moveto 
360 0 rlineto 
0 504 rlineto 
-360 0 rlineto 
close path 
fi 1 1 

These are hypothetical coordinates, but 
you can see the advantages of having the 
variables. You save a lot of typing, and 
you don't need to figure out specific 
positions or dimensions. 

2. Crop Marks - An even clearer ex­
ample is crop marks, one of six routines 
included in the PostScript Glossary that 
accompanies Word 4.0. After the actual 
crop marks are defined, the routine places 
them at the corners of the page . Ordinar­
ily, you would have to know or calculate 
exact positions for the marks, a painstak­
ingly bothersome task. But with judicious 
use of some of Word's variables, you can 
avoid the hassle: 

wp$1eft markl sub whitel sub wp$y 
wp$top sub moveto markl 0 rlineto 
stroke 

The variables wp£left, wp$y, and wp$top 
refer to the left margin , the drawing 
rectangle's height, and the top margin 

respectively. You don't need to get the 
dimensions from the Page Setup dialog 
box. Word fills in the appropriate num­
bers when the file is interpreted and sent 
to the printer. And if you change the page 
size, you don't have to go back w the 
code and insert new dimensions . 

WRITE Now 

Setting Up 
Informal Style Sheets 
You can set up informa l style sheets, 
using the dummy formats that you fre­
quently use, in a document template that 
is kept open whenever you're working in 
WriteNow. 

When you need a style , just switch win­
dows, click on the paragraph containing 
the format you need , and copy the ruler 
(Command-1 ). Then switch back to the 
docume nt window and paste the ruler in 
(Command-2). Although this method only 
copies ruler settings (not font or style 
changes, for instance), it can still be a real 
time-saver. It also helps e nsure that your 
documents all have a uniform style . 

Later, if you want to change a particular 
format, you can use \VriteNow's identical 
ruler feature. just select the text from the 
first occurre nce of the format to the end 
of the document and then hold clown the 
Shift key while making the change in its 
ruler. 
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